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1 Introduction

1.1 System overview

The ATEIS UAP G2 is the new generation of Universal Audio Processor developed by ATEIS.

It has more powerful function and can be easily used in an exigent environment requiring audio quality.

Audio

The UAP G2 unit  handles  4 slots  of 4 audio channels.  Each slot  can contain either an input  board
(A/D converters) or an output  board (D/A converters);  this  is  a  factory  hardware  configuration.  You
can choose between: 16 outputs, 4 inputs  and 12 outputs,  8 inputs  and 8 outputs,  12 inputs  and 4
outputs or 16 inputs.

The excellent sonic performance is  being achieved by  the advanced 24 bit  A/D and D/A converters,
and altogether with the 48/96 kHz capable audio processing and the ADSP 21371 DSP  (266  MHz
SIMD SHARC Core, capable of 1596 MFLOPS peak performance).

Every single analogue audio input can be software defined for five different  sensitivities  (input  gain of
0dB, 12dB, 24dB, 40dB or 54dB it means the input device have sensitivities  of 0dB,  -12dB, -24dB, -
40dB or -54dB) and for 48V phantom power operation.  This  can be set  for each single channel and
each machine independently.

Linking

If more inputs  or outputs  are  required,  it  is  possible  to  digitally  link  up  to  12  UAP  G2  (maximum
distance between two UAP G2 is 10 meters). Through this link, you can share up to 16 channels  at
48 kHz or 5 channels at 96 kHz sampling rate to the next device. It is not a network so you will  have
to define outputs from the previous UAP G2 to inputs from the next UAP G2 etc.

System configuration

To tell the machine what to do with audio and control signals  there is  a WindowsR based graphical
design and operating environment  software.  With this  all-in-one program  you  build  up  the  network,
design signal processing from a huge library of DSP components and apply control sources.

In the 'Monitor' part  you can choose the parameters  that  make sense to be edited by  the user and
create an individual graphic user interface. To keep your design protected from unauthorized altering,
there are many password locked user levels.

The  signal  path  of  the  UAP  G2  is  built  from  virtual  elements  called  'Components',  providing  the
functionality  of  simple  preamps,  filters,  dynamics,  delays,  or  more  complex  processors  like
automatic  mixers,  crossovers  or feedback killer.  Their control windows hold all  the buttons,  faders,
knobs, meters etc. to set the desired values.

After selecting, placing and wiring DSP 'Components', your 'System' will be compiled and sent to the
UAP G2 via TCP/IP Ethernet port.

Preset Management

The UAP G2 includes two types of presets:

Sub-preset:

They enable values of multiple parameters  of the same design,  such as  levels,  gains,  EQ, etc.
to be restored either from the PC software, the remote controllers or the control inputs.

Master preset:
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They enable completely  different  designs to be  restored.  Application  examples  for  this  feature
are  hotel  meeting  rooms  with  removable  walls.  These  'Master  Presets'  and  'Sub-Presets'
residing  in  the  UAP  G2's  memory  which  can  be  accessed  in  many  ways:  PC,  Logic  inputs,
Third  party.  The  maximum  numbers  of  Presets  depend  of  the  UAP  G2's  memory  space
available. This limitation doesn't depend of the number of linked UAP G2.

System Control

Once a 'System' is stored into the UAP G2s memories, you can disconnect your PC and run it  as  a
standalone audio network. You can control all parameters like 'Channel Level', 'Master Volume' etc.

from assignable control sources or from front  knob.  There is  a range of control devices built  for the
system  you  can  operate.  The  UAP  G2  integrates  perfectly  into  third  party  control  systems  like:
VITY, AMX, Audace, Crestron, etc.

Connection

Audio and control connections are made via Euro-block connectors on the rear panel of the units.

Components

Huge  library  with  audio  tools  for  all  applications  (routing,  paging,  signal  processing,  networking,
speaker managing, etc)

System

System design by drag & drop

DSP design by drag & drop from component library

Changeable appearance of the control elements

Monitor (custom designable graphical user environment)

Freely designable user interface

Import graphics or pictures from .jpeg, .bmp, .ico, .emf or .wmf files

Graphic object functions: Resize, alignment, pack, space, order

Offline Programming

Design and editing of "DSP designs"

Easy operation

Standard cut, copy and paste commands

Contextual menu items

Stackable floating docking or sliding control windows

Resizable animated sliders, knobs and buttons

Values can be typed directly into value fields

Edit parameters of EQs or dynamics in graphic curve display.

Additional Features

User-management:  Up  to  40  users  with  individual  access  rights,  password  protected  3rd  Control
table,  with the addresses (names) and commands of all  the control  parameters  accessible  via  the
RS232 serial port and through TCP/IP.

Scheduler
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The  scheduler  allows  planning  of  events  (preset  change,  message  play,  close/open  TTL  out  or
change component's adjustments). Up to 255 different schedules can be scheduled. In one schedule
you can define up to 255 events.

Message Player

The Message player incorporated into the UAP G2 allows you to play  any  kind  of  message  to  be
played. Two messages per UAP G2 can be run at a time. 

With the 100 Mbyte memory, the following storage times are available in WAV format:

Format : 48kHz, 24kHz, 16kHz / 16 bits

Up to 53 minutes in 16 bits and 16 kHz sampling rate.

Up to 34 minutes in 16 bits and 24 kHz sampling rate.

Up to 17 minutes in 16 bits and 48 kHz sampling rate.

 The message player cannot be used with the UAP G2 set  at  96kHz.  The UAP G2 must  be set
at 48kHz.
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2 Safety declartion

Do not  expose  the  device  to  extreme  temperatures,  direct  sunlight,  humidity,  or  dust,  which  could
cause fire or electrical shock hazard. 

Keep away water or other liquids from the device. Otherwise fire or electrical shock may result. 

Connect the power cord only to an AC outlet  of the type stated in this  Owner's  Manual or as  marked
on the unit. Otherwise fire and electrical shock hazard results. 

When disconnecting the power cord from an AC outlet  always grab the  plug.  Never  pull  the  cord.  A
damaged power cord is a potential risk of fire and electrical shock hazard. 

Avoid touching power plugs with wet hands. Doing so is a potential electrical shock hazard. 

Take care for correct  polarity  when operating the device  from  a  DC power  source.  Reversed  polarity
may cause damage to the unit or the batteries. 

Avoid  placing  heavy  objects  on  power  cords.  A  damaged  power  cord  is  a  fire  and  electrical  shock
hazard. 

Do not  cut,  scratch,  bend,  twist,  pull,  or  heat  the  power  cord.  A  damaged  power  cord  is  a  fire  and
electrical shock hazard. Ask your ATEÏS dealer for replacement. 

Turn off immediately the unit, remove the power cord from the AC outlet and consult your ATEÏS dealer
in any of the following circumstances: 

Smoke, odor, or noise getting out of the unit. 

Foreign objects or liquids get inside the device. 

The unit has been dropped or the shell is damaged. 

The power cord is damaged. 

If you continue using the device, fire and electrical shock may result.

Do not drop or insert metallic objects or flammable materials into the unit as this may result in fire and
electrical shock. 

Do not  remove the device's  cover,  as  there are exposed parts  inside carrying high voltages that  may
cause an electrical shock. Contact  your ATEÏS dealer if internal inspection,  maintenance,  or repair is
necessary. 

Do not try to make any modifications to the device. This is a potential fire and electrical shock hazard.
 

Avoid  the  device's  ventilation  slots  to  be  blocked.  Blocking  the  ventilation  slots  is  a  potential  fire
hazard.
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To prevent the unit from falling down and causing personal injury and/or property damage, avoid
installing or mounting the unit in unstable locations. 

Leave enough space above and below the unit to provide good ventilation of the device.  If the airflow is
not adequate, the device will heat up inside and may cause a fire. 

Operate the device in an environment with a free-air temperature of between 0 °C and 40 °C (32 °F and
104 °F). 

Turn  off  all  audio  equipment  when  making  any  connections  to  the  device,  and  make  sure  to  use
adequate cables. 

Do not use benzene, thinner, or chemicals to clean the device. Use only a soft, dry cloth. 

If  the  device  is  moved  from  a  cold  place  (e.g.,  overnight  in  a  car)  to  a  warmer  environment,
condensation may form inside the unit, which may affect performance. Allow the device to acclimatize
for about one hour before use.
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3 Quick start

1. Setup device and wiring

Speaker and microphone are connected to the Audio Input/Output Connector.

o BLACK = OUTPUT

o GREEN = INPUT

Connect a PC to the UAP G2 through the Ethernet port.

Connect a PPM on the RS-485 port, in case of paging, connect to the Audio input as well.

Power up the UAP G2 device and make sure the power LED on the front panel is glowing.

2. Install UAP G2 software.

3. Run UAP G2 Software.

4. The address of the UAPG2 is 192.168.100.6 by factory default settings. 

Make  your  PC's  IP  address  static  and  choose  192.168.100.50  as  network  address  for  your
computer. The Subnet mask as 255.255.255.0 and the Gateway as 192.168.100.254.

5. Choose the right network card on which the network is linked: Tools > Options (Shift + F8) > Network.

no91
註解
UAP G2 換新圖
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6. Search the UAPG2 by open the "Establish Ethernet Link" window (menu Tools, or Shift+F9). 

Enter the IP address of the UAPG2 and click  "Connect".  Once it  displays  a window of "Connection
Successfully", close it and start to configure.

7. Create a New file:

Create a new file File > New or by  clicking the button on the top left  of UAP G2 software which  is
shown in the picture below,
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8.  Create  a  block  in  the  device  editor  window,  the  UAP  G2  will  be  automatically  assigned  when
connected to.

If  there  are  several  UAP  G2  units,  the  connection  in  the  software  is  the  same  as  the  physic
connection. Drag the UAP unit icon and drop it in working area (System window):

Since there are many combinations audio boards can be fitted or omitted, 

With default setting of UAPG2 which comes and fitted with the following boards:

o Slot A: Analog Input

o Slot B: Analog Output

o Slot C: Analog Input

o Slot D: Analog Output

Tips: If you are not sure about the hardware configuration of your UAPG2:

o BLACK Audio connectors = OUTPUT.

o GREEN Audio connectors = INPUT.

9. Once the UAP block  is  in the working area,  you can right  click  it  and you will  have access to some
features:

Name: give a name to this UAPG2

Delete: same issue as selecting and press “DEL” key (delete the virtual UAPG2)

DSP  functions:  same  effect  as  double-clicking  on  the  UAPG2  icon,  open  the  dsp  design
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working area (see create audio signal path)

ExternalSelect: define the kind of each control input (Logic in (TTL) or analogue in)

Update U-input to Input: allow users to switch component: input board to u-input board.

10. Double click the UAP block and start to manage the component. 

The [UAP (*the name you choose)] window appears and allows you to edit the DSP configuration.

Drag and drop to add component  or set  audio bypass to  check  every  channel,  as  the  "Input  A  to
Output B" shown in the picture below. 

11.  Compile and Store

Once the design is done, click [Compile]. 

The Compiling window appears as shown in the picture below.

Then,  click  [Store]  to  store  your  design  into  the  UAP,  the  Store  window  appears  as  the  picture
below.
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Meanwhile, the system will ask the user to connect to the device and turn audio, click [Yes] to all.

12. Adjust element:

Double click the component and adjust their parameters.
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Now  you  can  adjust  the  parameters  when  the  device  is  connected  and  easily  click  [Save
Parameters].

If you want to add/delete the components or add more device, you need to disconnect to edit.
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4 Product features

4.1 UAP G2 audio processor

The UAP G2 is a completely re-design audio processor of the UAP88. The processor is the state-of- the-
art  solution  to  meet  almost  all  requirements  of  modern  sound  design  in  contemporary  applications.
Designed  for  Commercial  application,  the  UAP  G2  is  the  new DSP  audio  matrix  for  medium  paging
application and multi-zone audio routing.

With  its  powerful  audio  numerical  signal  treatment,  the  UAP  G2  can  easily  be  used  in  an  exigent
environment requiring audio quality.

Thanks to its Ethernet  port,  you can easily  connect  and pilot  the UAP G2 through an IP network  or via
the PC by using RJ-45 connector directly.

The  programming  of  UAP  G2  is  done  through  convivial  software  based  on  graphical  Windows  design
environment.  The  signal  path  is  defined  by  adding  DSP  components  (Equalizer,  Gate,  Compressor,
delay...),  simply  inserted a clear  and  intuitive  graphical  window by  "drag  en  drop"  operation.  You  can
recreate a complex audio system in a simple  1U space  machine.  You  can  recreate  a  complex  audio
system in a simple 1U space machine regardless  of the devices require racks and long cables  demand
in the past.

Once  programmed,  you  can  pilot  your  system  through  PC,  VITY,  Crestron  or  AMX.  You  can  also
disconnect the PC and the networked devices run as a standalone system; however it  can be controlled
through a range of controllers  (logical TTL Input,  logical TTL Output,  analogical inputs,  RS485 network).
Wall-mount  source  selectors,  Ethernet  remote  controller  and  programmable  paging  microphones  are
also available to work with UAP G2.

The UAP G2 is made of:

4 slots of 4 audio channels.

8 programmable front knobs (pilot the element adjustment you define in the UAP G2).

16 control inputs (0 to 5 VDC) either analogue or Logical (contacts).

8 logic outputs (dry contacts).

RS-232 serial interfacing for third party control.

Ethernet port (RJ-45) TCP/IP based.

RS-485 for connecting to the remote devices (URC, PPM-SP, PPM-SPWJB).

100 Mbytes memory message player (WAV, 16/24/48kHz, 16bits).

Digital link to link up to 12 UAP G2 and share 16 audio channels in 48 kHz or 5 audio channels  in
96 kHz.
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One micro controller and one DSP for standalone operation.

Application diagram

4.1.1 Installation

In the shipping box of the UAP G2,  it  contains  a letter with a point  by  point  instruction that  need to be
followed for safety reasons.

Rack mounting

If  it  is  required,  fit  the  rack  mounting  brackets  to  each  side  of  the  UAP  G2  by  using  the  6  pcs
Phillips M3X screws supplied with the package.

Sitting

The UAP G2 takes only  a single 19’’  rack  space  and  generates  little  heat  itself.  Consider  leaving
enough ventilation space above and below the unit.  Do not  mount  the UAP G2  directly  above  heat
generating devices like power supplies or power amplifiers.

The UAP G2 cooling capacity is provided by a fan at the left side of the unit.  Be sure to not  to block
the air vent holes  along the sides of the housing.  Normal operation is  ensured within a temperature
range between 0°C and 40°C (32 °F to 104 °F).

Power connection

Connect  the AC to the mains  supply  via a power cord.  Check your line  voltage  before  plugging  in.
The power supply of the UAP G2 accepts AC voltages ranging from 100 V to 240 V, 47~63 Hz. 

no91
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4.1.2 Front panel

1. Configuration audio I/O

There have 4 audio slots  (A,  B,  C and D) in UAP G2.  Each  of  these  audio  slots  receives  either  4
audio inputs channels or 4 audio outputs channels. 

When the UAP G2 is powered, you can see which kinds of audio card is fitted in each slots:

Green LEDs mean INPUTs

Yellow LEDs mean OUTPUTs

When a signal passes through an input or an output, the corresponded LED will blink.

2. Programmable knob

There are eight  front  knobs which allow a quick  adjustment  for  every  analogical  audio  element.  To
learn how to proceed, see How to use front knobs chapter.

3. Ethernet LED

Light up when the UAP G2 is connected (on-line) to the TCP/IP network.

4. Standby button

Activate the standby mode.

5. Link LED

Light up when the UAP G2 is linked in a UAP G2 system (several UAP G2 units are connected).

The link is
successful

Unconnected line
Already on-line but

don't configured
Already on-line but
LVDS receive error

Linking LED
The LED green

glows bright
The LED doesn't light Twinkle 2 times Twinkle 3 times

6. Power LED

Lights up when the UAP G2 is switched on.

no91
註解
UAP G2 換新圖

no91
註解
換新圖



Product features 21

© 2019, ATEÏS, member of PAX ProAV Group

Normal status  Standby status

Error status:
The UAP G2 has no design inside.
The design inside the UAP G2 does not
match with the physical installation.
If the link led is off, The UAP G2 has no input
link

Power LED
The LED glows 
bright in green

The LED glows
bright in red

 The LED flicks in red and green

4.1.3 Rear panel

1. Mains power inlet

Connect  the  mains  power  to  this  socket,  the  UAP  G2  accepts  AC  voltages  100~240V,  1.2A,
47~63Hz (fuse: T1.6AL/250VAC).

2. RS485 connector

24VDC input  and RS485 connector is  used for additional units  such as  the URC (universal  remote
controller) or the PPM (programmable paging microphone).

3. Control input connectors

4. Relay connectors

It is capable to engage a relay if the UAP G2 is  powered up via 24VDC (NO = normally  open,  NC =
normally close, RC = Relay common).

The  contact  has  both  normally  open  (NO)  and  normally  closed  (NC)  relay  contacts.  When  the
machine is powered-up and working properly, the NC contact is closed and the NO contact is open.

The NC contact is open and the NO contact is closed when there's a power fault or power-off. 

The NC contact is open and the NO contact is closed with the startup process of the UAP G2
(7 seconds). 

5. Contact outputs connectors

6. Audio input/output connectors

7. Digi-link input/output connectors

8. RS232 connector

9. Ethernet (RJ45) connector

Connect the UAP G2 over a TCP/IP based network or via your PC directly: 

To load design in a UAP G2 system

To pilot UAP G2 system

To monitor UAP G2 system

To do 3rd party control via UDP protocol.
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4.1.3.1 RS485 connector

The RS485 port  is  used for additional units  such as  the URC (universal  remote  controller)  or  the  PPM
(programmable paging microphone).

24VDC power input: + and  (max. 0.6A total)

DATA: A and B

The maximum cable length is depending on the type of cable for use and it  should not  exceed 300m
with standard STP CAT5/6 cable.

This  restriction is  due to supply  voltage which drops with low wire  gauge  in  longer  cable  runs  and
can  be  obviated  by  using  external  power  supplies  (Junction  Box)  or  higher  diameter  cables.
However,  we  have  seen  data  cable  lengths  up  to  850m  working  just  fine.  You  will  have  to  put
external power every three remote devices (PPM or URC) or every 300m.

It is recommended not to put  more than 8 remote devices (PPM and/or URC) on one UAP G2.  You
can use more remote devices for sure (UAP G2 can manage up to 16 PPMs or 12 URC’s),  but  this
will  increase the response time of the devices and you will  have to be  very  careful  in  the  wiring  by
adding external power supply.

4.1.3.2 Control input

The  UAP  G2  connects  either  logical  input  (TTL  IN,  dry  contact)  or  analogical  input  (10  k  Ohm
potentiometer). Simply by connecting to the switch, relay or linear potentiometer between the number (1
and 8) and the G (ground).  The  number  indicates  which  control  logic  channel  will  be  used  (when  you
define the action of the control input).

If you use control Input as analog input:

You can connect  Remote Controllers  RAC 5 or RAC 8.  Or  a  simple  variable  resistor  (10K)  to  the
analog control inputs as follows:
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You can reduce the step by putting a 100uF capacitor in parallel across the contact.

If you use control Input as Logic input:

Caution: The logic In is momentary activate when the contact is open.

If  you  want  to  active  a  parameter  when  the  contact  closes,  then  you  have  to  use  the  event
Management  (in  menu  View),  to  create  "Element  control"  event.  Then  you  can  assign  this  event
either to an opened or closed contact. For more details please see How to use Events chapter.

Simple activation of the TTL inputs can be made like the picture below:

:
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4.1.3.3 Contact output

The Contact closes when the Logic Output is active.

The logic outputs are simple dry contact or relay contact, with a common rail.

The common rail is linked to the ground. 

No voltage is provided.

Contact rating: (relays EGE type EDR201A0500)   

Maximum voltage 100 VDC, Maximum switching current 0.5 amps, Maximum switching power 10VA.

If the RS485 bus is unable to use,  then you can easily  use the 24VDC output  of the UAP G2 to feed 8
LEDs that each have a 2k2 current limiting resistor.

4.1.3.4 Audio input/output connector

Balanced audio input or output:

+ = Hot audio signal

- = Cold audio signal

S = Shield
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Input and output cards have different connector colors:

BLACK = OUTPUT

GREEN = INPUT

If you want to use unbalanced signal, please connect  the Cold (-) pin with the Shield (S) pin.  There is  a
hardware clip operation on input board over 15dBu.

4.1.3.5 Digi-Link input/output

If you want  to  put  several  UAP  G2  units  in  your  rack  (increase  the  number  of  input/output  or  remote
controllers),  simply  use straight  STP CAT5/6 cable with  metal  shielded  RJ45  connector  to  connect  to
the  “Digi-Link”  OUT to  the  “Digi-Link”  IN  of  the  next  UAP  G2  in  a  maximum  distance  of  10  meters
between two UAP G2 units.  The last  processor in the chain MUST be  connected  to  the   rst  processor
(the one connected directly to the computer) to form a loop.

 Use the supplied Ethernet UTP CAT5 cable on digilink connection is prohibited.

4.1.3.6 RS232 connector

Connect  the third party  device  (Crestron,  AMX,  VITY)  to  pilot  some  desired  features  of  your  UAP  G2
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system by using the Ateis  Third party  protocol.  (see also 3rd party  control over Ethernet) You also can
find a DB9f connector for RS232 data communication at  the rear side of the UAP G2.  This  port  can be
used for transparent RS232 data multi-point  communication through the network  or for 3rd party  control
applications.

RS232 does support cable lengths up to 15 m.

Pin Signal Text

1 CD Carrier detect (n.c.)

2 RXD Receive data

3 TXD Transmit data

4 DTR Data terminal ready (n.c.)

5 GND Ground

6 DSR Data set ready (n.c.)

7 RTS Request to send (n.c.)

8 CTS Clear to send (n.c.)

9 RI Ring indicator (n.c.)

(n.c.): non connected

4.1.4 Characteristics

Power

Item Voltage Min. Voltage Max. Comment

AC Input 100VAC 240VAC -

Backup Power Source 20VDC 28VDC > 2.5A

Remote Controller Power 20VDC 25VDC, (Typ.: 24VDC)
<0.5A, @mains 

power plug in

Power Consumption = 40 VA, 10 VA in stand-by mode.

Analog Audio Specification

Parameters Sensitivity Min Typ Max Units Condition

Sensitivity* - 0 - -54 dBu
Only 5 selection(0dBu/-12dBu/-24dBu/-

40dBu/-54dBu)

Equivalent Input
Noise

0dBu - - -81 dBu 20~20kHz@150Ω

-12dBu - - -93 dBu 20~20kHz@150Ω

-24dBu - - -104 dBu 20~20kHz@150Ω

-40dBu - - -112 dBu 20~20kHz@150Ω

-54dBu - - -115 dBu 20~20kHz@150Ω

THD+N

0dBu - - 0.04 % 20~20kHz@+4dBu

-12dBu - - 0.06 % 20~20kHz@-2dBu

-24dBu - - 0.06 % 20~20kHz@-14dBu

-40dBu - - 0.06 % 20~20kHz@-30dBu

-54dBu - - 0.06 % 20~20kHz@-44dBu

CMRR

0dBu
- - -60

dBu
10kHz@0dBu

- - -70 1kHz@0dBu

-12dBu
- - -70

dBu
10kHz@-12dBu

- - -80 1kHz@-12dBu

-24dBu - - -75 dBu 10kHz@-24dBu
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Parameters Sensitivity Min Typ Max Units Condition

- - -90 1kHz@-24dBu

-40dBu
- - -80

dBu
10kHz@-40dBu

- - -85 1kHz@-40dBu

-54dBu
- - -70

dBu
10kHz@-54dBu

- - -80 1kHz@-54dBu

Frequency
Response**

0dBu -1 0 +1 dBu 18~30kHz@0dBu, sample rate=96k

-12dBu -1 0 +1 dBu 18~30kHz@-12dBu, ample rate=96k

-24dBu -1 0 +1 dBu 18~30kHz@-24dBu, ample rate=96k

-40dBu -1 0 +1 dBu 18~30kHz@-40dBu, ample rate=96k

-54dBu -1.5 0 +1.5 dBu 18~20kHz@-54dBu, ample rate=96k

Crosstalk*** - - - -70 dBu 10kHz@150Ω

Maximum input

0dBu - - +15 dBu -

-12dBu - - +3 dBu -

-24dBu - - -9 dBu -

-40dBu - - -25 dBu -

-54dBu - - -39 dBu -

Input Impedance
(Balanced)

- 9k 10k 11k Ω 1kHz@sine wave

Output Impedance
(Balanced)

- 90 100 110 Ω 1kHz@sine wave

Sample rate - 48k - 96k Hz Only 2 selection

Phantom power - 47 48 50 V DC

Note:

*  It  means  input  could  get  the  gain  of  sensitivity  absolute  value.  For  example:  When  the
sensitivity=-54dBu  and  input=-54dBu,output  will  get  0dBu.  When  the  Sensitivity=-54dBu  and
input=-44dBu,output will get 10dBu.

** The difference between 1kHz and  the frequency of maximum value.

***Input ch sensitivity=0dBu,other ch sensitivity=-54dBu.

Contact Inputs

Condition Minimum Typical Maximum Comment

Low - 0 VDC 0.1 VDC Function
ProgrammableHigh - 4.2 VDC 5 VDC

TTL Outputs

Condition Short Open Comment

- 0 VDC Hi-impedance Function Programmable

Mechanical

Dimension (WxHxD): 432 x 44 x 245 mm (17 x 1.7 x 9.3 inch)

Weight: 3.5 kg (7.7 lbs)

Mounting: 19" 1U rack

Color: RAL7016

Working Temperature.
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0°C ~ 40°C

4.1.5 Peripherals

The following table is the peripherals list supported by UAP G2:

Device Connection
Max.

Number
Function

PPM V2 RS485 32

Remote console for with paging ability.PPM V3 RS485 32

PPM V4 RS485 32

PPM-IT5 Ethernet Eth. Limit Paging, Element Control, Master/Sub Preset Control.

URC Control Input 16
Analog and Logic functions for controlling elements such as

volume.

URC200
TPC

Ethernet Eth. Limit Parameters Control, Master/Sub Preset Control.

Max. Number indicates the max. number of peripherals the UAP G2 can connect  one through the
connector by using Junction Box.

One UAP G2 has 1 RS485 connector, and the sum of remote units are 32.

Eth. limit: The max. number which can be assigned over the network.

If  connect  to  the  device  through  the  sole  Ethernet  port  of  UAP  G2,  one  PPM-IT5  or  one
URC200TPC can only be supported by UAP G2.

4.1.6 3rd party control

The following table refers to the 3rd Party Control protocols which UAP G2 is supported.

Protocol
Interface

Function
Connection Settings

Ateis 3rd
Party

Protocol

Ethernet
(UDP)

UDP Port =
19761

Read/Write value of parameters.
Stepped adjustment for parameters.

Ateis 3rd
Party

Protocol

RS232
Baud Rate

Parity
Stop Bit

Read/Write value of parameters.
Stepped adjustment for parameters.
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4.2 Consoles and accessories

4.2.1 PPM-SP

The  PPM-SP  is  an  unidirectional  addressable  condenser  paging  microphone  for  UAP  G2  system.  In
accordance  with  BS5839,  it  is  monitored  by  using  RS485  protocol  over  STP  CAT5/6  cable,  and
transmits both audio and power from the paging console to the system units.

The PPM-SP has 8 zone buttons with a sleek gooseneck microphone,  and the zones can be expanded
to  256  zones  via  additional  PPM-KP  keypad.  The  PPM-SP  enables  live  announcement  to  any  pre-
assigned zones. The paging station has a gooseneck microphone,  a push-to-talk  button,  zone selection
keys and a monitor speaker. Buttons represent a single zone or a group of zones and be easily  de fined
in  the  software  using  a  simple  matrix  selection.  All  buttons  can  be  programmed  using  drag  &  drop
feature  from  UAP  G2  GUI software  and  each  button  can  be  programmed  for  PTT  (Push  To  Talk)  or
latching functionality.

In addition to the zone LEDs,  “Hold” and “Busy” LED signals  make PPM-SP an extremely  user-friendly
paging console. Thanks to the cardioids  polar pick-up pattern,  the unidirectional condenser microphone
ensures the high-quality and directive signal pick-up with minimal interference from the surroundings.

The  RS485  communication  protocol  allows  daisy-chain  wiring  up  to  300m  on  a  single  CAT5/6  cable
(FTP/STP)  and  makes  each  station  easy  to  connect  by  using  standard  RJ45  connectors.  The  PPM-
SPWJB comes with PPM-SP and junction box,  and allows multiple peripherals  such  as  PPM-SP  and
URC to be cascaded with the distance of up to 300m between a peripheral and a junction box,  and up to
10 peripherals can be connected via junction boxes on one processor.  In addition,  the junction box can
be powered from the processor or 24VDC local power supply.
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4.2.1.1 Front panel

 Microphone

The  sleek  condenser  gooseneck  microphone.  This  unidirectional  condenser  microphone  warrants
high quality directive signal pick up from the user and hence less interference from the surroundings.

 Monitoring speaker

This embedded speaker to play chime when paging or monitor signal from audio processor,  it  needs
to  work  with  RS485  output  component  to  get  audio  signal  from  other  DSP  components  in  audio
processor.

 Fault LED

See the following table of the fault status of system. 

Status Frequency Activity

Permanent There are faults in audio processor.

Blinking  °  ° Lost communication with audio processor.

 EVAC LED

Status Frequency Activity

Blinking  °  ° PPM isn't assigned in UAP G2 Software, open Remote List to edit.

The  "Remote  Plug-in"  function  will  let  UAP  G2  audio  processor  to  recognize  the  peripheral
devices.
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 Power LED

This LED lights up when the PPM is powered.

 Hold LED

These LEDs Indicate which keys are selected.

 Event select key

These key buttons are used for selecting the events  which may link  to  an  event  with  an  triggering
actions like paging or adjust the value of parameters.

 All/Release LED

This indicator lights up if all keys are selected/deselected.

 All/Release button

Press this button to select/deselect all the key buttons.

 Talk key

Push this key to request paging.

 Talk indicator

This  LED lights  up if  PPM  is  allowed  to  paging,  on  the  other  word,  the  paging  request  has  been
acknowledged.

Sometimes even the paging request  is  granted,  zones under paging still  can  be  occupied  by  other
sources with higher priority.  In the event  of,  the talk  LED still  lights  up,  you can check it  from busy
LEDs.

 Busy LED

Show the status of zone:

Color Status Frequency Activity

Red Permanent Priority of the zone is lower than other sources.
Green Blinking  °  ° Priority of the zone is higher than other sources.

Green Permanent
The zone only desired for paging is not using by other

sources.
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4.2.1.2 Rear panel

PPM-KP (Left) and PPM-SP (Right)

PPM-SP: 

 Volume Control

Here you can use  a  cross-tip  screwdriver  to  adjust  the  volume  of  the  speaker,  mic  and  chime  of
PPM-SP.

 Terminator

The terminator switch for Master-Slave connection with junction boxes.

 Keypad connector

The keypad connector on PPM-SP for expanding additional keys with PPM-KP keypad.

Please make sure the hardware version is matching. If connecting with the wrong hardware type,
the circuit in the keypad will burn out.

PPM-KP:

 Keypad connector:

The PPM-KP connector for connecting to the PPM-SP. Every  keypad  is  shipped  with  one  flexible
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flat cable.

 Keypad connector:

The  keypad  connector  for  connecting  to  the  next  keypad,  one  PPM-SP  can  attach  2  PPM-KP
keypads for extending the keys.

 RJ45 connector (PPM-SP):

The RJ45 connector for connecting to the RS485 connector on UAP G2 processor.

When the PPM-SP is  connected to the junction box,  please note the master PPM  should  use
the 10-pin STP CAT5 cable,  and Slave PPM should use with 8-pin STP CAT5 cable.  See more
on PPM-SP > Connection chapter. 

If  the  PPM-SP  is  linked  to  an  additional  PPM-KP,  the  PPM-KP  keypad  is  able  to  start
messages, see Use PPM-KP to trigger event (as messages)..

4.2.1.3 Characteristics

Power

Item Voltage Current Consumption Comment

DC Input 18V~26V, Typical 24V 120mA -

Microphone output

Maximum level = 6dBu.

Output Impedance = 100Ohm.

THD @ 1kHz < 1%.

Bandwidth @ -3dB = 100Hz ~ 18kHz.

Front panel speaker

Impedance = 4Ohm.

Maximum Power @ 1kHz = 1W.

THD @ 1kHz < 1%.

Bandwidth @ -3dB = 200Hz ~ 8kHz.

Cable length

300m (control and power on the same cable).

900m (when power line connects to junction box).

Mechanical

Dimensions (WxHxD)

o PPM-SP base: 105 x 50 x 190 mm

o PPM-SP with microphone: 105 x 350 x 190 mm

Weight: 0.7Kg

Color: RAL7035
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4.2.1.4 Connection

To connect one or several remote devices on UAP G2,  they require to add an external power supply  via
Junction Box (JB). For the  first three remote devices and/or the  first 300m of cable run, the power can be
delivered by  UAP G2.  If the distance between UAP G2 and JB is  more than  300m,  the  JB  requires  to
add for external power supply. The maximum distance between UAP G2 and remote device is 850m.

See the steps below to configure one or several PPM:

1. Connect the PPM.

2. Drag and drop the PPM device into the UAP G2 system on software,  see PPM-SP Configuration
chapter.

3. Search and set the PPM on software, see PPM-SP Configuration chapter.

4. Adjust  the parameter settings of PPM on software.  You can  also  assign  chime  to  a  PPM,  see
PPM-SP Configuration chapter.

Hardware wiring

Connect with several PPM and URC:
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See  cable  specification  chapter  to  know  more  about  the  corresponded  8-pin  out/10-pin  out
wiring.

Connect to PPM

To connect one or several PPM units, it requires the Junction boxes (JB). Connect Audio to the UAP
G2 Input  you  want,  and  remember  of  which  PPM  is  connected  to  which  input  (note  the  serial
number). After that, define the system with the PPM.

If there has an unstable connection, switch on the end line resistor on the last  Master PPM (rear
of PPM). Slave feature is not available for the moment.

Wiring without the external power:

o Max. distance between UAP G2 and JB: 300m

o Max. distance between JB and PPM: 2m

With the External Power:

o Max. distance between UAP G2 and JB: 850m

o Max. distance between JB and PPM: 2m

4.2.1.4.1  Cable specification (8-pin/10-pin)

Connect the Junction Box to UAP G2 processor by  using the STP CAT5/6 cable with metal shielded
connector.

Pin1 RS-485 B

Pin2 RS-485 A

Pin3 Line in -

Pin4 24VDC

Pin5 Ground

Pin6  Line in +

Pin7 Line out -

Pin8 Line out +

Connect the PPM-SP to the Junction Box by using the supplied 10-pin CAT5/6 cable.
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Pin1 Slave RS-485 A
Pin2 24VDC
Pin3 Master RS-485
Pin4 Master RS-485 A
Pin5 Line out + ( PPM Mic)
Pin6 Line out - (PPM Mic)

Pin7
Line in + (PPM

speak.)

Pin8
Line in – (PPM

speak.)
Pin9 Ground
Pin10 Slave RS-485 B

4.2.1.5 Configuration

Drag and drop the PPM in one of the UAP G2 inputs (A3 for our example) in accordance to the inputs
you have physically connected to the PPMs.

If you have  several  PPM  units,  repeat  this  action  for  each  PPM,  then  Search  the  PPM  (gives  IP
address to each PPM).

Search and set PPM

1. First, make sure to clear all the old remote IP address on "Tools > Clear Remote IP".

Always clear the remote address before installing or changing the system with new PPM units.  If
the  system  cannot  be  found  with  the  correct  number  of  remote  devices  during  the  search
process, clear the remote IP and search the PPM again. If it doesn't  correct  the problem, please
check the hardware wiring (to be sure that data A and B are well connected: A to A and B to B).

2. Click  "View > Remote list"  or press  F9  on  your  computer  keyboard.  The  "Remote  Device  List"
window will appear, then click on the PPM’s page.

3. Click "Search", then a new dialogue window will appear, click "Search" again.

4. When the system has completed the searching process,  a list  with the various connected PPM
will appear. Each PPM is identified by  its  own serial number.  This  number is  written on a sticker
at  the rear panel of PPM. The system will  detect  each  PPM  automatically  (in  our  example  the
serial number of PPM is R01051).

If the system doe not find all  the remote devices,  clear all  the remote IP address (Shift+F5) and
search again.

5. Click "Close" to close the remote search window. 
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6. Select  the PPM in the first  window by assigning the corresponding serial number to each PPM.
See the example as  the picture below, the Input  A1 of UAP1 has connected the PPM R01051).
Then click "Apply" and "OK".

7. The  system  is  now  ready  to  work  with  the  PPM  connected  on  the  input  A1  of  the  UAP1
(according to the picture above). 

Adjust PPM parameter

Double click the PPM icon in the system window, the "PPM setting" window appear.

Serial No.: The serial number of the PPM connected on this input.

Name: Assign a name for this PPM.

Priority: Set the priority of this PPM compared to others (1 = highest priority, 8 = lowest).

Key: Number of key (8 for a single PPM, or more with extension's modules, up to 64).

Talk: Select the talk behavior between "Press To Talk" or "Lock To Talk".

o Push: Talk only while pushing the microphone button.
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o Locked:  Talk  after pushing the microphone button one time and stop  talking  by  pushing  the

microphone button again.

Message control: 

You  can  have  access  to  this  option  only  in  connection  state.  If  notched,  the  last  PPM-KP
keypad is able to start messages. To be able to start  messages from the PPM-SP, a PPM-KP
must be link to the PPM-SP. Even, if you add several PPM-KP keypads,  the last  one is  able to
start  messages only.  (With  additional  PPM-KP  keypad,  please  remember  to  change  the  key
number in the PPM setting).

When using a normal PPM, the message control is  grayed out  or disappearing when the serial
number of a PPM is assigned.

Stacking paging cancel:

If not notched, the PPM-SP will record the announcements  in case of the destination is  already
occupied by another PPM-SP. The announcement will be play as soon as the destination will be
available.

When using a normal PPM, the stacking paging cancel is  grayed out  or disappearing when the
serial number of a PPM is assigned.

Announcement setup: 

The PPM has two chimes in his  internal memory  by  default,  click  the  "active"  box  and  select
which chime you want by clicking the "Index" field.

When  all  the  settings  have  completed,  the  PPM  is  ready  to  be  used  like  any  kind  of  input
sources.  To learn how to configure the system in order  to  control  the  access  of  the  sound  to
various areas through the PPM’s keys.

4.2.1.5.1  Chime

Assign chime to PPM

You can upload a max. of 128KB (Wave files, 16 bits,  16 kHz mono) in a PPM, If you want  to have
several chimes in a PPM, then you must store all of them together in the same time.

See the steps below to load chime to a PPM:

1. Select chime.

2. Load chime (Wave files) in the PPM.

3. Adjust PPM's chime.

Select chime

Open the window "View > Wave File Manager".
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Select  which audio file you want  to use.  Click  [Save to Library],  and  a  message  will  appear,  click
"OK".

If the file is  already transferred,  the message would say:  "there are 0 wave file transfer to Wave
library",  just  close the window. You can also load your own wave  files  from  PC:  16bits,  mono,
16kHz in the wave file manager window (menu "view") by  clicking add from [File].  A window will
open and request  you to  choose  the  wave  files  in  your  computer.  Select  the  chime  and  click
[OK]. When you've selected all the whished files, click [Cancel]. Finally, click [Save to Library].

Load chime

Open the window "Chime data store” > menu view"
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1. If you have several PPM connected, choose in which you want to load. 

2. Click the "Wave Select" button to open the Wave library. 

3. Select the files which will be uploaded in each PPM.

4. To import  a wave from your computer,  click  "Add" to import  a ZIP file from your  computer,  click
"Import".

5. Click "Transfer" to send the file in the "Chime Data Store", see the picture below.
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6. Click  "Store"  (or if you change only  one PPM chime select  it  and  click  Ind).  The  wave  files  are
uploaded in the PPM. Depending on your system, this  operation takes time.  When the  process
complete, close the window.

Adjust PPM’s chime

Open the PPM manager window menu "View > PPM Manager".

Click the “Chime” field of the PPM which you want to authorize the chime.

You can also reach this  window by double clicking the PPM’s  icon,  and click  the "Announcement"
Setup button.

The PPM announcement manager window appears:

Click the Index field to select the wave files you want to use as a chime.

Activate it by notching the Active box.
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If you have several PPMs, repeat the manipulation for each.

When the adjustments have completed, compile your project and upload it in the UAP G2.

4.2.2 PPM-IT5

The PPM-IT5 IP paging console allows call-paging and messages broadcasting. Its back-lit touch screen
is  designed  for  user-friendly  operating.  The  3  hardware  keys  can  be  freely  assigned  by  software.  All
paging parameters  are programmable:  zones assigned to different  buttons,  name  zones,  group  zones,
messages  triggering  or  event  control.  A  total  of  168  keys  over  14  pages  allow  zone  selections.  The
prerecorded  messages  and  chime  are  stored  in  PPM-IT5  IP  paging  console.  Thanks  to  the  echo
cancellation, the PPM-IT5 delivers full duplex crystal clear sound quality. 

Features

5” TFT LCD color touch panel.

Full duplex intercom, zone paging, and control. 

High quality gooseneck microphone.

Loudspeaker built-in.
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Ethernet interface including PoE (Power Over Ethernet).

24 VDC external power supply (if no PoE available).

AGC(Automatic Gain Control) function. 

Noise Reduction and Acoustic Echo Cancellation.

G.711/G.722/G.726/G.727/G.729/MP3 audio encoding/decoding and AAC+ decider. 

SNMP (Simple Network Management Protocol). 

Full duplex audio.

Memory for message recording and playback.

POWER/FAULT EVAC LEDs.

RJ 9 for optional telephone headset, 3.5mm socket for Earphone-Mic headset. 

2 mini-jack plugs for optional headsets.

4.2.2.1 Control panel

 Microphone

A 280mm flex microphone.

 Power LED

This LED light up when the PPM-IT5 is powered on.

 Fault LED

To display  fault  status  of  system,  permanently  lit  if  a  fault  state  in  the  VACIE  system  has  been
engaged.

 EVAC LED

The EVAC LED won't light up because UAP G2 doesn't have the Evacuation function (normally lights
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up when system is under Evac paging).

 Left Button

Switch between Auto detecting the Microphone and phone jack.

 Middle Button

Push to talk for paging out during the half-duplex conversation.

 Right Button

Push to hang up the call during the half-duplex conversation.

 Monitoring Speaker

This embedded speaker to play chime when paging or monitor signal from audio processor,  it  needs
to  work  with  RS485  output  component  to  get  audio  signal  from  other  DSP  components  in  audio
processor.

  Touch Screen

A back-lit touch screen with 5" diagonal and 800 x 480 resolution,  each buttons in the PPM-IT5 can
be freely configured as a zone paging button or parameter adjustment in audio processor.

4.2.2.2 Side panel

1. Microphone and loudspeaker:

Use the internal speaker and microphone of PPM-IT5.

2. Phone Jack:

3.5mm headphone jack: To connect to a external headphone output.

3.5mm mic port (close to RJ9 connector): To connect to an external microphone input.

3. RJ9 Connector:

To connect to a RJ9 telephone handset.

4.2.2.3 LCD menu

All the buttons displayed on the  PPM-IT5  will  be  configured  via  Terracom  web  interface,  and  used  for
displaying and operation only.

The PPM-IT5 supports  multi-language,  allowing to set  the language shown on each button.  The  default
language is English.
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 Primary horizontal menu:

MAIN: Display the Device as button, Events as buttons and function buttons.

DIAL: For typing telephone numbers, SIP URI and so on.

MESSAGE: Messages list.

SETTING: Display the setting information.

 Content area.

 System status: Display the status of the device, such as a network cable is unplugged.

 Operation:

 SIP Call.

 Paging.

 Monitoring.

 Play message.
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 Back to root menu (works with Macro buttons)

 Select all.

 Page Up/  Down.

4.2.2.3.1  Main

Button types:

All buttons change to lighter color while pressed.

Device Button (Blue): Displays the device name on the button. There is  an indicator at  the upper-left
corner of a button showing its status, see the picture below:

Device Status

Available (Green)

Off line (Gray)

Busy (Red)

In case of changing a device button names.  you can  use  Ateis  Studio  to  change  the  name  of
LAP, ECS and IDA8 and enter in each Terracom device's web interface to edit its name.
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Paging Group (Orange) : The Paging Group button.  Press it  then start  paging by  speaking to the
goose-neck microphone of the IT5.

Pressing the orange button won't pop up for asking for permission to access. For example, if you
press PagingGroup button, the pre-chime will play right away for the paging.

Command Button (Orange):  Press to perform the Command (string) function  defined  on  the  web
interface.

Logic  Out  Button  (Orange):  Press  to  perform  the  Logic  (Out)  function  defined  edit  on  the  web
interface.

Locked Button (Orange): Similar to Command button, but it holds the Up/Down status.

Macro Button (Green): Manages buttons like a folder.  After create a Macro button,  press to enter
in its page. See how to create a Macro button.

SIP Call

Call to other device (one to one)
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Call from other device (one to one)
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Paging to multi-user



UAP G2 Manual50

© 2019, ATEÏS, member of PAX ProAV Group

4.2.2.3.2  Dial

BS: Backspace.

CANC: Cancel all. 

CAPS: Caps lock.

After entering the phone number, press the " " icon to dial from SIP Call. 

You can re-dial the last phone number by pressing " ".

If you intend to dial a local call, press the  icon to dial.
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4.2.2.3.3  Message

Play messages: 

Select the audio file > Go to Main page, select devices > Press  button.

The audio files are stored in the device's flash. You can check the free disk space on the web server.

The format currently supported is WAV(16k 16bit only). 

4.2.2.3.4  Setting
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Use - , + buttons to adjust the speaker volume.

 ( Volume ):

Use - , + buttons to adjust the speaker volume.

(Brightness):

Use - , + buttons to adjust the Screen brightness.

4.2.2.4 Characteristics

Case

Dimension = 250mm(W) x 140mm(L) x 80mm(H)

Weight =  1.1kg (2.43 lb)

Color = RAL7016

Screen

Diagonal = 5"

Resolution = 800 x 480

Power

Item Voltage Current Consumption Connect Type

PoE >19VDC 250mA RJ45

24VDC 24VDC - DC Jack

MAX Power consumption  = 6W.

Microphone Length: 275 mm.

Microphone Output

Maximum level = 6dBu.

Output Impedance = 100Ohm.

THD @ 1kHz < 1%.

Bandwidth @ -3dB = 100Hz ~ 18kHz.

Noise Gate Threshold = -84dBu ~ -24dBu.

Target Output Level = 0.

Max Output Level = -54dBu ~ 6dBu.

Attack Time = 8ms.

Release Time = 100ms.

Front Panel Speaker

Impedance = 4Ohm.

Maximum Power @ 1kHz = 1W.

THD @ 1kHz < 1%.
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Bandwidth @ -3dB = 200Hz ~ 12kHz.

Maximum Cable Length

100m on Category 5 cable

4.2.2.5 Connection

At first  connect  the  PPMTouch  to  your  TCP/IP  network.  If  your  switch/hub  provides  PoE  (power  over
ethernet) then you don't need to use a power supply.  The switch/hub will  bring power to the PPMTouch.
If you don't have PoE, then power the PPMTouch with the external power supply.

Set the IP settings of your PC to be on the same network than the PPMTouch.

4.2.2.6 Configuration

Define the PPMTouch in the UAP G2 software

With the PPMTouch,  there is  no need to put  it  in the System window as we do with the PPM and
PPM-SP.
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Double-click in the UAP G2 icon, to open the component list. 

Drag and drop one of the LPC to the design area. The PPMTouch can have 16 output zones at max.

Drag and drop the PPMTouch component to the design area.

Link the PPMTouch component output to the input of the LPC. Connect also the LPC outputs  to the
zone outputs.

 

 

Define Control

Control a fader:

In the UAP G2 software, open the component to control.

To control a fader, right-click on the fader and select "Third Party".
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Open View/Third Party, and select the "Elements" tab. You can see the element control.

Just add a "I" to the command ID (here C001) to increase or a "D" to decrease.

In this example, the command IC001, will increase of 2.2 dB.

The following content is not available on v1.0.3.54:

Click on the three dots ( ) of the event, that will open this window.

Here you can see three different command: Increase, Decrease, Read and Write.

If you want to increase or decrease the fader,  then you have to write the step (in dB) in the
horizontal

fader in the window top. The Command will change, depending of the step.

If you want  to write a value,  then  you  have  to  write  this  target  value  on  the  knobs,  in  the
window
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bottom. The Command will change, depending of target value.

If you want to read a value, then you don't have to set the knobs, just use the Command.

You can read, under "Commands", the Command string to be set in the PPMTouch.

Please see Set Control on PPMTouch.

Control a button:

To control  a  button,  we  need  to  use  two  events.  One  event  is  used  to  active  the  button  and
another to release it.

Open "View > Event Management."

Click [Add] two times, to create two events. Under "control Type" select "Element Adjustment".

Rename the event as you want.

Now push your button to have it in its  "active position".  Then right-click  in the button and select
the

event for the activation (in our example, Mute On).

Then do the same for the other button position. Release the button and assign it  to the event  for
the release (in our example, Mute Off).
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Now open again View/Events Management.

Notch the "third Party" option for the both events.

Check on "Mount", it must be 1 if the event is assigned to an element parameter.

Open View/Third Party, and select the "events" tab. You can see the both events.

Click on the three dots ( ) of the both events, one by one, that will open these windows.

You can read, under Command, the Command string to be set in the PPMTouch.

Compile and store the configuration.

Please see Set Control on PPMTouch.

4.2.2.7 Web interface

UAP G2 System embeds a web interface that  enables  you to control the PPM-IT5 through your favorite
internet browser.
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4.2.2.7.1  Window layout

 Main menu bar:

In this menu you will find the major operations related to your device which allows you to compile the
configuration design and to save the compiled configuration into the device.

 Second menu bar:

In this menu you will find the detail settings for each function. 

 Name / Version: 

Display the name of the product,firmware version and system time.

 URI:

 Display the URI (sip:x@y:Port).
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 Line / Out:

Display the information of Line Out(2 channels).In

 Content area: 

List the information of device and the adjustment of each setting. 

 Save/Cancel:

These buttons are made for users whether to save or cancel the settings.

4.2.2.7.2  Setup 1

Under the "Setup 1"  tab,  you can set  how PPM-IT5 connects  with network  and perform each functions
such as Stream Out, Logic Control, 3rd party control, etc.

4.2.2.7.2.1  Basic setting

Network:

DHCP: Enables/disables the Dynamic Host Configuration Protocol.

IP Address: Click to change its IP to fit  your network.  (Each Terracom device is  shipped from the
factory with a default IP address of 192.168.100.1)

Subnet Mask: Depends on the LAN where the Terracom devices located.

Gateway Server: The IP address of the gateway server.

DNS: Check the checkbox to enable the DNS server and type the IP address.

Serial:

This area is for the 3rd Party control.
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Speed(Baud),  Date  bits,  Stop  bits,  Parity:  Settings  for  3rd  Party  Control  and  SERIAL  LINK
bypass.

System Time:

Location: Click the drop-down list to select the location and click the [Save] button at the bottom
of the page to apply. 

Date/Time: Manually set the device's time.

NTP Client Service: Once enable this, the NTP Server IP is needed. 

Changes in the System Time area will  affect  the Scheduler  and  the  Current  Time  displayed  at
the upper right of the web page. 

Dial Agent:

On PPM-IT5's webpage: 

Agent  Service:  Enables/Disables  the dial function.  The PPM-IT5  will  become  the  dial  for  other
device with telephone card such as ECS. You need to add a VoIP component  for ECS by Ateis
Studio and type your IT5's IP at the Dial Agent field as shown in the picture below:
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Once the setting is done, switch to dial page of IT5 and you can start a telephone, see this.

Once enable this, the IT5 only remains the dial function.

On the webpage of other types of Terracom device (non-Terra-FXO and non-IT5): 

The Terra-FXO is the Foreign Exchange Station and can perform the telephone call with a phone
set  plugged.  Click  the drop-down list  to choose the FXO as the Agent  Device  which  has  been
added into the Address Book.

License (Only appears on IT5's webpage):

License Service: Enables/Disables the License Service, the user need to enter the username/
password before performing a call, paging, etc. Once the license service is enabled, you can set
the permission of buttons as well. See this.

Family Status:

Status Notify Service: 
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Enables/Disables  this  feature  for  the  management  and  monitoring  purpose  usually  when  the
network setting doesn't support IGMP. Under this occasion, a TerraServer is needed. 

Once  enable  Status  Notify  Service,  the  Terracom  device  will  unicast  its  online  status  to  the
Server,  and the Server will  spread it  to other devices,  therefore,  each device and be added into
Address Book and be communicated.

SERIAL LINK Bypass:

Serial to Network Service: Enables/Disables the bypass from the Terracom device to Network.

Network to Serial Service: Enables/Disables the bypass from Network to the Terracom device.

Third Party Controls:

There are two interfaces provided for 3rd Party Control:

Serial Controls  Service:  Enables/Disables  the  3rd  party  control.  Once  enabled,  the  "Serial"
setting area is required. 

 This will automatically disables the Serial to Network Bypass.

Network Controls Service: If the Network Controls Service is enabled, the local network  port  is
required.

Command String Controls:

Network Port: If the user choose Ethernet interface for Command feature, the source(network) port
must be assigned. 

SIP:
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Transfer  Protocol:  In  certain  cases,  users  may  use  the  Terra  Server  to  relay  the  audio  packet
through TCP or UDP.

Firewall Traversal Mode: For users to choose SIP server or not.

Username: For TERRA family to identify this device. 

SIP Port: Network port for SIP protocol.

RTP Port: Network port for RTP protocol, the value should be an even number.

AGC: If Auto Gain Control is enabled, the following items will appear:

o AGC Noise Threshold Control: The threshold for active AGC.

o AGC Maximum Gain Allowed: Limit the maximum gain in AGC.

Global Priority:

IDA8, UAP G2, LAP G2T and ECS use central priority control mechanism. The device priority  is
required while cooperating with these devices.

Once the SIP priority here is higher than the TerraManager's,  this  device's  zone won't  be able to
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paged by TerraManager.

Audio Codec: There are two Codec for SIP, G.711 / G.722 / G.726 / G.727   

Time to Stop Ring: The SIP call will be hung up after the set time.  If sets  up as  0 second,  it  won't
stop ringing.

SIP Auto Answer: The SIP call will be automatically picked up, usually for monitoring usage.

SIP Auto Answer Input: Choose the input source, MIC IN or LINE IN.

Booting Tone: The Terracom device will play the booting tone after it's ready.  

Speak Out  IP Address(CIN1):  Closing pin G and pin 1 during the  booting  tone,TERRA-EX,  EXA,
IEX, AMP, FDX, DS will speak out its IP Address.

Factory  Setting(CIN2):  Closing  pin  G  and  pin  2  during  the  booting  tone  will  restore  the  default
setting.

SIP Active/Inactive, Audio Out Active/Inactive: 

The  Terracom  will  trigger  the  chosen  "Logic  Out  (Single)"  Function  while  the  SIP  call/Audio
output  is  active/inactive.  The following  pictures  show the  change  of  a  logic  signal  in  time  line
graphic:

SIP active/ inactive indication

Logic Out (Single): Reverse mode

SIP :

Half-duplex: Enables/Disables the half-duplex intercom to PPM-IT5.

Once it's enabled, a new button "Push to Talk" appears on IT5's touch screen during a call from
Terra-DS as shown in the picture below:
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When the button is pressed, the IT5 is the party who transmits.

Stream Buffer:

Streaming Buffering Time: Buffering time for Audio-in from network.

Paging Setting:

You can only enable one setting a time.

TERRA  server  agent:  Paging  through  Terra  Server,  you  need  to  enable  the  "Family  Status"  as
well.

o TEERA Server IP: Enter the IP Address of your Terra Server.

IGMP  Fix  Address:This  is  for  multi-paging.  Enable  the  fix  address  to  use  the  specific  IGMP
address and disable the fix address to get the IGMP address randomly.
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4.2.2.7.2.2  Device list

Address Book:

If you need to use Function Libraries, the devices need to be added into the Address Book.

 The  priority  set  will  affect  the  paging  and  SIP  calls.  The  smaller  the  number  the  higher  the
priority.

RealTime Search:

Shows the list of all Terracom units connecting to your LAN, click "add" to add the device.

4.2.2.7.2.3  Function libraires

The Function Libraries chapter talks about how to set the functions for Control Inputs.

First things first, please make sure the Basic Setting and the Control Calibration are done completely.
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Allows the user to create a group as a function target with devices added in the address book.

Click the [Add] button to add a group as shown in the picture below:

Sends Command String to other device.

1. Set the Function and click Save. 
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String:  The command string depends on the target  device.  Terracom  only  receive  the  command
string in ASCII.

Interface: You can send Command string through the Serial port or Network.

Mode:

o Time Interval: The device will send the command string in period.

o Time Out: The device will stop sending the string if receiving the answer string from the target.

2. A Command (String) can be triggered by a Logic or by a scheduler.

By using a Logic:

Go to "Control Input" page and use logic to send a command.

After connecting a trigger device such as  a push button,  you can perform the function with the
setting listed below:
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o Control Input: Select the input your button is connected to. (IN1 means short pin 1 and

pin G)

o Controller: Select Logic.

o Position: N/A.

o Function: Select Command (String)

o Source: N/A.

o Target:  Select the command function you set.

After pressing the button, the command will be sent through Network or through Serial.

By using a Scheduler:

Go to "Scheduler" page and use the scheduler to send a command at the the time you set.

1. Go to "Setup2 > Scheduler". 

2. Click  the  first  drop-down  list  at  the  Command  area  to  select  "Command  (String)",  the
commands will show on the next drop-down list as shown in the picture below.

3. After the Date, Time and Repeat settings are done, the Terracom will  send the command
trigger by the scheduler.
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3. Here is  an example the PPM-IT5 sends command to control 3rd  party  type  of  UAP  G2,  ECS,  LAP
G2T, etc.

Send the string: %02hWC0051%03h$1%0dh from PPM-IT5.

o 02: This is a fixed value and cannot be changed.

o WC0051: Number created by Ateis Studio.

o %xxh: Convert xx into hexadecimal values.

o $1: Checksum.
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o 0D: This is a fixed value and cannot be changed.

Normally, you only have to change the "WC0051".

Here we can check the 3rd party control command received by the target:

String: %02hcmd=3rd WC0015%03h$1%0dh

Sends the Logic controls to the target.

1. Set the Function and click Save:

Name: The function's name.

Remote Target:  Select  the  target  you  want  it  to  perform  the  Logic  Out  as  a  remote.  If  none  of
items are selected, the target will be the local device.

Channel: Depends on the type of Terracom. For example, the Terra-IO has 8 relays. 

 If the Terracom device doesn't have the channel you chosen, no activity will be taken.

Value: 

o LOUT_MODE_ZERO: Contact output's channel relay will be "Normally open".

o LOUT_MODE_ONE: Contact output's channel relay will be "Normally close".

o LOUT_MODE_TOGGLE: Contact output's channel relay will switch between open and close.

o LOUT_MODE_PULSE: Close during High period then open during Low period like a square
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wave.

High/Low period: The period between each pulse.

Times: The times of the pulse.

o LOUT_MODE_REVERSE: Reverse the last status.

2.  Go to "Control Input" page, there are two ways to use the Logic Out(Single) function.

By using the Logic:

Here we use an example to explain how the remote control works with Logic Out(single)
function.

After connecting a device such as a power switch which can be controlled by a Terracom
device's relay. You have to set a logic input (button) to trigger the Logic Out (relay). See the
picture below:

FDX uses IO's relay to open the Amplifier's power.

o Control Input: Select the input the button is connected to. (IN1 means short pin 1 and pin
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G)

o Controller: Select Logic.

o Position: N/A.

o Function: Select Logic Out.

o Source: N/A.

o Target:  Select the Logic Out(single) function you set, here we use Power_On.

After pressing the button connected to FDX, the IO switches its  relay  to open the power of the
Amplifier.

By using a Scheduler:

Go to "Scheduler" page and use the scheduler to send a Logic Out at the the time you set.

1. Go to "Setup2 > Scheduler". 

2. Click  the  first  drop-down  list  at  the  Command  area  to  select  "Logic  Out  (Single)",  the
logic out function will show on the next drop-down list as shown in the picture below.

3. After the Date, Time and Repeat settings are done, the Terracom will  send the Logic  Out
signal triggered by the scheduler.

The Marco manage the sub-page and controls the function at the same time.

1. Set the Function's name and click Save.  
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Name: The button name.

Control: This item is for Logic Out(Single) and Command(String), the action will be taken while the
Marco button is pressed.

2. Go to Main Window page and set the Marco button you create before.

Click the drop-down list to switch between Macro and the Main page.

Button  Function:  There  are  Device,  Paging  Group,  Command(String),  Logic  Out(Single)  and
Locked Btn.

Button Name: The name of each button appears on IT5's touch screen.

There is  no way  to  move  buttons  from  one  Macro  to  another,  you  need  to  add  those  buttons
manually.

Pages to all devices in the group.

1. Select  devices  you  want  to  paging  and  give  this  paging  group  a  name,  here  shows  "p115"  which
includes 4 devices.
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2.  Go to "Control Input" page, there are two ways to use the Paging Group function you set.

By using a Logic:

After connecting a trigger device such as  a push button,  you can perform the function with the
setting listed below:

o Control Input: Select the input your button is connect to. (IN1 means short pin 1 and pin

G)

o Controller: Select Logic.

o Position: N/A.

o Function: Select Call Button.

o Source: Select the source, MIC IN or LINE IN.

o Target:  Select the target, here we use p115.

By pressing the button to start  a paging to all  devices (if the priority  is  lower than other current
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paging source, the paging failed)

By using a RAC 5 or RAC 8:

After connect a RAC and a button, you can perform the function with the setting listed below

o Control Input: Select the input the RAC is connected to (IN1 means short pin 1 and pin

G).

o Controller: RAC 5 (or RAC 8).

o Position: The channels of the RAC.

o Function: Select Call Target.

o Source: N/A

o Target:  Select the target, you can set 5 (or 8) different targets.

Now, set a button (as mentioned before) to trigger for RAC.

o Control Input: Select the input your button is connect to (IN2 means short pin 2 and pin

G).

o Controller: Select Logic.

o Position: N/A.

o Function: Select Call Trigger.

o Source: Select the source, MIC IN or LINE IN.

o Target:  Select the target, here we use "IN1" where the RAC is connected to.

Easily switch the knob to the target you want and press the button to paging.

Locked Button is  associated  with  External  Variable  and  only  appear  at  PPM-IT5's  Function  Libraries.
Here we use a simple example showing how to combine those functions steps by steps:
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Pressing one button on PPM-IT5 to control the w indow with the Terra-IO.

Add a Locked Button function:

This is for performing the Logic Out with External Variable's status.

Name: Button's name, this will appear on IT5's touch screen.

Down trigger action: Select the Logic Out(Single), action when the button is down.

Up trigger action: Select the Logic Out(Single), action when the button is up.

Status: This is the External Variable function.

After the Locked Button function added, see the next chapter to add an External Variable function.
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Allows other device to control Terracom devices through 3rd Party  Control.  You have to enable  the  3rd
Party Control at Basic Setting page.

1. Set the Function and click Save.  

Name: Function's name as the string.

Function:

o Call: Calls one device or call devices one by one.

o Paging: Pages to device. (One or more)

o Message: Plays message to device. (One or more)

o Monitor: As the monitor function of PPM-IT5's.

o Hung up: Closes the session (Call, paging, Message, Monitor).

o Logic out: Controls local Logic Out or remote Logic Out by sending UDP packets.

Source: Choose the The MIC-IN or LINE-IN from the Terracom.

Target: The target for the selected function, a group or a device. 

Example:

3rd party control Terracom device:

We use this  program “UDP Test  Tool  to command IT5,  string:  cmd=3rd  ______,  underline  is
the function's name. 

And then the PPM-IT5(192.168.101.215) will call AMP-101217.
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Add an External Variable function and save.

This is for updating the button status with the true/false value and showing the "button up" or "button
down".



Product features 81

© 2019, ATEÏS, member of PAX ProAV Group

Name: The name of the function.

Type: The type of function, select Logic.

True/False: The elements of the answer string.

Auto Update: The command string, see the picture below.

Name: The function's name.

String: The command string depending on what your target device can receive and read. 

Interface: Choose Network

o Network IP: The IP of the device which performs the Logic Out.

o Network Port: The Port of the device which performs the Logic Out.
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Mode: The way a device answering the command.

o Time Out:  The device will  stop sending the string if receiving  the  answer  string  from  the

target.

o Time Interval: The device will send the command string in period.

Ans: Click the [Add] button to add the Variable, here is #Status#. 

Time Out: Set the time out, the unit is millisecond.

Repeat: The times of sending the command string.

In this  case,  the answer string would  be  "I  am  open"(true)  or  "I  am  close"  (false).  Once  PPM-IT5
receive this, it will update the button's status(up or down).

Jumping pages via the PPM-IT5 by using this function. Users can customize the pages which reduce the
difficulties for switching pages repeatedly. 

1. Select the "Goto Button" function at "Setup1 > Function Libraries".

2. Choose the name of the function.

Edit / Delete: Edit or delete the selected function.  Edit:  To open the setting window, see the next
picture below. 

Add: Set more page jumping function. 

3.Select the customized function users intend to change via PPM-IT5, then press the [Save] button.
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Name: The customized name of each button appears on IT5's touch screen.

Page:  Choose the modified page intending to switch to . 

Save the alteration to perform a page jumping function on PPM-IT5.

Set the Null Button for specific black space via the PPM-IT5 by using this function.

1.Choose the specific page and button to set the null button. One page is consisted of a maximum up to
twelve buttons. Users shall customize the function for their demand. 



UAP G2 Manual84

© 2019, ATEÏS, member of PAX ProAV Group

2.Once the setup has completed, see the picture below and check whether the alteration is modified or
not.  

4.2.2.7.2.4  Main window

Here you can set the buttons of PPM-IT5, this will immediately show on its TFT screen.

Use " " and " " to add/delete buttons, it needs to click  the [Add]  icon to confirm the last  button you
added.

Button Function:

Device:

The booked device, the button name is the same as the device's name. See this.

Paging Group:

The  Paging  Group  button  is  a  group  of  devices  edited  in  the  Function  Libraries.  The  paging
starts and the pre-chime plays after the button pressed. See this.

Command (String):
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The button which sends a command string edited in the Function Libraries. See this.

Logic Out (Single):

The Logic Out edited in the Function Libraries, see this.

Locked Btn:

The Locked Btn edited in the Function Libraries, see this.

Macro: 

The Macro edited in the Function Libraries for managing buttons. See this.

Goto Button:

The Goto Button edited in the Function Libraries, see this.

Null Button:

This Null Button edited in the Function Libraries, see this.

Button Name:

You have to add functions at  the Function Libraries  page,  then the items will  appear at  each  drop-
down list.

License Service:

Once  the  license  service  is  enabled,  you  can  set  the  permission  of  buttons.  The  password  is
required for the unchecked items.

The keyboard for typing the password appears when the secured button is  pressed as shown in the
picture below:
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4.2.2.7.2.5  Volume control

Volume: 

Adjust the level of built-in speaker. 

Phone Jack:

Adjust the level of Audio In-Out (3.5mm phone jack).   

Microphone:

Adjust the level of built-in microphone on your PPM-IT5 device.

Chime itself:

Adjust the level of chime sounds for the built-in speaker. 

Chime out:

Adjust the level of chime sounds for other paging zones.  
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4.2.2.7.2.6  GUI

Here you can change the font size and language of the main buttons, you have to reboot PPM-IT5 for the
changes to take effect.

Display Settings:

Screen Timeout: Set the Screen Timeout from 15 seconds to 30mins. 

Disable Screen Saver During Phone Calls:  Enable or Disable the Screen  Saver  function  on  your
device. 

Enlarge Font: Enlarge the font from scale 80% to 160 %.

Backlight Level: The level settings for backlight control.

Label Settings:

PPM-IT5 supports multi-language  Here you can change the name of MAIN, DIAL, MESSAGE,
SETTING.  It will also display on the PPM-IT5.

4.2.2.7.3  Setup 2

Under the "Setup 2"  tab,  you can set  how PPM-IT5 connects  with network  and perform each functions
such as Account Management  and Scheduler.

4.2.2.7.3.1  Account management

Here you can manage the accounts, such as add/delete a user's ID and change one's password.

Five default account:

1. admin / admin
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2. ateis / ateis

3. user1 / user1

4. user2 / user2

5. user3 / user3

If you want to change an existing account, the old password is required.

4.2.2.7.3.2  Scheduler

Custom Scheduler List:

You can click  the Example to see  how to  set  a  scheduler.  The  schedules  will  be  listed  after  the
example, click the content for further editing or to delete. 

New Scheduler:
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Name: Scheduler's name.

Start On: The start time. 

Time: From 00:00 to 23:59.

Command: Logic Out(Single), Command(String) and Play message.

Repeat (YYYY/MM/DD)

o Daily: Repeat every day.

o Weekly: Repeat weekly, you can choose the weekdays.

o Monthly: Repeat the DD every month.

o Yearly: Repeat the MM/DD every year.

If you want to repeat two or more days monthly or yearly, please set another scheduler.

End: The end time.

Summary: No function for the moment.

4.2.2.7.4  Update

Firmware:
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You can download the newest version of Firmware on Ateis website.

Configuration:

It will create a file with .sql extension in your PC. 

Only  upload files  backed up  using  this  firmware  and  from  the  same  model  of  devices.  Do  not
upload any files that were not created by this interface.

Message / Chime:

Here you can set  the Pre-Chime/Post-Chime of Paging and  Message.  Click  on  the  "Upgrade  new
chime file" to add more chimes. 

The format currently supported is WAV(16k 16bit only).

Logo:

Here you can customize your own Logo figure on the device. (Size: 75x75 , PNG file)

http://www.ateis.com
http://www.ateis.com
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Reboot:

Reboot the Terracom device, this would take a while.

4.2.2.7.5  Status

TERRA System:

Shows the basic information of the Terracom unit. 

TERRA Family:

Shows the list of all Terracom units  connecting to your LAN and some Ateis  Devices which can be
paged or received SIP call from Terracom such as IDA8C, UAPG2, etc.

LAP G2T and ECS needs VoIP component edited.

Control Calibration:

Displays the result of control input calibration.

Log File:

Displays the log file, it is up to 3000 lines of text.

4.2.2.7.5.1  System

System time: 

Displays  the  current  time.   You  can  change  the  location  and  NTP  server  at  "Setup1  >  Basic
Setting".

Network: 

Displays the IP address, MAC address, etc of the local Terracom device. You can change each filed
at "Setup1 > Basic Setting".
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SIP:

Displays the SIP information. You can change each filed at "Setup1 > Basic Setting".

Detect Router type:

The following are router's types:

1. Open: This device is under Open Internet.

2. Independent Mapping, Independent Filter: This device is under Full Cone NAT.

3. Independent Mapping,  Address Dependent  Filter:  This  device  is  under  Restricted  Core
NAT.

4. Independent Mapping,  Port Dependent Filter: This  device is  under Port  Restricted  Core
NAT.

5. Dependent Mapping: This device is under Symmetric NAT.

6. Firewall: This device is under Symmetric Firewall..

7. Blocked or could not reach STUN server: The UDP is Blocked.

 If shows the type 2, 3 which means the router supports  STUN protocol and can go through NAT
automatically.

 If shows the type 4, 5, 6 which means the router doesn't support the SIP, you need to use a SIP
server or TerraServer.
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 If shows the type 7, please contact the technician to fix your network.

4.2.2.7.5.2  Family

URL: Shows the web interface URL of the Terra com device and its SIP Port.

Available status: 

o Available: The device is available for SIP call or paging.

o phone (caller)/(callee): The SIP caller and callee.

There is no way to know which device is called by which device is.

4.2.2.7.5.3  Log file

Click the Log File will open a new window displaying the log content.

You can save the webpage to a single html file.
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4.2.3 URC

URC can  be  fully  programmed  via  UAP  G2  software  to  adjust  every  setting  you  want:  volume,  mute,
preset,  components' adjustments,  etc.  This  remote device is  connected to the UAP G2  via  the  RS485
port.

Use a URC

Because every  remote device needs power,  you will  have to add external power supply  every  three
remotes devices or every  300 meters.  Except  for  the  first  three  remote  devices  or  the  first  300m,
power will be delivered by the UAP G2. The maximum distance between UAP G2 and remote device
is 800m.

There are six main steps to configure a URC or several URCs:

1. Connect the URC(s)

2. Define the system with the URC(s)

3. Search and set the URC (The UAPG2 scans the system and attributes  a specific  IP address
for each remotes device (PPM and URC) automatically)

4. Define and adjust URC's parameters

5. Assign adjustments

6. Set adjustments

If you have some troubles during the procedure, try to clean the UAPG2 memory (first try to clear
remote IP address, after, if needed, try to clean MCU data then restart UAPG2-PPM software)
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4.2.3.1 Control panel

 OLED Display

 Exit Button

Back to the main menu.

 Knob

Turn: Select items or change volume.

Press: Enter in the sub menu.

 Back Button

Back to the root menu.

4.2.3.2 Characteristics

Case

Dimension = 84mm (W) x 33mm (L) x 84mm (H).

Weight = 0.08KG.

Power

Item Voltage Current Consumption Comment

DC Input 24VDC 20mA -

Maximum Cable Length

1200m on Category 5 cable.

4.2.3.3 Connection

To connect URC, use the RS485 connector at  the rear of the UAPG2. For several URCs you may have
to use Junction boxes (JB), or you can daisy-chain them. See This.

If you have a bad connection: Switch on the end line resistor on the last  URC (Blue switch:  1 =
inactive, White square = active).
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4.2.3.4 Configuration

Define the system with URC

Drag and drop the URC to the communication port of the UAPG2 (C,  at  the top of the inputs).  If you
have  several  URCs  and  several  UAPG2,  define  the  URC to  the  UAPG2 in  the  same  way  as  the
physical connection.

Search and set URC

After  defining  the  system,  it  is  necessary  to  communicate  where  and  who  are  the  URCs  to  the
system. The research procedure is automatic, but requires to be launched. 

1. First make sure to clear all old remote IP address. Clear remote IP (Shift + F5).

2. Click “View Remote list” or hit F9.

3. You can also double click on one of the URC’s icons. A windows appears, click [Search].
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A window appears, click on URC’s page, not on PPM’s one.

Then, Click [Search ], a new dialogue window appears, click [Search] again.

4. When the system has finished the search,  a list  with the various connected URCs or PPMs
appears. 

5. Each URC is  identified by  its  own serial number.  This  number is  written on a sticker on  the
URC. The system finds automatically each URC (in our example the URC’s  serial numbers  is
U00185).

If the system doesn't find all the devices: Clear all remote IP address and search again. 
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6. Click [Close] to close the Remote Search window.

7. Set  the  URC:  Select  the  URC  in  the  first  window  by  assigning  the  corresponding  serial
number to each URC (for our example we have connected a URCs on UAPG2 1) :

8. Click [Apply], then click [OK].

9. The system is now ready to work with the URC.

Define and adjust URC’s parameters
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Serial No: 

Indicates which URC you are going to configure.

Name: 

Gives a name for this URC. Essential when you have several URCs connected. 

All the following options will be explained in details.

About: 

You can write few words in the default  menu called "About"  The user will  also  have  access  to
the URC’s version number in this menu. You can also change the name of this menu.
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o Title:  Title  for  the  menu  which  appears  on  the  screen  of  URC  after  the  various

adjustments’ choices (Max. ten characters).

o Add and Delete: Adds or deletes a line of ten characters.

o Memory: Indicates the state of filling of the URC’s internal storage.

Assign right: 

Enables  to  protect  several  settings  with  a  password.  By  clicking  on  Assign  Right  you  can
protect some adjustments you have created in the URC. Just  select  if you want  the adjustment
to the first layer (not protected) or in the protected layer.
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To access to the protected layer:  Hold exit  and back and push the knob.  Then  enter  the  user
name, select [apply], enter the password and select [apply].

Logo: 

Enables to choose two different logos. Those logos will appear on the URC screen. It is  possible
to post two different images to the screen of the URC. Only one image at  a time can be shown.
By clicking the logo button the following window appears:

o Constant Mode: Chooses one image (A or B) to be posted on the screen of the URC.

o Advertisement  Mode  (warning  mode):  Alternates  the  two  images  every  swap  time

seconds.
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o Waiting  time:  Sets  the  number  of  seconds  before  the  URC  returns  to  its  initial  state

(apparent  logo,  and  you  have  to  push  twice  the  rotate  knob  for  accessing  the
adjustments). Be sure to let enough time to the user to read and choose.

o Open: 

You can search and assign to the URC any images (be careful about  the image size.)
you  have  on  your  computer  by  clicking  on  Windows  File  or  Logo  Library  button.  By
clicking Logo manager,  a window shows you which images you have selected for your
URC.

 

You can use any type of image you want. But the screen of the URC has only one color
(plus the black background). So the best image parameters are:

Size: 128x64 pixels.

Color: Black and white.

Search: 

You  can  launch  the  URC’s  research  process  from  here.  See  the  "Search  and  set  URC"
paragraph above.

Global Parameters: 

Manage  the  choices  of  Master  Preset  to  which  you  will  have  access  with  the  URC.  (Master
Preset:  change all  the system’s  design.  On this  tab you can create a Master-Preset  selection
on the URC. This  tab is  called "Global Parameter"  because these parameters  will  be  available
from every Master-Preset. It's different than the others tab, "Sub-Preset  and Parameters",  where
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the parameters are depending of the Master- Preset.  Of course at  first  the Master-Preset  must
be created. To create Master-Preset, please see Master- Preset chapter.

To check your Master-Preset click on [Name] button, next to the Master-Preset unroll menu.

Open the URC settings window, and select the "Global Parameters" tab.

Click on [+ Add] to create a Master-Preset selector.
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You can change the name in the Label space.

Click on the three dots (  ) on the right of the “Assigned” space, a window opens and you can

choose which Master Preset is accessible with this function (Here named: MP-SP SEL.)

With this adjustment, you can then choose to switch between two modes/master preset  pages
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(conference or music for example) by clicking twice on the rotate knob of the URC and clicking
on “MP-SP SEL.” on the URC.

You can have several "MP-SP SEL." (by clicking [add]) with several Master Preset  choices,  just
cross the check box after clicking the three dots on Assigned.

The  setting  is  complete.  To  activate  this  parameter,  compile  and  store  the  configuration  into
UAP.

Sub Preset and Parameters: 

On this  tabYou can manage the choices of parameters  and Sub Preset  to which you will  have
access with the URC. Assign adjustments of component to a URC for a specific  Master Preset.
The parameter of this tab depends of the Master-Preset.  You have to create the parameters  for
each Master-Preset individually.

So  at  first  select  in  which  Master-Preset  you  want  to  have  the  adjustments.  Open  the  URC
settings window by clicking on the URC icon. Click on "Sub Preset and Parameters" tab.

You can then Add or Delete all the kind of adjustments you want to have on the URC. Be aware
however not to overload the URC memory.
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Assign a Label (name) for each of them. Not  that  here you just  define  how many  adjustments
you will have with the URC.

Unroll the "Control Type" menu, and select if it is a Sub-Preset control or an Element control.

Follow the step in the chapter "Sub-Preset" or "Element Control".

Memory: 

Indicate the state of filling of the URC’s  internal storage.  Pay attention to not  exceed the  URC
storage capacity.

4.2.3.4.1  Element control

Now that  we have create the Element  parameter (Sub Preset  and Parameters  tab chapter),  we have to
assign this element control to an adjustment.
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To assign the control to a specific action (adjustments),  go to the design (double click  on the UAPG2’s
icon), then double click on the component (module) of which you want to use an adjustment. 

Finally  right  click  on the adjustments  and select  "URC > UAPG2 (or the name you have given) > URC
(or the name you have given) > Label (or the name you have given)".

Assign adjustments

 You  cannot  control  an  element  if  the  corresponding  inputs/outputs  of  the  component  are  not
linked  to  something.  As  example,  to  control  the  volume  of  the  channel  3  on  a  volume  control
component, the input 3 and output 3 of the component must be linked to something.

Go to the design (double click on the UAPG2’s  icon),  then double click  on the component  (module)
of which you want  to use an adjustment.  Finally  right  click  on the adjustments  and select  "URC >
UAPG2 (or the name you have given) > URC (or the name you have given) > Label (or the name you
have given, in our example it's "volume")”.

If you see an asterisk,  it  means that  another adjustment  is  linked to this  label.  It  is  impossible  to
assign two different  types of adjustments  (for example a mute with a fader) on a same Label,  they
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must be the same type of adjustment.

This is only visible when the machine is connected.

Now, on the URC setting window you can see the number  "1"  under  "Assigned",  that  means  that
this control is assigned.

The setting is complete. To activate this parameter, compile and store the configuration into UAP.

With this adjustment, you can control an element  by  clicking twice on the rotate knob of the URC,
clicking on “volume” (the Label), and move the knobs on the URC.

After that,  you can set  the adjustments  (default  values,  unity  on URC's  screen),  by  clicking on the
three dots in the URC setting window. (next chapter).

Set adjustments

Open the URC setting window. You can see how many module's adjustment you have assigned to a
label (number in the assigned column).

For  example,  in  the  following  window,  we  see  that  there  are  two  actions  connected  to  the
Volume_CD label.
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By clicking on the three dots (  ,  in assigned column) a box appears.  According to the assigned
function some adjustments are available by clicking in the box and set the value):

UAPG2 Column: If there are several UAPG2s: shows on which the action is undertaken.

Component,  ID Element,  Input,  Output,  Band:  Shows  which  components  and  which  kind  of
adjustments are assigned to this label.

Max, Min, Step, Type: Enables to adjust parameter adjustment. For example here we have fixed
the max level at 20 (dB), the minimum at -40 (dB), Step: fix the incrementing. Type: choose Linear
or Log.

Unit: Insert a unity for the adjustments, here: level in dB, this unity will be displayed on the URC's
screen.
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Protect the access to URC with Password

You can protect the access to the element of the URC with a Password.

To do this, you have to use the IDM (access to Master-Presets), not the UserID.

Open User >ID Management, and then create a new IDM associated with the Master-Presets.

Our advice is  to use a very  short  user name  and  password,  because  it  takes  time  to  enter  these
names with the knobs of the URC.

On  the  URC window click  on  [Assign  Right],  a  window  will  open  and  display  all  the  parameter
created in the URC:

Then for each parameter,  select  if you want  it  in  the  first  layer  (not  protected)  or  in  the  protected
layer.
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Now, to access to the protected layer on the URC, the user will  have to hold exit  and back buttons
and push the knob. Then enter the "IDM user",  select  [apply],  enter the "IDM password"  and select
[apply].

4.2.3.4.2  Sub-preset

Now that we have create the Sub-Preset  parameter (Sub Preset  and Parameters  tab chapter),  we have
to assign this control the sub-presets.

The Sub-Presets must be created before. Check the Sub-Preset tool bar in the main window.
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If there is no name next to "Sub-Preset" that means that  there is  no Sub-Preset  already created.  In this
case see Sub Preset  chapter to create a sub-preset.  You can display  the Sub-Presets  list  by  clicking
on [Name] in the sub-preset tool bar.

On the URC settings window,  click  on  the  three  dots  (   )  on  the  right  of  the  "Assigned"  space,  a
window opens and you can choose which Sub-Preset is accessible with this function.

Close this window. Now you can see the number 1 under "Assigned".



Product features 113

© 2019, ATEÏS, member of PAX ProAV Group

The setting is complete.

To activate this parameter, compile and store the configuration into UAP.

With this adjustment, you can then choose to load a sub-preset  by  clicking twice on the rotate knob of
the URC and clicking on "sub 1" (the Label) on the URC.

4.2.4 URC200 TPC

The URC200 is an programmable remote controller (TCP/IP) for the UAP G2, IDA8 system, LAPG2T and
ECS DSP audio matrix System. It allows users to customize the menu items for the control parameters,
master/sub presets of Ateis audio processors.

The URC200 contains  a color 2"  TFT panel,  and with the well designed user interface it  gives  the  user
the best experience of using this control console. Two buttons and one encoders  make menu controlling
very simple and easy.

The URC200 is  powered over  IP  and  easy  to  integrate  with  current  demands  for  room  controllers  like
light,  curtains,  sound  and  video  control.  The  full  color  display  is  easy  to  read  and  has  a  low-power
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consumption to allow for long lines and multiple devices into one system.

4.2.4.1 Control panel

 TFT Panel:

A color 2" TFT panel presents the menu system of URC 200 TPC.

 IR Receiver:

It receives the control signals of handheld devices for controlling the system.

 Back Button:

This button is used for going back to the upper layer of the menu.

 Encoder:

Rotate this encoder for select the item of the menu.

 Enter Button:

This button is used for going into to the inner layer of the menu.

4.2.4.2 Characteristics

Case

Dimension = 140mm (W) x 108mm (L) x 34mm (H).

Weight = 0.35Kg.

Color = RAL7016.
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Screen

Diagonal = 2".

Resolution = 176 x 220.

Power

Item Voltage Current Consumption Comment

PoE 19V - -

DC Input 18V~26V, Typical 24V 50mA -

Maximum Cable Length

100m on Category 5 cable

4.3 Junction box

The junction box (JB) is the device that contains the wiring junctions and allows the peripherals  such as
PPM-SP and URC be wired in chain using STP CAT5/6 cable with metal shielded connector.

5 x RJ45 connectors

1. RS-485 MAIN-IN + AUDIO OUT: Connect  to the RS485 terminals  of  UAP  G2  or  connect  to  the
previous JB.

2. RS485-SIDE: Connect to a URC device with 8-pin STP CAT5 cable.

3. MASTER PPM: Connect to a PPM-SP using the supplied 10-pin CAT5 cable.

4. SLAVE PPM: The Slave PPM function is not available for PPM-SP.

5. RS-485 MAIN-OUT: Connect to the next JB.

2 x internal screw connectors for 0 dB audio

6. AUDIO OUTPUT: Audio output from PPM microphone to UAP G2 processor.

7. AUDIO  INPUT:  Audio  input  from  UAP  G2  processor  to  the  speaker  of  PPM-SP  for  monitoring
surveillance.

no91
註解
換新圖

no91
螢光標示



UAP G2 Manual116

© 2019, ATEÏS, member of PAX ProAV Group

8. 1  x  input  for  external  24VDC power  supply.  Depending  on  the  distance  between  the  UAP  G2
processor and PPM-SP/URC devices. 

2 x internal switches

9. 1  x  internal  switch  inside  the  JB  for  PPM  Master/Slave  selection  (Slave  PPM  function  is  not
available for PPM-SP). 

10.1 x internal switch inside the JB for System Power or External Power, see Figure 1.

Figure 1

LEDs:

POWER SYSTEM: Light up when the power comes from a local power supply.

POWER LOCAL: Light up when the power comes from UAP G2

READY: Light up when the Junction Box is powered correctly.

4.4 Amplifier

4.4.1 SPA

4.4.1.1 Overview

The SPA (Security  Power Aamplifier) is  designed  for  perfect  integration  into  the  SINAPS  system,  but
thanks to its flexibility, it can also be used for any Public Address application.

SPA 2060

no91
註解
換新圖
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SPA 2120

SPA 2240

The  SPA  were  specifically  developed  to  meet  the  requirements  of  EN  60849  for  safety  installations.
Each  amplifier  module  is  fitted  with  its  own  220  VAC/24  VDC  power  supply  for  increased  system
reliability. To avoid handling errors, the volume output is set  using the potentiometer located at  the back
of the apparatus.  In addition to standard protection via  fuses,  SPA  amplifiers  also  have  electronic  and
thermal protection to protect them from all potential hazards.

A fan provides forced cooling for the final power shelves and internal parts  of the apparatus.  It  starts  up
automatically  when the temperature reaches  a  certain  threshold,  and  stops  when  it  returns  to  normal
values.

Four LEDs display the status of each amplifier: AC or DC power supply,  Line Overload and Temperature
overload.

Furthermore, a three LEDs Vu-Meter indicates the presence and level of audio signal.

A  surveillance  circuit  continuously  monitors  the  temperature  and  the  presence  of  AC  and  DC  power
supplies for both amplifiers. In case of a problem, the overload LEDs will  be switched ON and the Fault
relay will be activated.

The  SPA  series(SPA  2060,  2120,  2240)  can  be  ordered  with  optional  115V  power  supply.  Please
contact your local dealer or your regional ATEÏS branch office.

Main Characteristics

2 audio outputs (selectable 100 /70 / 8 Ohm outputs)

Fault reporting outputs

Two audio input gain control
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Supervision of the amplifiers using DIVA8 or IDA8 controllers

Advanced audio processing for each amplifier channel using DIVA8 or IDA8 systems

Amplifier supervision and spare amplifier switching through DIVA8 or IDA8 systems

Loudspeaker line and loudspeaker supervision through DIVA8 or IDA8 systems

Specifications

Output power: 

o SPA 2060 : 2ch X 60W

o SPA 2120 : 2ch X 120W

o SPA 2240 : 2ch X 240W

Output voltage: 8 Ω /  70 V / 100 V

Power type: 24 (range 21-28) VDC and 220 VAC

Connector (electronically balanced):  3-pin XLR and 3-pin phoenix

Frequency response: +/-3 dB @ 40 Hz and 20 kHz

S/N: 86dB@ 1 kHz at full power

THD: < 1% @ 1 kHz

Input range: -6 dBV to 6 dBV / 770mV

Input impedance: 22k ohm

4.4.1.2 Front Panel

 VU Meter

The VU-meter is  composed  of  three  LEDs  that  represent  three  different  level  thresholds:  -40dB,  -
20dB and 0dB. When the input signal reaches those thresholds, the corresponding LED will blink.

 Overload

The overload LED will blink as soon as the output  power exceeds the nominal value.  If the Overload
LED is blinking,  check that  the output  load is  well connected and still  in good condition as  well as
checking the level of the input signal.
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 Temp.

If the device internal temperature exceeds 95 degrees C,  the TEMP LED will  light  and the pre-amp
will  stop working until  the temperature falls  below 95 degrees C.  The pre-amp will  come  back  to  a
working state automatically.  To avoid temperature failure,  please insert  an external  fan  to  the  rack
system.

 DC

The DC LED indicates that the SPA amplifier is powered by a 24VDC power supply.

 Power

The Power LED indicates the ON/OFF status of the SPA amplifier.

4.4.1.3 Rear Panel

 Fuse Receptacles

Two fuse receptacles are located on the left of the amplifier’s rear panel.

 Power Switch

The power switch is located at the left of the rear panel and is a two position switch.  Pushing up the
power switch (I is  pushed) will  power on the device,  pushing it  down (0 is  pushed) will  power it  off.
When the power switch is on the I position, the front panel power LED will be lit.

  Channel 1/2 24VDC battery backup connector

The SPA amplifier can be operated with battery  backup.  Use the channel 1 and channel 2 “24VDC
Battery Backup” connector to do so. These connectors are located on the upper part  of the channel
connectors on the rear panel.

This 24VDC power supply can be used where no AC power is available. When in use, the front  panel
Power LED will be lit as well as the front panel DC LED.

 AC Power Inlet

The 3 pin IEC connector is  located  on  the  left  of  the  amplifier’s  rear  panel.  It  accepts  a  standard
mains power lead fitted with an IEC connector.

For 115 V, fuse rating: 

SPA 2060: 2.5A
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SPA 2120: 5A

SPA 2240: 8A

For 230 V, fuse rating: 

SPA 2060: 1.25A

SPA 2120: 2.5A

SPA 2240: 5A

 Channel 1/2 Audio Output

For each amplifier channel,  there is  a dedicated Audio Output  connector for connection  of  either  8
Ohm speakers,  75V speakers  or 100V speakers.  For the  8  Ohm  connection  and  if  you  are  using
more than 1 speaker, please ensure that speakers are wired in a way that  the total impedance load
is between 8 Ohm and 16 Ohm. The Com point is the  terminal and 8 Ohm, 75V and 100V are the
+ terminals.

 Fault Contact

The fault contact indicates an amplifier fault by an opening contact.

 Channel 1/2 Outputs

Each channel outputs a replica of the corresponding balanced audio input signal either on XLR or on
Euro-terminal block.

 Channel 1/2 Inputs

For each channel,  there is  an XLR balanced input  and a Euro-terminal block  balanced  input.  Each
input  can be  gain  adjusted  to  suit  the  user’s  needs.  The  On/Off  gain  switch  can  instantaneously
bypass the gain controller and set the channel gain amplifier to maximum.

4.4.1.4 Characteristics

Case

Dimension: 

o SPA2060, SPA2120 = 483mm (W) x  305mm(D) x 88mm(H) 

o SPA2240 = 483mm (W) x  420mm(D) x 88mm(H) 

Weight :

o SPA2060 = 10.6 Kg (23.3 lbs)

o SPA2120 = 12.3 Kg (27.1 lbs)

o SPA2240 = 18.5 Kg (40.8 lbs)

Color = RAL7016.

Power

Item Voltage Current Consumption Comment

AC Input 230V +/- 10% 1.2A Frequency:47Hz~63Hz

DC Output 24~27V, Typical: 24V 1A -

Audio 

Frequency response = 40 - 20 000 Hz
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Distortion at nominal power: < 1%

Signal/noise ratio: > 90 dB

 Inputs/Outputs 

Power output = 100 V

Main line input = 770 mV

Input impedance = 20 KOhms

Current consumption

Current consumption with 28 VDC supply (per channel)

Standby 1/8
Nominal
Power
(Audi

Messages)

1/4
Nominal
Power
(50%

Message,
50% Siren)

1/2
Nominal
Power
Siren

Nominal
Power

Power
Consumpt

ion

SPA2060 0.19 A 1.5 A 1.8 A 2.75 A 3.2 A

SPA2120 0.25 A 2.9 A 3.9 A 5.5 A 6.4 A

SPA2240 0.30 A 5.47 A 7.5 A 10.4 A 12.3 A

Current consumption with 230 AC supply (per channel)

SPA2060 0.07 A 0.32 A 0.42 A 0.53 A 0.67 A

SPA2120 0.12 A 0.65 A 0.89 A 1.15 A 1.4 A

SPA2240 0.28 A 1.25 A 1.65 A 2.20 A 2.85 A

Working Temperature.

0°C ~ 40°C

4.4.1.5 Parallel Output

To combine 60W x 2 Channel to be 120W power, Simply do the following:

1. Turn the input gain to "OFF" position on channel 2, but keep the channel 1 Input gain adjustable.

2. Connect channel 1 output to channel 2 input.

3. Parallel the output of channel 1 and channel 2 (COM to COM, 70.7V line to 70.7V line).

Please refer to the example connection below:



UAP G2 Manual122

© 2019, ATEÏS, member of PAX ProAV Group

4.4.1.6 Maintenance and Troubleshooting

This chapter will help you to diagnose the common problems for troubleshooting and how to solve.   The
maintenance of the device and peripherals are also told here. 

If none of the solution way works, please contact your ATEIS dealer.

Hardware maintenance:

1. Be sure to keep the case clean and away from any heat source. 

2. The operating temperature is 0°C ~ 40°C.

3. Keep it clean, especially air filters and ventilation paths (If the device has a fan).

4. Avoid vibrations and shocks.

4.4.2 BPA

4.4.2.1 Overview

 Thanks to its flexibility, the BPA (Basic Power Amplifier) is designed for perfect integration for any
Public Address application.

The BPA is  a 2U 19" rack-mountable,  2-channel amplifier,  transformer  isolated  for  100  V,  50  V  and  8
Ohm distributed loudspeaker systems. There are three models in the coverage of BPA :

BPA2120 : 2 x 120 W

BPA2240 : 2 x 240 W

BPA2480 : 2 x 480 W

The  BPA  amplifier  has  a  230  V  AC mains  supply  input  and  a  48  V  DC battery  back-up  input  which
allows it to be used in combination with a battery backup system for maximum availability  and reliability
in  an  emergency  evacuation  system.  BPA  amplifiers  have  short-to-ground,  short-circuit  detection  and
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line-impedance surveillance up to 5% deviation using  the  DIVA8  or  IDA8  systems  for  loudspeaker-line
surveillance.  They  support  both  single-spure  and  redundant  loop  cabling  (A/B)  and  have  a  switchover
facility  that  automatically  reroutes  power to a backup amplifier (if present) via  the SONAES charger in
the event of failure. BPA amplifiers have a rear-panel selector switch for amplifier monitoring according to
EN 54-16.

Main Characteristics

2 audio outputs for BPA2120, 2240 and 2480 (100 V / 50 V / 8 Ohm selectable outputs)

Fault reporting outputs

Two audio input gain control

Supervision of amplifiers through DIVA8 or IDA8 systems

Advanced audio processing for each amplifier channel through DIVA8 or IDA8 systems

Amplifier supervision and spare amplifier switching through DIVA8 and IDA8 systems

Loudspeaker line and loudspeaker supervision through DIVA8 and IDA8 systems

4.4.2.2 Front Panel

 

VU Meter:

The VU-meter is  composed  of  three  LEDs  that  represent  three  different  level  thresholds:  -40dB,  -
20dB and 0dB. When the input signal reaches those thresholds, the corresponding LED will blink.

 Temp.:

If the internal temperature of device reaches 95 degrees C,  the TEMP LED will  light  up and the pre-
amp will  stop working until  the temperature falls  down under 95 degrees C.  The pre-amp will  come
back to a working state automatically.  To avoid temperature failure,  please insert  an external fan to
the rack system.

 Overload:

The overload LED will blink as soon as the output  power exceeds the nominal value.  If the Overload
LED is blinking,  check that  the output  load is  well connected and still  in good condition as  well as
checking the level of the input signal.

  Power:
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The Power LED indicates the ON/OFF status.

 Power fault:

This LED indicates the main/backup power supply,  the LED lights  up when one of them is  lost  and
the system will switch to the working one as well.

There  is  a  button  on  the  rear  panel  for  disabling/enabling  this  LED  indicator.  It's  required  to
enable this LED for the PAVA system.

4.4.2.3 Rear Panel

 Fuse Receptacle:

A fuse receptacle is located on the left of the amplifier’s rear panel.

 Power Switch:

The power switch is  a two position switch.  Pushing up the power switch ( I position) will  power  on
the  device,  pushing  it  down  (O  position)  will  off  the  power.  When  the  power  switch  is  on  the  I
position, the front panel power LED will light up.

  En54 -16 LED Switch:

Push on  : Normal type.

Push off  : EN54-16 type.

 Channel 1/2 48VDC battery backup connector:

The BPA amplifier can be operated with battery  backup.  Use the channel 1 and channel 2 "48VDC
Battery  Backup" connector to do so.  This  48VDC power supply  can be  used  when  it's  unavailable
with AC power supply. The Power and DC LED shall light up when in use of Battery Backup.

 Fault LED On/Off:
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Enables/Disables  the  Fault  Power  LED indicator.  In  need  of  turning  off  the  indicator,  use  a  thin
screwdriver to press the retractable button.

 &  Channel 1/2 Outputs:

Each channel outputs  a replica of the corresponding balanced audio input  signal either on the XLR
connector or on the Euro-terminal block.

The following table shall list the pins of XLR connector (Female and Male):

Item Description

Pin1 Chassis ground (cable shield).

Pin2 Positive polarity terminal for balanced audio circuits (aka "hot").

Pin3 Negative polarity terminal for balanced circuits (aka "cold").

 &  Channel 1/2 Inputs:

For each channel,  there is  an XLR balanced input  and a Euro-terminal block  balanced  input.  Each
input  gain  control  can  be  adjusted  to  suit  the  users’  needs.  The  ON/OFF  gain  switch  can
instantaneously bypass the gain controller and set the channel gain amplifier to maximum.

 AC Power Socket:

Main 230V~253V, 50/60Hz AC power input with fuse.  It  accepts  a standard mains  power lead fitted
with an IEC connector.

For 230 V, fuse rating: 

BPA 2120: 5A

BPA 2240: 10A

BPA 2480: 20A

 Channel 1/2 Audio Output:

For each amplifier channel,  there is  a dedicated Audio Output  connector for connection  of  either  8
Ohm speakers,  50V speakers  or 100V speakers.  For the  8  Ohm  connection  and  if  you  are  using
more than 1 speaker, please ensure that speakers are wired in a way that  the total impedance load
is between 8 Ohm and 16 Ohm. The Com point  is  the negative terminal and 8 Ohm, 50V and 100V
are the positive terminals.

 Fault Contact:

The fault contact indicates an amplifier fault by an opening contact.

 Channel 1/2 Inputs GAIN and ON/OFF switch:

The ON/OFF switch is mainly for the parallel output and the knob is for adjusting the amplifier gain.
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4.4.2.4 Characteristics

Case:

Dimension: 

o DPA4125 / DPA4250  = 2RU, 88.5 x 483 x 370 mm

Weight :

o DPA4125 = 14 Kg (31 lb)

o DPA4250 = 18 Kg (40 lb)

Color = RAL7016

Power:

Item Voltage Power Consumption Comment

AC Input 115 or 230V +/- 15%

DPA4125

Standby: 1W

Frequency: 50/60Hz

Idle: 38W

Full Power: 600W

DPA4250

Standby: 1W

Idle: 44W

Full Power: 1169W

DC Output 19~30V - -

(Total Mains-power consumption @ 230 VAC)

(Alarm cycle + 10 V pilot-tone @ 24 VDC)

Audio:

Frequency response = ±3dB@50Hz ~ 20KHz

Distortion at nominal power: <0.1% (@ 1 kHz) @ -10dB of rated output power

Signal/noise ratio: > 90 dB

 Inputs/Outputs:

Power output = 100 V

Main line input = 770 mV

Input impedance = 20k Ohm

Loudspeakers outputs:

DPA4125: (per channel)

o Rated load resistance = 80 ohm (100 V)

o Rated load capacitance = 62,5 nF (100 V)

o Rated output power = 125 W (cont. at 40°C)

o Two channels bridged = 250 W (cont. at 40°C)

DPA4125: (per channel)

o Rated load resistance = 40 ohm (100 V)
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o Rated load capacitance = 120 nF (100 V)

o Rated output power = 250 W (cont. at 40°C)

o Two channels bridged = 500 W (cont. at 40°C)

Frequency response = 40 Hz to 20 kHz(-3 dB)

S/N = >90 dB (no pilot tone)

Crosstalk = <70 dB at nominal load for 1 kHz

Distortion = <0,1% (@ 1 kHz) @ -10dB of rated output power
Current consumption:

Current
Consumption

Current consumption with 48 VDC supply (per channel)

Standby Idle Full Power

DPA4125 0.03 A 1.45 A 22.5 A

DPA4125 0.03 A 1.65 A 43.85 A

**(Total Mains-power consumption @ 230 VAC)

*(Alarm cycle + 10 V pilot-tone @ 24 VDC)

Working Temperature:

Operating temperature: -5 ºC to +55 ºC (+23 ºF to +131 ºF).

Storage temperature: -40 ºC to +70 ºC (-40 ºF to +158 ºF).

Relative humidity: 15% to 90%.

Air pressure: 600 to 1100 h Pa.

4.4.2.5 Parallel Output

In this chapter, we can combine 2 or more channels into one. For example, 120W x 2 Channels to be
one channel with 240W power, see the listed description below:

BPA-2120 (120W x 2 Channel to be 240W power)

BPA-2240 (240W x 2 Channel to be 480W power)

BPA-2480 (480W x 2 Channel to be 960W power)

1. Turn the input gain to "OFF" position on channel 2, but keep the channel 1 Input gain adjustable.

2. Connect channel 1 output to channel 2 input (XLR connector or Euroblock connector)

3. Parallel the output of channel 1 and channel 2 (COM to COM, 100V line to 100V line).

Please refer to the example connection below:

o Via XLR connectors:
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o Via Euroblock connectors:

4.4.2.6 Maintenance and Troubleshooting

This chapter will help you to diagnose the common problems for troubleshooting and how to solve.   The
maintenance of the device and peripherals are also told here. 

If none of the solution way works, please contact your ATEIS dealer.

Hardware maintenance:

1. Be sure to keep the case clean and away from any heat source. 

2. The operating temperature is 0°C ~ 40°C.

3. Keep it clean, especially air filters and ventilation paths (If the device has a fan).

4. Avoid vibrations and shocks.
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4.4.3 DPAfour

4.4.3.1 Overview

The DPAfour is a 2U 19" rack mountable, 4-channel class-D power amplifier, transformer isolated for 100
V, 70 V, 50 V and 4 Ohm distributed loudspeaker systems. There are two models in the DPAfour range:

DPAfour 125 rated at 4 x 125 W

DPAfour 250 rated at 4 x 250 W

Each channel  can  deliver  up  to  125/250W  as  a  separate  channel  or  can  be  bridged  to  deliver  higher
power. The amplifier has a dual-voltage mains supply 115/230V AC (selectable internally) and a 24 VDC
battery  back-up  connection.  In  combination  with  DIVA8G2  and  IDA8  the  DPAfour  amplifiers  have  the
following features:  Loudspeaker line monitoring for Shortcut  /  Open line /  Ground leakage /  Single  spur
A/B  loudspeaker  lines  individually  monitored.  By  adding  a  Sonaes  to  the  system  a  fully  EN54-16
certified Voice Alarm system will be created, with extensive PA capabilities.

Main Characteristics

4 audio outputs (100V / 70V /50 V / 4 Ohm selectable)

Fault reporting outputs

Four audio input gain control

Advanced audio processing for each amplifier channel using DIVA8 or IDA8 systems

Supervision of the amplifiers through DIVA8G2 or IDA8 systems

Back up amplifier switching through DIVA8G2 or IDA8 systems

Loudspeaker line monitoring with DIVA8G2 or IDA8

Output bridging for higher power
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4.4.3.2 Rear Panel

Power Switch:

The power switch is located next to the AC power socket on the rear panel.  When the power switch
is on the “on” position, the front panel power LED will be lit.

AC Power Socket:

Main 115V~230V, 50/60Hz AC power input with fuse.  It  accepts  a standard mains  power lead fitted
with an IEC connector.

Channel 1-4 Audio Output:

For each amplifier channel,  there is  a dedicated Audio Output  connector for connection  of  either  4
Ohm speakers,  50V speakers,  70V speakers  or 100V  speakers.  The  Com  point  is  the   terminal
and 4 Ohm, 50V, 70V and 100V are the + terminals.

Channel 1-4 Inputs GAIN and ON/OFF switch:

For each  channel,  there  is  a  Euro-terminal  block  balanced  input.  Each  input  gain  control  can  be
adjusted to suit  the users’ needs and the ON/OFF switch is  mainly  for the  parallel  output  and  the
knob is for adjusting the amplifier gain.

24VDC battery backup connector:

The DPA  amplifier  can  be  operated  with  battery  backup.  This  24VDC power  supply  can  be  used
when it's unavailable with AC power supply  or as  a secondary  supply  which is  referred to the EN54
type. The Power and DC LED shall light up when in use of Battery Backup.

CAUTION: This connection should be externally  fused with 50AF max.  when directly  connects  to a
battery unit. This is not required when connected to the BECS150 Charger and Supply unit.

Configuration switches:

1  by  setting this  switch to “ON”,  the indicators  on the front  panel will  comply  to the  EN54-16.  In
case of technical maintenance, this switch may be temporarily set to the “OFF” position.

2 - For future use.

3 - For future use.

4 - For future use.

General Fault Output Contact:

The fault contact indicates an amplifier fault by an operating contact. (NC)
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Service Request Output Contact:

The Service Request contact indicates that maintenance is needed.

This is indicated by an operating contact. (NC)

Lamp Test Input Contact:

By shutting down this input contact, all LEDs on the front panel of the amplifier will light up.

Spare Input Contact:

For extra input contact use.

4.4.3.3 Characteristics

Case:

Dimension: 

o DPA4125 / DPA4250  = 2RU, 88.5 x 483 x 370 mm

Weight :

o DPA4125 = 14 Kg (31 lb)

o DPA4250 = 18 Kg (40 lb)

Color = RAL7016

Power:

Item Voltage Power Consumption Comment

AC Input 115 or 230V +/- 15%

DPA4125

Standby: 1W

Frequency: 50/60Hz

Idle: 38W

Full Power: 600W

DPA4250

Standby: 1W

Idle: 44W

Full Power: 1169W

DC Output 19~30V - -

(Total Mains-power consumption @ 230 VAC)

(Alarm cycle + 10 V pilot-tone @ 24 VDC)

Audio:

Frequency response = ±3dB@50Hz ~ 20KHz

Distortion at nominal power: <0.1% (@ 1 kHz) @ -10dB of rated output power

Signal/noise ratio: > 90 dB

 Inputs/Outputs:

Power output = 100 V

Main line input = 770 mV

Input impedance = 20k Ohm
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Loudspeakers outputs:

DPA4125: (per channel)

o Rated load resistance = 80 ohm (100 V)

o Rated load capacitance = 62,5 nF (100 V)

o Rated output power = 125 W (cont. at 40°C)

o Two channels bridged = 250 W (cont. at 40°C)

DPA4125: (per channel)

o Rated load resistance = 40 ohm (100 V)

o Rated load capacitance = 120 nF (100 V)

o Rated output power = 250 W (cont. at 40°C)

o Two channels bridged = 500 W (cont. at 40°C)

Frequency response = 40 Hz to 20 kHz(-3 dB)

S/N = >90 dB (no pilot tone)

Crosstalk = <70 dB at nominal load for 1 kHz

Distortion = <0,1% (@ 1 kHz) @ -10dB of rated output power
Current consumption:

Current
Consumption

Current consumption with 48 VDC supply (per channel)

Standby Idle Full Power

DPA4125 0.03 A 1.45 A 22.5 A

DPA4125 0.03 A 1.65 A 43.85 A

**(Total Mains-power consumption @ 230 VAC)

*(Alarm cycle + 10 V pilot-tone @ 24 VDC)

Working Temperature:

Operating temperature: -5 ºC to +55 ºC (+23 ºF to +131 ºF).

Storage temperature: -40 ºC to +70 ºC (-40 ºF to +158 ºF).

Relative humidity: 15% to 90%.

Air pressure: 600 to 1100 h Pa.

4.4.3.4 Maintenance and Troubleshooting

This chapter will help you to diagnose the common problems for troubleshooting and how to solve.   The
maintenance of the device and peripherals are also told here. 

If none of the solution way works, please contact your ATEIS dealer.

Hardware maintenance:

1. Be sure to keep the case clean and away from any heat source. 
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2. The operating temperature is 0°C ~ 40°C.

3. Keep it clean, especially air filters and ventilation paths (If the device has a fan).

4. Avoid vibrations and shocks.
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5 System configuration

5.1 UAP G2 software

The  UAPG2 software  is  a  powerful,  yet  easy  to  handle  tool  to  assist  you  creating,  controlling  and
monitoring  DSP-Designs  for  UAPG2  systems,  supporting  up  to  12  processors  including  all  the
controlling gear connected to it.

After the determination of which type and how many units  would make up your network,  you  can  start
designing signal paths with all the exiting features the huge component  library  offers  simply  by  drag and
drop and connect different audio component.

This all is  done in a straight  forward and clear manner,  helping you to concentrate on creating state-of-
the-art  electro-acoustic  environments.  After  a  Design  is  successfully  compiled  and  loaded  into  the
machine(s), you have full access to all the parameters in the system.

There  are  a  lot  of  controlling  features  starting  from  simple  TTL  I/O's  over  analogue  voltage  control  to
advanced  data  communication.  You  can  choose  from  a  range  of  controlling  devices  or  remote
microphones suitable to access parameters within the whole networked system.

UAPG2-Design  also  provides  a  multi  level  user  management  administrating  up  to  40  different  sets  of
user privileges. You also can create unique bespoke graphical environments  that  only  consist  of control
elements you want operators to have access to.

Many of the concepts  in this  program are based on modern graphic  design environments,  using similar
tools and techniques to provide the functionality, speed and intuitive feel of contemporary user interfaces.

The UAPG2 Software gives you control over all  the design features  needed to build and control  a  DSP
System  using  UAPG2  Processors  and  all  its  accessories.  Also  it  provides  a  graphical  design
environment to create custom user interfaces.

5.1.1 System requirement

IBM compatible computer with Pentium III MMX CPU, 400 MHz or faster

256 MB RAM
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Hard drive with at least 20 MB of free space

CD-ROM or DVD drive or a connection to the www (for installation only)

VGA display (1024 x 768, 256 color or better recommended)

One free USB-port

Operating system: Windows 2000R Professional (Service Pack 3 or  greater),  Windows  XP  Home  or
Professional (Service Pack 2 or greater), Windows 7.

If you use Windows VISTA, be sure to be in compatibility mode.

5.1.2 Install

Before installing the UAPG2 software, check if your PC meets the system requirements.

Turn  on  your  PC and  allow Windows  to  start  up  Insert  the  supplied  CD-ROM  into  your  drive.  If  the
content of the CD-ROM is not displayed automatically double click  the 'My Computer' icon and navigate
to the 'DVD/CD' drive.

1. Copy the file 'ATEIS UAPG2 v.1.x.x setup' using the copy and paste commands or by  drag and drop
to the 'Desktop'. Wait until the task has finished.

2. Start the program 'ATEIS UAPG2 v.1.x.x setup' by double click  on its  icon and follow the instructions
to install the UAPG2 software onto your hard drive. 
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And Click "Next".

3. Type in user name and your organization name if you want  and click  "Next"  By default  the  program
'UAPG2-PPM v1.x.x.exe' is installed under the path <<C:\Program Files\ATEIS\ATEIS UAPG2>>.
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4. Change installation path (by clicking Change) if required, and click "Next".

5. As usual  with  the  install  shield  wizard  a  window appears  showing  all  information  before  the  actual
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installation.  You can enter corrections at  this  point  by  clicking "Back".  If there is  nothing  to  change
click "Install" to execute the installation.
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6. After all installation tasks have been finished successfully click "Finish" to exit wizard. The installation
program  creates  a  shortcut  to  the  'ATEIS  UAPG2  v.1.x.x  .exe'  named  'UAPG2  v1.x.x'  on  your
'Desktop' with the UAPG2 icon. Double click the icon to start the program.

The newest  version will  be published on the Ateis  website for users  to update.   Before you can
upgrade or reinstall UAPG2 software you have to remove the older version from your applications
folder. 

To do this, follow the instructions below:

Choose: > Start > Program files > ATEIS > UAPG2-G2 > UAPG2-G2 v1.x.x-(yyy)_Uninstall.

Follow the instructions.

You can also Choose: > Start > Settings > Control Panel.

Double click the 'Add or Remove Programs' icon, Locate and choose 'ATEIS UAP-G2 v1.x.x' and
click the 'Remove' button.

Follow the instructions to remove the 'ATEIS UAP-G2 v1.x.x' software from your hard drive.
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5.1.3 Windows layout

 Title Bar:

Displays the path name of the current file.

It displays UNIVERSAL AUDIO PROCESSOR G2- untitled, if you start a new system design,  or the
full path name of the current saved file. 

At the right hand corner you can find the usual Windows minimize button and the close box (in red),
which exit the program.

 Menu Bar:

Holds all the functionalities of the software (windows and tools), arranged by topic.

Tools Bar:

Short access to main functionalities that are hidden into menu bar.

Tab Bar:

Shows  the  window  title  of  all  opened  windows  (design,  components  control  windows)  for  quick
access.

 Design Components Area:

Contains all “virtual devices” you can use to build up and design your system.
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 Working Area:

It is the space where you create your “virtual system” and make your design.

 Properties Control Area:

Access to some information (summaries) and functionalities  regarding all  communications aspects
(RS-232, TTL I/O analogue Input, etc..)

 Status Bar:

Indicates connections status between UAPG2 and PC, and also compilation process.

5.1.4 System/component

1. Dock Panel-Component Template:

A  dock  panel  on  the  left  side  of  UAP  G2  software  which  contains  all  the  devices  and  DSP
components you can use to build up and configure into your system.

5.1.5 File

In this menu, you will find everything related to system/design files as well as printing command.

All the UAPG2 files are saved under the *.UAPG2 extension.
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The File menu contains the following items:

New: Opens a new blank project (new system/design file)

Save: Saves the current file you are currently working with

Save As:  Opens the "Save as…" dialog box  to  save  the  current  working  project  with  a  different
name and/or path

Open: Opens the "Open...” dialog box which allows you to select a path and open a saved file

Open auto saved: Opens the last auto saved file

Recent files: Quick access to the last opened files

Print Header Settings: 

Opens the “Print header settings” window which allows you to set the headers (name, company,
etc.) for the printed design. You have the possibility  to print  your project  either for site technical
documentation  or  for  filing.  You  can  enter  project  name,  date,  and  name  of  the  designer,  a
description for the project,  the reference and the model  of  UAPG2  used.  You  can  choose  the
position of this  header on the paper.  You can also choose Font  size,  type  and  color  and  also
background color of the header.  Finally  you have the choice to display  this  header or not  when
you print your design.



System configuration 143

© 2019, ATEÏS, member of PAX ProAV Group

Print: Open your “Windows print” dialogue box which allows you to print the design file.

Print  Preview: Opens the “Print  preview “dialog box which allows you to see before  printing  what
your print will look like. Here is an example with a factice simple design:

o Top left you can see the header (purple box), defined via the “print header settings” window.

o Opens the "Windows Print" dialog box to print the file
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o Opens the "Windows Print settings" dialog box to set your printer

o Choose which master preset you want to preview

o Choose which Items you want to preview

o Zoom in and zoom out.

o See the complete page

o See only the part of the page where there is the design

o Navigates between all the printable pages

Print Setup:

Opens the “Windows Print settings” dialog box to set your printer. This  dialog box allows you to
select which printers you will use and set your printer by clicking on properties. 

You can also choose the size of paper and if you want  it  normal or landscape.  This  window is
generated by your OS.

Exit: Terminates the current UAPG2 session after asking to save modified files.

5.1.6 Edit

Here you will find all the common basic edition tools of windows based software.

The Edit menu contains the following items:
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Undo: Will undo the last actions

Redo: Will redo the last action or will retrieve the last state in case undoing too far

Cut: Cuts out the active selection and copies it to the operating system’s clipboard

Copy: Copies the active selection to the operating system’s clipboard

Paste: Pastes the content of the operating system’s clipboard

Delete: Deletes (erases) the active selection

Alignment

You can select several elements (by  maintaining left  click  and move the mouse you will  have a
selection square) then you can align all the elements.

Pack

You can select several elements (by  maintaining left  click  and move the mouse you will  have a
selection square) then you can pack the elements.
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Space

You can select several elements (by  maintaining left  click  and move the mouse you will  have a
selection square) then you can define the space between all the elements. It is interesting if you
pack the elements first.

Order

If you have elements which are under other elements, you can define by selecting one element  if
this  will  be to the front  or to the back.  Pay attention sometimes element  can be totally  hidden
with this action. It is useful with background image and buttons for example.

5.1.7 View

In this topic you will find practically every windows of the software. Most part of those windows has short
access from the TOOL BAR. We are going to introduce you every items. 

The View menu contains the following items:
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System

Opens the system window, in the Design Component Area.

You have to explain to the software which Hardware will  be used for you project.  Here you can
find the virtual system machines:

o The processor (UAPG2)

o The paging microphone (PPM)

o The remote controller (URC)
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When you define your system you will  drag and drop those virtual machines in the  WORKING
AREA. For example if you use three linked UAPG2 you will  drag and drop three virtual UAPG2
from  this  window.  Then  if  you  use  PPM  you  will  drag  and  drop  virtual  PPM  and  "virtually
connect"  them in desired inputs  of the virtual UAPG2s (be  sure  to  connect  them  in  the  same
way as the hardware).

Components

Opens the Components window, in the Design Component Area.

Once your (virtual) system has been defined you will  define what  the processor will  do between
Inputs  and  Outputs.  Here  are  all  the  tools  you  can  use  for  signal  processing  and  for  Audio
routing etc. Simply double connect in the UAPG2 (defined in the System window in the Working
Area) and then  drag  and  drop  the  desired  components  and  create  wiring  between  inputs  and
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outputs.

All those components are going to be explained in the Component chapter.

System status

The first  TAB contains  the "Log file"  and the second TAB shows the  compilation  results  (error
and warnings).

You can save log file by  clicking "Save" or you can see the different  recorded events  selecting
the number and by clicking "Get" or you can clean the Log file (click"Clear").

Third Party Control

Opens the Third Party Control window in the Properties Control Area.

This  section shows you all  the detail  of all  the elements  or events  which are  designated  to  be
controlled via third party device (Crestron, AMX, VITY, …)

Two  different  TABS,  One's  showing  the  Elements  controlled  via  third  party  protocol  and  the
second 's showing the Events controlled via third party protocol

For more information, see the Third Party Control chapter.

Logic in

Opens the Logic IN Control window in the Properties Control Area.

You have a lot  of possibilities  to use the 16 controlled inputs  (either  analogue  or  Logic)  If  you
need to  use  Logic  inputs  you  can  control  and  do  a  lot  of  different  things.  Following  windows
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shows you the details of what is controlled and what you are doing with Logic input:

1. The contact input must be assigned to a group to be available. You can also use Logic  inputs
as "bit" for different choice (not available at the moment).

2. You can use Logic input in order to change preset:

3. You can use logic in to pilot every logic adjustments in every  UAPG2 of the system (bypass,
mute, routing, solo,…)

4. Finally you can choose to start events with logic input

For more information, see the Logic Input chapter.

Logic out

Opens the Logic Out Control window in the Properties Control Area.

You have two possibilities to control the 8 logic  outputs  of one UAPG2. The window shows you
which output is controlled by what.

1. Elements can control a logic output (mute, bypass, signal, routing,…)
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2. Logic inputs of a UAPG2 can control a Logic  output  of a remote UAPG2 (in order to give
some logic signal to a remote device for example):

For more information, see the “HOW TO: use Logic Output” chapter of this manual.

Analogue in

Opens the Analogue in window in the Properties Control Area.

You can control some analogical elements  with remote 10kOhm potentiometer (volume, attack
time or threshold of a compressor, gate,…). This window shows every  analogue adjustment  you
have defined:

For more information, see the "Analogue Input" chapter.

Sub-preset List

Opens the Subpreset elements window in the Properties Control Area.
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Show all the elements controlled ("virtually photographed") for each subpreset.  This  window is  a
kind of reminder.

Remote List

Opens the Remote List window in the Properties Control Area.

When you want to use Ateis remote device (PPM or URC, through RS485 network),  you have to
follows few steps (see Remote chapter), one of those step is the searching process:The UAPG2
scans the system and attributes  a specific  IP address for each remote device (PPM and URC)
automatically.

From those windows you will  have a summary of each PPM and URC with their serial  number
and where they are connected. You can also start the search process by clicking .
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PPM Manager

Opens the PPM Manager window in the Properties Control Area.

This window gives all the details of each PPM you are using in the system.

Chime Data Store

Opens the Chime Data Store window (floating window)

With this window you can load chime (format: 16k, 16bit WAV, storage: 128kbits) in PPM. First
you will have to define the wave file by using the wave file manager.

Wave File Manager

Opens the Wave Files List window (floating window)

With this window you select which wave file will be used with your project.
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PPM vs Wave Table

Opens the PPM vs Wave Table window (floating window) 

Gives  details  about  which  wave  file  is  loaded  in  which  PPM  (wave  file  associated  to  which
UAPG2 and input's number)

Logo Manager

You can post two different logos on the URC’s display.

This window shows you which logo is in your project and you will  define which logo you will  use
with the URC.
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Logo Library 

Opens the Logo Library window (floating window)

With this window, you choose which logo you will use in your project.

Event Management
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Opens the Event Management window (floating window)

Here you can add,  define,  select  or clear some events.  You cans choose between five different
kinds of events:

Change master preset

Change subpreset

Adjust element (volume change, mute…)

Pilot TTL Output (Logic output)

Stop event

You can also choose to command events via third party protocol.

Schedule Management

Opens the Schedule Management window (floating window)
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Here you can  define  to  start  events  automatically  (you  define  when  you  want  and  how many
times you want  to  start  events  or  an  event  sequence  (addition,  sequence,  of  several  different
events).

The arrow is here the event list can be opened or closed, see how to use Scheduler to trigger.

Virtual Control

Opens the Virtual Control window (floating window) and Virtual tools  in the Design Components
Area

The “virtual Control” allow you to define group of buttons, LEDs,  or faders.  You can import  these
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groups in the Monitor Window.

You  can  add  as  many  “virtual  logical  in”,  “virtual  logical  out”  and  “virtual  analogical  in”  as
required.  Simply  drag  and  drop  object  from  the  virtual  tools  menu  in  the  PROPERTIES
CONTROL AREA

 

Monitor

Open  the  Monitor  window  (floating  window)  and  the  Monitor  tools  window  in  the  Design
Components Area.
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The Monitor window is  a window in which you can bring all  the adjustments  and indicators  you
need for your project.  This  is  helpful if you want  to have a graphical control  interface.  You  can
define users whom have restricted access to the software;  they will  have access to this  window
(monitor) only. So you can put in this window all the adjustments  the users  will  need in order to
prevent improper use of the program.

You can add as  many "monitor logical in",  "monitor logical out"  and "monitor analogical in"  as
required.  Simply  drag and drop object  from  the  Monitor  tools  menu  in  the   Properties  Control
Area.

When a specific  restricted access user will  start  the software he will  see  the  monitor  window.
So it is why there are a lot of small sized tools (the same as in the Tool Bar). 

Here is a picture of the virtual soft keyboard:

For more information, please see the Monitor chapter.

Monitor Settings

Opens the Monitor settings window (floating window)
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When you use monitor window you can choose to hide some tools  (of the monitor window tools
bar)

Change Master\Sub Preset: Disable the possibility to change Master or Sub presets  from
the monitor window.

Save\Load File: The master-Preset menu on the monitor window is greyed out. 

Exit  Software:  Disable  the  possibility  to  save  or  load  UAPG2  design  file  The  software
connects  (live)  automatically  to  the  UAPG2  master-preset  by  using  the  default  IDM
(ADMIN) which has an access to all master-presets.

Auto Connect: Disable the possibility to close the software from the monitor window

For more information, please see the Monitoring Settings chapter.

Toolbars

Choose which kind of tools will be "shortcuted" in the Tool Bar.

5.1.8 User

In this  topic  you will  find windows related to system communication (Ethernet:  ID and UAPG2 system:
User).  Most  part  of those  windows  has  short  access  in  the  Tool  Bar.  We  are  going  to  introduce  you
every items in User Management chapter.

The User menu contains the following items:

User Management (user right)

ID Management (Master-preset access)

Logout User
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Logout ID

5.1.9 Compile

Start the compile process.

The software verifies that no major errors remain before uploading the design into UAPG2 system.

5.1.10 Operation

In this  topic  you will  find windows related to system connection.  Most  part  of those windows has short
access in the TOOL BAR. We are going to introduce you every items.

The Operation menu contains the following items:

Store: Starts the Store process which upload your design into the UAPG2 system.

Reverse:  Starts  the reverse  process  which  download  the  design  from  the  UAPG2 system  into  your
computer.

Connect: Connects your computer to the UAPG2 system.

You have to have opened the good corresponding design file to connect to UAPG2 system.

Disconnect: Disconnects  your computer from the UAPG2 system, Allow you to change settings and
re-upload them into UAPG2 system.
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Audio Enable: Activates the Audio (Outputs) of the UAPG2 g2 system.

Audio Disable: Stops every audio signals going out of the UAPG2 system.

5.1.11 Tools

In this topic you will find windows related to system configuration and software settings. We are going to
introduce you every  items.  To learn how to use those  items  please  refer  to  the  “create  a  project”  and
“how to” sections.

The Tools menu contains the following items:

Update: 

Opens the Firmware update window (floating window)

The software contains  every  updated firmware.  If you have to update  UAPG2 or  PPM  or  URC,



System configuration 163

© 2019, ATEÏS, member of PAX ProAV Group

just click on [update] button.

Always update DSP before MCU and never reset between the two update processes.

Machine Configuration:

Opens the Machine Configuration window (floating window)

When you are connected to the UAPG2 system. This  window allows you to read and set  some
internal UAPG2 information.

o Date/time: set the internal date and time of the UAPG2g.

Read: To see which settings are into each UAPG2 of the system

Set: To load some settings changes

Get Current Time: To get computer date and time directly.

Time adjustment:

If you use the UAPg2 connected to internet,  our advice is  to synchronize the time
with NTP protocol.

If you use the UAPg2 in stand alone, then the only way to adjust  the time if needed
is to use the parameter "Time error (Sec)".

1. At first, set the time (from the PC or with NTP), and remember this time.

2. Leave the machine working in stand-along during one month.

3. After one month, record the current time and see the formula.

4. Time Error(sec)=(current time -previous time)/30.

5. Set time error sec in machine configuration.

6. Every  day  at  00:00,  the  machine  will  automatically  increase/decrease  the
time(calibration time).

o RS-232 SET: Set  the RS232 communication,  Baud rate,  parity,  Stop  bit  and  connected

target.
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 Read: To see which settings are into each UAPG2 of the system.

Set: To load some settings changes.

o NTP: Set the UAPg2 to have the date/time updated in real-time by the NTP servers.  NTP

means Network Time Protocol.

Read: To see which settings are into each UAPG2 of the system.

Set: To load some settings changes.

Parameter Setting:

Opens the Parameter setting window (floating window)

This  window is  applied to setting the parameter of dsp elements  with  maximum  and  minimum
value.

There are two tab sheets:

o Global: 
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Here you can define a range or specifics values and give a name to this  specific  range then
in the Private tab you can assign this specific range to specific component.

o Private: 

Here you can assign specific range (define in global) to a component in the design.
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 For example if there is a element ranged from 20 to -90,  if we add a row on the Global tab
and set  maximum  as  50  and  minimum  as  0  then  give  it  a  name  “mm”.  Next,  change  to
private tab and select  the "mm" item in Change to follow global and click  ok.  The  element
will have a new maximum 50 and minimum 0 now.

Clear Remote IP:

Opens the Parameter setting window (floating window)
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Clear the IP addresses of the remote devices (PPM, URC) connected  to  the  selected  UAPG2
(s). If you add new remote device or change something in the system you may have to clean all
IP addresses and re-give addresses (Search process in the remote list  window: sheet  41).  Click
on Delete several time.

Delete Current Operation Preset

Opens the Delete Current Operation Preset window (floating window)

Clean the memory (design) of the connected UAPG2. This  feature  is  useful  when  the  UAPG2
have strange behaviours due to a error during data transfers or an old improper design.

VR Calibration:

Opens the VR Calibration window (floating window)



UAP G2 Manual168

© 2019, ATEÏS, member of PAX ProAV Group

Here you  calibrate  all  the  remote  potentiometer  (Variable  Resistors)  connected  in  the  control
inputs (defined as analogue inputs) and the 8 front knobs of the UAPG2.

Simply choose the UAPG2 of the system and the control input  (or the front  knob) then put  it  at
the minimum and click  on [Minimum]’s  button then put  the potentiometer (or the front  knob) to
the maximum and press the [Maximum]’s  button.  After that  switch  off/on  the  UAPG2 and  the
potentiometers are calibrated.

Options:

Opens the options window (floating window)
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This option window contains 6 different tabs. Here are the details of each tab:

o DSP design(see the picture above):

Active some option regarding design (working area):

1. Show animation, the Icons are animated.

2. Show print boundaries, you will  see on the working area the limits  of each page.  So
you can be sure that your design is not between two pages if you want to print it.

3. Component  first  seat,  when you drag and drop  the  component  from  the  component
system  windows  (design  component  area)  you  can  choose  either  that  every
components are put on top left or are put where your mouse is  when you release the
right button after drag and dropping.

o File:
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1. Autosave  your  design,  notch  it  if  you  want  that  UAPG2  software  auto  save  your
current project

2. Autosave every XX minutes, choose the time between two project saves

3. YY recent files, Choose the number of files which will  be accessible from the "recent
files" option in the file menu.

o Color Scheme:



System configuration 171

© 2019, ATEÏS, member of PAX ProAV Group

Change the color of the audio component windows.

o Store:
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1. Auto Connect to system, notch it if you want that UAPG2 software auto connect after
uploading  a  design  file  into  UAPG2  system.  If  you  do  not  active  this  option  a
message box will appears asking you if you want to connect or not.

2. Auto  enable  Audio  after  connecting,  notch  if  you  want  that  audio  can  go  out  from
UAPG2  after  uploading  a  design.  If  you  do  not  active  this,  a  message  box  will
appears asking you if you want to order audio enable.

3. Auto configure remote, If you have remote devices (PPM, URC) the software will  ask
you  if  you  want  to  configure  them  each  time  you  upload  (store)  a  design  file.  By
activating this option the configuration will be automatic.

o Network:
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1. NIC, Define which net-card of your computer is used by the UAPG2. Be sure the right
card is used.If you are connected directly be sure that is not the WIFI card which are
define here.

2. IP Address gives you the IP address used by your Net-card. By default UAPG2 is set
on address: 192.168.100.XY, be sure your computer is  also set  on this  network  and
be  sure  the  computer  is  not  using  the  same  as  a  UAPG2.  To  be  sure  use
192.168.100.1 for your computer.

3. UDP Broadcasting Port, be sure to use same UDP port  between your computer and
UAPG2… (Try as possible to keep the 19760)

o Internet Protocol (TCP/IP):
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Here are options to change default  TCP/IP  parameters.  Be  sure  you  know TCP/IP  basics
and use to change settings. You can change IP parameters of UAPG2 here.

Here for example the address of the UAPG2 is: 192.168.100.6

Establish Ethernet Link:

Opens the IP Setting window (floating window)

When you want  to  use  UAPG2 system  you  have  first  to  open  communication  (Ethernet  link)
between your computer and the UAPG2 system.

1. If you do not know the UAPG2 IP address click  on [search].  Be sure to be on right  network:
192.168.100.XY (factory settings) 
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2. If you know the IP address enter it and click [connect]

Reset:

Opens the Machine List windows (floating window)

You can select a UAPG2 of your system and reset  all  the parameters.  Use it  if you have some
trouble with your system and you do not know why.

Configure machine IP:

Opens the UAPG2 Machine Configuration windows (floating window)
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This options is used when you use linked UAPG2 (A system of UAPG2) in order to get  and set
the  order  of  the  several  devices  on  the  network  (give  a  unique  number  to  each  UAPG2,
identification number)

Write the numbers of UAPg2 under "Machines Count",  and then click  on [Configure].  Wait  until
you see a proper Net status.

5.1.12 Lock

In  this  topic  you  will  find  windows  related  to  secure  the  software  when  you  leave  it.  You  have  the
possibility to lock the software in order to prevent unwanted use when you are away from it.

The Lock menu contains the following items:

Lock

Block the computer. First define a password by clicking “Password Setup” Then click “Lock”.

To  unlock  software,  click  [Unlock]  button.  And  enter  the  password  defined  in  the  password
setup window.
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You have to re-define a password each time you lock the software.

Password Setup

Choose a password to lock Software.

You will have to enter a password each time you want to lock software.

5.1.13 Window

In this topic you will find tools to re-arrange windows or find hidden opened windows.

The Window menu contains the following items:

Cascade

Arrange every opened window in cascade mode.

Tile

Arrange every opened window in tile mode.

Arrange Icons

If  you  have  a  lot  minimized  windows  everywhere  on  the  working  area,  this  Items  will  arrange
them.

5.1.14 Help

In this topic you will find some features.

The Tools menu contains the following items:
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Version

Opens the Version window (floating window)

This window allows you to know which versions are installed into UAPG2, PPM, URC and which
version has to be used with the current software.

If the version is displayed in red it means the version is mismatching and you will have to update the UAPG2 or the remote devices. 

Activate

This feature is not used in Europe. You do not have to activate your product when you receive it.

About

Some information about the software.

Soft-Keyboard

Opens a Soft-Keyboard in order to use UAPG2 software with touch screen computer or with computer without keyboard. This Soft-Keyboard has a fixed size optimized for screen resolution of 1280x800 pixels.

5.1.15 System status

This function allows users to read the log of the UAP G2 Audio Processor.

 Log 

Display the system log data in the below table.

Build

Display data whether there's any fault on [Compile] procedure.
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Save 

 In case of sending the log data to your technician, click the [Save] button to generate a .txt  file.
 

Get 

Click to show the system log data. 

Clear Log

Click to clear the system log data.

5.1.16 3rd party control

Use Third party Control

Select the adjustments you want to pilot with third party control: 

1. Double click on the component's  icon then right  click  on the adjustment  you want  to control and
select > Third party control.

2. Repeat this step for each adjustment you want to control.

3. Then open the third party control window: > View > 3rd party control.

You  can  change  the  command  ID  in  the  Command_id  field,  in  order  to  make  the  names  of
parameters more explicit. (for example C001 --> INP1) Command_id must be 4 characters long.



UAP G2 Manual180

© 2019, ATEÏS, member of PAX ProAV Group

To see which frame you have to send from the third party controller to pilot  the UAPG2, simply  click

on the three dots (  ) in the Command field.

Move the cursor on the left to see how to change value. For example: if you want  to increase volume
of the parameter C001 by step of 2 dB the “command” frame is IC0012.

For all the received command, the UAP acknowledge with ACK (0x06) or DLE (0x10 ).

 Each preset has its own third party  command.  For example,  the packet  for increasing the level
of input A1 in the preset 1 is different with the packet for input A1 in preset 2.

Read a Parameter Value

In this example,  the third party  window of command C001 displays  the packet  which must  be sent
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to read the level value.

STX=0x02, ETX=0x03, CR=0x0D

In HEX format: [TX] - 02 52 43 30 30 31 03 26 0D

In DECIMAL format: [TX] - <STX> RC001 <ETX> & <CR>

Here you can see the response of the UAP (in this example the result is +09,9 dB).

In HEX format: [RX] - 02 52 43 30 30 31 2B 30 39 2E 39 03 0D

In DECIMAL format: [RX] - <STX> RC001+09.9 <ETX> <CR>

Checksum calculation

The checksum is  the  sum  of  all  data  between  STX and  ETX.  And  keep  only  the  least  significant
byte.

In the following example:

Data = WC0010 = 57 43 30 30 31 30 (in hexa)

Sum of Data (in hexa) = 57+43+30+30+31+30 = 15B

Checksum = the least significant byte of 15B = 5B

Set RS232 Third party control parameters

Select Tools > Machine configuration

Click [Read] to load the UAP G2 values,  if you want  to change values and load it  into the UAP G2
click [SET]
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To set RS232 click on each serial parameters  field "Baud rate",  "Parity",  "Stop bit"  and choose the
setting in accordance with your third party device.

You can use the RS232 connection for two tasks:

1. To control UAP G2 with a third party controller (Vity, Crestron, AMX, etc.).

2. To select the type of task, select in the "Connect target" field between IDA4 and 3rd party 

These settings are also applied on the Ethernet 3rd party.

Use third party over IP

Since  UAP  G2  software  version  1.0.4.65,  the  UAP  G2  can  be  control  by  third  party  equipment,
through the IP network.

Both third party over RS232 and UDP/IP work together.

The way to define the third party control is the same as with RS232.  Please read "Define third Party
control" chapter on page 108.

On UAP side:

There is no parameter to set  on the UAPg2.  You just  need to know the IP address of the UAP
G2.

The UDP port used is always 19761.

On the third party device:

The IP address of the third party  device must  be on the same network  than  the  UAP  G2  (  by
default 192.168.100.x). If not, the IP routers must be set  to establish links  between the different
networks.

The UDP port used is always 19761.

Example:

As example,  I use UDP Test  Tool software which is  free on internet.  In the third party  window,
copy the string of the command.

In the third party device, set its IP address to be on the same network  then the UAP. Write the
UAP IP address as remote IP, with UDP port 19761. The local UDP port is the same, 19761.
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Now you can past or write the command string in the Data area.

Then click  on "Send" to send the string to the UAP.  You  can  see  the  answer  in  the  received
data area.

The UAP answer "06 0D" as acknowledge, otherwise it answer "10D" or nothing.

You can also use the test  command “02 54 03 54  0D".  The  UAP  will  just  acknowledge  if  the
connection is working.

 This test software is limited for Checksum max. up to 7D, If it's  bigger than 7D, it  will  result
error.

So if you want test some function with checksum bigger than 7D, Set  UAP command only  with
"NOT Checksum".
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5.1.17 Logic inputs

The analogue/logic input must be set as TTL IN in the external settings.

Each used TTL IN must be assigned to a group to be available (Logic IN floating window).

Second step right click on the software adjustments you want  to pilot  with the control input  and choose
control option:

1. Type of control you can assign to this software control (adjustments).

2.  Name of the UAPG2 in the system.

3. Connector channel number (FP = front panel knob).

When you open the hardware contact this will active the selected software button.

If  you  want  to  active  a  parameter  when  the  contact  closes,  then  you  have  to  use  the  event
Management  (in  menu  View),  to  create  "Element  control"  event.  Then  you  can  assign  this  event
either to an opened or closed contact.

Logic inputs in binary mode (group, only for selector component or presets selection)

The binary mode means use Logic inputs as “bit” for different  choice.  The analogue/logic  input  must
be set as TTL IN in the external settings.

To use the TTL IN in binary  mode,  several TTL IN must  be assigned to a group.  Open the Logic  IN
floating window:



System configuration 185

© 2019, ATEÏS, member of PAX ProAV Group

Assign several TTL IN to a group. In this example the TTL IN 2,3, and 4 have been unassigned to the
group 2,3 and 4 (to make them free). Then all of them have been assigned to the group 1.

The TTL IN number in black means "TTL IN selected for the group".

Second step right  click  on the selector you want  to pilot  with the control input  and  choose  control
option:

1. Select Logic IN.

2. Select the name of the UAPG2.

3. Select the "multi-logic" group .

The value of the controlled parameters will depend of the binary value of the group.
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Now if you open the Machine tab of the Logic In floating window you can see the multi-logic selector

5.1.18 Logic outputs

Right  click  on  the  software  adjustments  you  want  to  pilot  with  the  control  input  and  choose  control
option:

1. Type of control you can assign to this software LED.

2. Name of the UAPG2 in the system.

3. Connector channel number (here  we  have  define  control  9  to  16  as  analogue  input)  FP  =  front
panel knob.

These  logic  output  are  simple  dry  contact,  there  is  no  voltage  on  the  output.  The  output  contact  is
closed when the logical value is "1". It is open when logical value is "0".

For example,  if the logical output  is  assigned to a "signal led",  which lit  when an audio signal is  above
the threshold (logical value = 1),  so the output  contact  will  be closed.  And it  will  be open when there is
no audio signal.

The "Machine" tab of the logic out floating window able to check the logical outputs.
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5.1.19 Analog in (control input)

First you have to define if rear control input is logic or analogue input.

 Make sure the system is fully connected to. 

Right  click  on  the  desired  UAPG2  (if  you  have  several  UAPG2  units  in  a  system)  and  choose
"ExternalSelect" option in the working area of the system window.

Then in the "External channel type settings: #name of the UAPG2#",  select  for each connector if it  is  a
TTL IN (logic) or an Analogical IN.
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If you set the others channel ( 9 to 16 ) in TTL IN mode, than you have to configure the groups 9 to 16 in
the Logic IN window (that means assign TTLin 9 to group 9, and TTLin 10 to group 10, etc).

 You cannot switch the TTL and Analogue freely. The TTL IN must go before all the analog IN.

Analogue Inputs

Second step  right  click  on  the  software  adjustments  you  want  to  pilot  with  the  control  input  and
choose control option:
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Type of control you can assign to this software control (adjustments).

Name of the UAPG2 in the system.

Connector channel number (FP = front panel knob).

An analogue input  can control a component's  parameter only  if  his  corresponding  component's
input or output are linked to something in the design. 

Don't forget to calibrate your external "variator resistance": Tools/VR calibration.

The "Machine" tab of the Analogue IN floating window able to check the analogue input.

5.1.20 Sub-preset elements

The  Sub-Preset  function  allows  the  storing  of  values  of  different  component  elements  (volume  gain,
frequency,  mute,  etc.) in one Sub-Preset.  By loading a Sub-Preset,  all  of the elements  associated  will
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take the predefined values.  The Sub-Presets  are  different  in  each  Master  Preset  and  in  each  System
(Device).

The idea is  to create a Sub-Preset,  define  which  element  of  which  component  you  want  to  associate
with the Sub-Preset, then to the elements  to their target  values,  and then to memorize that  in the Sub-
Preset.

Sub-preset  Combo Box

Select and switch to the desired sub-preset.

Sub-Preset:

List all the sub-preset.

Add / Delete:

Add a sub-preset.

Save:

Save a value of linked elements  to the sub-preset.  Those values are kept  in the memory in the
sub-preset.

Load:

Load values from the storage of the sub-preset and set to linked elements.

Click on the [Add] button to create a new sub-preset setting, see the picture below, 

Assign an element to be controlled by sub-presets

Right click on the element of the component you want to control, and select your sub-preset.

Table of linked elements
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This table lists all elements controlled by the sub-preset. Each field is described in sections below.

Device

Indicates the device containing the linked element.

Component

Indicates the component containing the linked element.

ID

Display the ID for component. 

Element

The element could be controlled by the sub-preset.

Input / Output / Band

Three kinds of type to control the component. 

5.1.21 Wave file manager

This  function allows you to manage the Wave files  stored in your  device.  By  clicking  menu  [View >
Wave File Manager] to open the control window.
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 The menu of Wave File Manager contains in the following items:

Select 



System configuration 193

© 2019, ATEÏS, member of PAX ProAV Group

All / Reset: Select / Cancel all the selected file.  

Add from

File / Library: Click to add a new file from the PC or from Wave Library.

Delete

Ind. / All: Delete the selected individual files or all the files.   

Save to Library:

Save the selected files to Wave Library. 

The menu of Wave Library contains in the following items:

Add / Delete: 

Add or delete the Wave file into the Wave Library.

Import / Export:

Import or export the Wave file into the Wave Library or from your PC or laptop.

Transfer:

Upload the selected Wave file to the [Wave File List].  

Play / Pause / Stop / Record: 

o Play / Pause / Stop the selected Wave file. 

o Record the the selected Wave file into your PC or laptop. 
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Options: 

Click to auto save the files to [Wave File List]. 

Record Type: 

Select the types of recording file.  

Volume:

Adjust the volume on selected Wave file.

Close:

Close the Wave Library window. 

5.2 Connection

5.2.1 UAP G2 to PC

Once you connect your PC to the UAPG2 through Ethernet  port.  There are one type of connection with
UAPG2 software:

Ethernet connection

This  connection allows PC to discuss with UAPG2 (one or several UAPG2 in a network) once this
connection established you can:

Check version of UAPG2 system or remote device (PPM, URC)

Update UAPG2 system or remote device (PPM, URC)

Upload design file in UAPG2 system

Connect PC to UAPG2 to adjust parameters in live

Connect the device

Connect your computer to the Ethernet connector of the UAPG2 using a straight Cat5cable.

You  can  also  using  an  Ethernet  HUB  (router)  to  connect  your  computer  to  several  UAPG2.  And
switch on the UAPG2.

1. Define IP address

By default (factory settings) the address of the UAPG2 is 192.168.100.6. First  of all  you have to
be sure that  your computer net  card is  set  on this  network.  Please refer  to  your  network  card
user  manual  to  set  it.  You  can  safely  choose  192.168.100.50  as  network  address  for  your
computer.

With Windows XP you can proceed as follow to change your network  address  (With  Windows
VISTA you should do similar steps).

Click [Start] button choose "parameters" > "network connection"

Right  click  on  the  icon  of  your  connection  (normally  it  is  your  local  network)  and  choose
“PROPERTIES” 
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Use the following IP address And enter the desired IP address for your computer.
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2. Set Ethernet connection

Now the computer is set for the right  network  let's  see how to choose which computer net  card
will be used by the UAPG2 software.

Open the option window (menu tools) and choose the Network Tab

Here you can  see  which  net  card  is  used  by  UAPG2 software.  And  also  which  address  and
UDP Port are used by computer.

Be sure to choose the right  net  card (NIC) (for example here we  have  the  choice  between  the
VirtualBox Host and Local network)
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3. Search every UAPG2 in the network

Open the Establish Ethernet Link window (menu Tools, or Shift+F9) 

If you know the IP address of the UAPG2 you can enter it in the IP address field.

If you don't  know the address or you have several UAPG2 connected in the network,  leave  the
field blank.

Be sure the port  field is  the same as the one define in the (option window > network  tab).  And
click search to find your UAP G2, see the following pictures.

If you have this  message box "No Devices Found".  Verify  the step 1 and 2,  close  UAPG2
software and re-open it. 
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5.2.2 UAP G2 system

Open Ethernet connection

Select  the UAPG2 you  want  to  connect  to  (it  makes  sense  when  you  have  several  UAPG2)  and
click [connect] button.

Make sure that each UAPg2 has unique IP addresses in the list.  If not,  disconnect  one UAPG2 and
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change the IP address of the other before connecting both again.

Once the connection process complete (successful) the computer is ready to communicate with the
UAPG2. 

To  know if  the  Ethernet  link  is  activated  a  green  Ethernet  led  appears  in  the  bottom  left  of  the
UAPG2 software.

UAPG2 system connection

This connection allows you to pilot  audio settings of UAPG2 system, change sub preset  or master
preset, use monitor window.

To connect to the UAPG2 you have to be sure that  the configuration file in the UAPG2 is  the same

as the file opened with the software.  Then simply  click  on connect  icon  (or operation connect).
This will start the connection process.
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Change IP address of UAPG2

To change the IP address of an UAPG2

1. Connect to the UAPG2 locally (UAPG2 have to be alone)

2. Open the "option" window (menu tools)

3. Choose the Internet Protocol (TCP/IP) Tab.

4. Enter the information you need and press save. If you need click  on [Read]  to know what  the
address of the connected UAPG2 is. 

Make sure that the Ethernet indication is on.

5. RESTART the UAPG2 to make  changes  effective.  If  you  start  the  search  process  the  new
address will appear.

Set Up several UAPG2 Linked together

You can link up to 12 UAPg2 together, see the picture below:
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Please be aware that it is not a redundant network, if one link fails, the system fails.

Link all the UAP together :

Connect each Digilink output to the Digilink input of the next UAP, with RJ45 shielded CAT5
STP cable.

Close the loop by connecting the last UAP to the first (called master).

with the master UAP : Tools/Establish Ethernet link

If the UAP already has a configuration inside : Tools/clear the MCU data

All the UAP must  be in the same version (MCU and DSP).  Check all  your  UAP's  version,  if
necessary you may have to connect with each one UAP, establish Ethernet link and update.

The master must know the physical configuration : open Tools / Configure machine IP.
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You  can  plug  and  unplug  the  link  and  see  instantly  in  this  window  how  many  machines  are
detected.  Check your cable until  the detected machine count  becomes  match  with  the  number  of
UAP. If one of the links  is  broken or absent,  the detected machine will  be 1.  As soon you see the
right  machine count,  write the number of UAP in the Machine Count  box,  and click  on  "Configure"
button. If you cannot get the "Normal status", the problem can come from the UAPg2 version. In that
case  establish  the  connection  with  each  UAPg2  individually,  and  then  update  them  to  the  latest
version. (see Read version)

Also  a  possibility  is  to  power  down  the  complete  system  and  power  up.  Give  in  the  number  of
UAPG2s again. The system is configured properly, "when Net Status: Normal" is displayed.

Then draw your design by drag and drop the UAP icon to the design area.  For each UAP the
"Configure Modules" window ask you about the Audio modules.  As the system is  configured,
the Inputs/Outputs choice appears already correctly. (Check it).

To  send  audio  between  the  UAP,  you  have  to  use  the  Digilinks  components.  You  can  send  16
channels at 48kHz (5 at 96kHz) from each UAP to the next UAP. Now your system is ready.

The Ethernet led lit on the master.

All the link led lit.

Make a link  between two UAPG2’s  is  broken this  can also be seen on the  front  of  the  UAPs.
The UAP with a blinking red/green power led has the broken link on the input.
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Machine Configuration Error

If a Digilink is absent or broken, this error message appears:

Check your RJ45 wiring.

Look on the front LED:

o If a link led is off (the others  led should blink),  it  means there is  a problem with the input

Digilink.
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o If the power led blink  in red and green,  that  means the configuration of this  UAP doesn't

match its the physical connection.

When you do something to resolve the problem (like exchange a cable), the UAPs need some times
to get the system in a normal state. You have to wait  several seconds.  I can also try  to store again
the configuration to wake up the system.

5.3 Event management

Event Triggering

There are several ways to trig (start) the events as "message play event" or "Stop Event":

With Contact input > see Use Control Inputs to trigger Events (as messages)

Scheduler > see Use scheduler to trigger Events (as messages)

With Third Party > see Use third party to trigger Events (as messages)

With PPM-KP keypad > see Use PPM-KP keypad to trigger Events (as messages)

At the moment, there is no way to use the virtual button to trig events.

Events types

If you have several master preset you will have to re-do the operation for each master preset.

Click menu view > Event management

Columns:

o NO.: Number of the event

o Name: Name of the event (click on this filed to change name, click enter to finish)

o Control 
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Type: Here you can define all events you need we have 5 different type of event.

1. Change master preset: This event will load the selected master preset

2. Change Sub preset: This event will load the selected Sub preset

3. Element  adjustment:  This  event  will  adjust  one  or  several  adjustments  (elements)  to  a
designed state.

4. Set TTL-Out: This Event will pilot one TTL output during a designed time period.

5. Stop event: This event will stop another event.

o Third party Cont.: Select here if you want to start event also with Third party control.

o Login IN (H): define here if a TTL input will start the event, when TTL is High.

o Login IN (L): define here if a TTL input will start the event, when TTL is Low.

o Mount:  Number  of  parameters  assigned  to  this  event  (clique  on  this  field  to  assign  or  set

some parameters or adjustments).

o Select: Select event for further operations.

5.3.1 Control type

Control Type:

Change master preset:  Once  you  have  define  several  master  preset  and  define  an  event  which
control master preset (Control Type) click on "Mount field":

And select which master preset will be called by this event (notch select box and click OK)

Change master preset:

Once you have define several  master  preset  and  define  an  event  which  control  master  preset
(Control Type) click on Mount field:

And select which master preset will be called by this event (notch select box and click OK)
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Element adjustment:

Choose which adjustments (elements of a component) will be adjusted by  the event.  Right  click
on the adjustments and choose event > name of the event.

You can assign more than on adjustments to an event (several events of several components)

A yellow dot appears next an assigned adjustment.

Once  all  the  adjustment  s  are  assigned  to  desired  events  go  on  the  Event  manager  window
(menu view) and click on the Mount field of the event

You will see the number of adjustments assigned to the event in this  mount  field And adjust  the
value of each element (click on the virtual button or knob to fix the value).
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Set TTL-Out:

This event pilot a Logic output of any UAPG2 of the system.

Create an event which control TTL out (control type) then click in the Mount field of this event.

Select which output of which UAPG2 (if several UAPG2 in a system) will  be open (and also the
kind of pulse capability)

o Enable: Notch it to active the Logic output channel.

o Process Time Enabled:  If not  notched,  the  process  time  will  be  ignored.  The  pulse  will

start directly.
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o Process Time: Time before the beginning of the first pulse.

o Process Period Enabled: Notch this option if you want  have cyclic  pulses.  If not  notched,

the pulse will be permanent.

o Process Period: Select here the time of the period.

o Logic:  If  notched,  the  default  value  during  the  process  time  is  "1".  The  pulses  are

inversed.

Be sure to click [save] to enable your action.

Stop event:

Two kind of event can be stopped by Stop event: TTL output activation and Message play.

To stop an event,  create an event  which stop event  (control type).  Then  click  in  the  Mount  field  of
this event.

And then select which event you want to stop.

Message play event:

(see Use the message component)

First  of  all,  Load  messages  into  UAPG2  by  using  wav file  manager  and  Message  storage
component.

Then into the message storage component, choose the Event Settings tab:

Click [Add] to add a message play event (events which start the selected message)

o Delete: Tick the box in the Selected column and click to delete event(s).

o Select: select all event(s).
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o Cancel: unselect all selected event(s).

Now you have created message play event you will have to assign wave file to event(s):

Click on "Assigned field" of the desired event:

Choose the wave file which will be played.

You can choose to repeat  the message a fixed number of times:  (Repeat  field)  or  until  a  stop
event appears (Forever field).

(In the assigned field you will  see the number of wave file assigned).  Priority  allows you to fix  if
the  event  has  a  higher  priority  regarding  another  message  event.  For  more  information,  see
Message Selection.

5.3.1.1 Message Selection

Message selection from UAP

As to be played, the message must be in the UAP G2, my advice is to click on "+Add from UAP" to
open this window.
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Click  on  the  reading  glass  to  display  the  files,  select  one  and  then  click  on  "+"  to  assign  the
message file to the message event.

Click on the doors to quit this window.

Message selection from Wave Library

If you want to import a file from your PC, click on "+Add from Wave library":

Then click on "+Add" to open the browser which allows you to select the file to import.
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Select the files and click on "Transfer" to assign the message file to the message event.

Click "Close" to close this window.

5.3.2 Use third party to trigger

Use Third Party to trigger an event as messages.

Open View > Event management:

1. Here you can see the list  of your events.  To control an event  from a third party,  notch the "Third
Party Cont." function of the event.

2. Close this window.



UAP G2 Manual212

© 2019, ATEÏS, member of PAX ProAV Group

3. Open View > Third Party Control. Select the "Events" tab.

4. To see which frame you have to send from the third party  controller to  pilot  the  UAPG2,  simply

click on the three dots (  ) in the Command field.

5.3.3 Use scheduler to trigger

Use Scheduler to trigger an event as messages.

Open the schedule management window: menu view > Schedule management. This windows lists all the
programmed schedule(s)
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[Add]: to add a schedule.

[Edit]: open the Schedule setting window to edit an existing schedule.

[Delete]: erase an existing schedule.

[Select]: select all schedules.

[Clear]: Clear all selected schedules.

[Close]: Close this window.

Click [Add] to create a new schedule (open the Schedule Settings):
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Occurrences field: 

Gives name to the schedule and set time period etc.
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o Schedule Name: Name of the current schedule.

o Start time: Beginning date of the current schedule.

o End time: Ending of the current schedule.

o Enable: Active the schedule.

o Period: Gives the repetition frequency for the event sequence (schedule).

Event List: 

List  of  all  the  defined  events  (here  we  do  not  have  any  event  created,  menu:  view  >  event
management). You can find the event list on the right side at the small arrow.

Event control:

Define which event will be start  by  the schedule.  You can also create a string of several events
and define time between event’s launch.

Here you assign which event(s) will be started with the schedule.

First create event group:

Click [Add] to add Event group, click [Delete] to clear the selected group. 

Then, create an event sequence (Event).
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Click [Add] Event, click [Delete] to clear selected event.

Simply drag and drop event from the event list to the event group or event field.

By double clicking on the event field in the sequence you will open the event setting window.

A time setting allows you to fix interval time between event groups (time displayed at  the right  of
the event group) :

Be carefully if you start a message before the end of the previous message, it won't be played.

After all is defined, do not forget to click [ok]

Then check the active box in the Schedule Management window: NO= inactive, YES= active.
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5.3.4 Use PPM-KP to trigger

1. Connect to your PPM-SP (not PPMV2~V4) and PPM-KP. Wire it physically to the UAP G2.  Only  the
last PPM-KP will be used to trig messages.

2. In the System page, add the remote PPM icon to an input.

3. In the menu Tools, clear the remote IP and search the PPM device.

4. Double click on the PPM icon and select  to number of Key that  you have (1 PPM-SP +1 PPM-KP =
16 Key / 1 PPM-SP +2 PPM-KP = 24 Key etc.).  When you will  be connected (after compilation and
storing), you will have to notch the "Message control" option.

5. Double click on the UAP to enter in the draw window, and drag and drop the "Message Player",  and
LPC component. The message player must send its audio to the input of the LPC. If the PPM is  also
used as microphone,  you have to mix  the  both  microphone  input  and  message  player,  you  can  do
that by several way, Matrices, Ducker, etc.
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6. Then double click  on  the  LPC component,  and  notch  the  table  to  make  the  routing  as  you  which.
Select the good audio input in the Audio Module Box.  You cannot  have fixed route for the messages,
so  don't  assign  zones  to  the  keys  on  PPM-KP  keypad.  In  the  message  player  component,  add
several Message events, and assign them to audio files.

7. Double click  on  the  "Message  player"  component,  add  several  "Message  Play"  events  and  assign
them to audio files.

8. Open the Event  management windows,  and notch  the  "Third  Party  Cont."  option  for  each  message
event.
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9. Open the "Third Party  Control"  floating window.  Write  PPMx  under  "Command_id"  ,  where  x  is  the
Key number of the last PPM-KP (from 1 to 8). By this way you can chose which Key of the last  PPM-
KP will start which message.

10.After compilation and storing you can trig messages:

Select  the zones where the message will  be played by  pushing some key on the PPM-SP,  and
then push the key of the PPM-KP (that's the message selection).

5.3.5 Use control inputs to trigger

Use Control Inputs to trig Events (as messages)

Open Event management window menu view:
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According to the TTL state (High or Low) click on one of the two fields: Login IN (High or Low)

And select the logic channel number:

Do not forget to activate your choice by clicking [Save].
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For more details, please see How to use Events chapter.

5.4 Device management

5.4.1 Read version

To know which versions are loaded in the devices and which version are available with the UAPG2.

software:

Choose Menu: > Help > Version

If you have trouble  to  read  version  it  is  probably  due  to  the  fact  that  the  system  is  not  configured.  It
means that  the software doesn't  know how many UAPG2 are connected to it  and the UAPG2s doesn't
know their place in the network (even if you have one UAPG2) to set up the system:

1. Clean MCU.

2. Make a simple design (just define UAPG2 system).

3. Compile it and load it. (If the system is not configured, the software will  ask  you if you want  to do
it.  Click  [yes])  The  software  will  check  if  the  version  between  the  AP  and  the  UAPG2  are
matching, and tell you if it is not the case.

4. After those Steps you can read the version.

During the Store process,  the software verify  the different  versions  (DSP,  MCU,  NET,  PM  and
URC) If the version are not correct, a message appears. Connect  UAPG2G ?to your PC Launch
the UAPG2 software

Connect UAPG2G to your PC Launch the UAPG2 software

Choose menu: > Help > Version.
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Click "Read Version".

o Firmware Ver: if red indicates that MCU has to be updated.

o DSP Ver: if red indicates that DSP has to be updated.

Version mismatch is  displayed in red,  indicates  that  you have to update the Firmware.  When you have
URC or PPM defined and connected you can also check if versions are OK.

Updating the UAPG2 software makes necessary to update the UAPG2's firmware also.

5.4.2 Update

Updating Software UAPG2/URC/PPM firmware version.

For the software:

New versions are available on the net.  Read carefully  the release note in order to determinate if
updating is required or not for your specific system

For the firmware:

The purpose is  to match the version contained in  your  UAPG2-PPM  software  with  the  version
contained in UAPG2's hardware. 

First, performing "Read Version" to know if there is versions mismatching.  Then proceed to the update if
needed.
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We need to update following:

DSP

MCU

PPM or URC

Update DSP

Updating the UAPG2 software sometimes makes necessary  to update the UAPG2's  firmware also.
To do this follow these steps:

Note:  Update  DSP  always  BEFORE  a  MCU firmware  update;  even  if  there  is  no  MCU  firmware
mismatch when reading the firmware versions.

Open the Ethernet connection

Choose menu: > Tools > Update... (DSP Tab)

Select the UAPG2 you want to update (click on the box on the left)

Click [Update]

Update MCU

Note: Update MCU always after a DSP firmware update; even if there is no MCU firmware mismatch
when reading the firmware versions. 

Open the Ethernet connection.

Choose menu: > Tools > Update... (MCU tab).
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Select the UAPG2 you want to update (click on the box on the left).

Click [Update].

Note: you can update several UAPG2 at same time.

Update URC

Open the Ethernet connection.

Be sure the URC is detected (search process and IP address given) and connected.

Choose menu: > Tools > Update... (URC tab).

Select the URC you want to update (click on the box on the left) (you can update several URC at
same time).
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Click [Update].

Update PPM or PPM-SP

Open the Ethernet connection.

Be sure the PPM is detected (search process and IP address given) and connected.

Choose menu: > Tools > Update... (PPM or PPM-SP tab).

Select the PPM or PPM-SP you want to update (click on the box on the left).

Click [Update].

5.4.3 Adjust time/date

Select Tools > Machine configuration, this window opens:
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Click [Read] to load the UAPG2 values.

Set Date&Time manually:

Click on (respectively) "Date" field and "Time" field, write the wished date & time.

Then click [SET] to load these values into UAPG2.

Get Date&Time from the computer:

Click on [Get Current Time] will display the date & time of the computer.

Then click [SET] to load these values into UAPG2.

Time adjustment:

If  you  use  the  UAPG2  connects  to  internet,  our  advice  is  synchronizing  the  time  with  NTP
protocol.

o Adjust Time/Date with NTP

Set the UAPg2 to have the date/time updated in real-time by the NTP servers.  NTP means
Network Time Protocol.

First of all, Select Tools > Option, check the IP address on the both "Network"  and "Internet
Protocol" tab.

The IP address of your PC (Network tab) must  be in the same network  than the IP address
of  the  UAPG2 (Internet  Protocol  tab).  The  Gateway  must  match  with  the  gateway  of  the
local network where is connected the UAPG2.

If you change a parameter, then the UAPG2 must be restarted.

Unroll the "country" menu and select your time zone. Then next to "Network Time Protocol",
select "On".
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Click [read] to see which settings are into each UAPG2 of the system, click [SET] to load some
settings changes

If you use the UAPG2 is not connected to internet, then the only  way to adjust  the time if needed
is  to use the parameter "Time error (Sec)".  At  first,  set  the time (from the PC or with  NTP),  and
remember  this  time.  Leave  the  machine  working  in  stand-along  during  one  month.  After  one
month,  record  the  current  time  and  see  the  formula.  Time  Error(sec)=(current  time  -previous
time)/30  Set  time  error  sec  in  machine  configuration.  Every  day  at  00:00,  the  machine  will
automatically increase/decrease the time(calibration time). 

When using the NTP protocol on an internet NTP server do not  update the time or date within 5
sec of each other. You will risk getting you IP address band by the NTP server.

5.5 Store

When all the settings (signal path) are OK, we just have to upload them into the UAPG2 system.

1. Compile your project: menu: “Compile >Compile...” or hit Ctrl+F4 or click on this icon :

2. When this window appears click OK.

If this window does not appear, or if there are warnings,  there is  some trouble with the configuration
(design). Check it and correct the mistakes.
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3. Now we are going to load the  UAPG2 with  our  configuration:  menu  "Operations  >  Store"  or  hit

ctrl+F7 or click on this icon .

4. This window appears

  

5. Type user ID (in a new setup this is always ADMIN no password)Click  [ok],  you will  see the load
process.

Steps 6, 7 and 8 are FOR URC AND PPM only

6. At the end, if the remote is well configured this dialogue box appears:

For PPM, if this dialogue box does not appear, it means that  the PPM is  not  recognized by  the
UAPG2.  A  yellow  light  flashes  on  the  PPM  (Fault  led).  You  have  to  restart  the  research
procedure.

7. Click Yes, the URCs and PPMs are configured when this dialogue box appears:



System configuration 229

© 2019, ATEÏS, member of PAX ProAV Group

8. Click  Ok.  A dialogue box appears  and asks if you want  to connect  to the machine.  Click  Yes if
you want to pilot some settings with your computer.

9. Another dialogue box appears and asks if you want to “order audio_enable”. Click Yes if you want
inputs and outputs to be active.

5.6 User Management

User Management

Opens the User Management window (floating window)

You have the possibility to define up to 40 different users with different access privileges.

Add: To add a new User (open the "Add new user window").

Delete: To delete one user,

Store: To load new user in UAPG2 system.

Close: To close window.

If  you  select  a  User  and  click  [Edit]  you  will  have  access  to  "Add  new  user  window"  to  modify
access privilege or change code:
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This window allows you to give access password, name and to define access privileges. 

Simply read what you want to allow as rights and notch the corresponding blank square.

Bottom of the window you can define which UAPG2 file will be opened when the user will log in. 

You need to setup both Use ID and User management for a working user in the virtual/monitor
window mode of the software. If the software asks to save the changes, click save.

ID Management:

Opens the ID Management window (floating window)
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This feature is available to prevent all unauthorized people to connect to the system via the network.

The ID management allows to gives access to the Master-Preset  with an user name and password.
With this window you can:

Add: create new user.

Delete: Erase users.

Close: Close the window.

Finally Edit user’s right [Edit]) this last button opens the following ID Information window.
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Password field: 

Enter desired password

Idle to lock XX minutes: 

If the user doesn’t  use software during XX, the connection will  be closed and user will  have
to log again. 

When the software was locked, users should enter an account  with a correct  password.  Or
the software will be locked permanently.

Keep preset for next user: 

It is possible that a user doesn’t have the right to log in with the last  preset  used by  another
user (the one who just logged out).

By clicking this option, you assign the right  to this  user to log in and use the system even
without the right for this preset.

Box at  the right  part  of the window:  Show all  master  presets  of  the  system.  Choose  which
master preset the IDM user will have right to access and operate.

Logout User

Opens the User Login window (floating window)

In this window, it allows user to logout or change users, and is available only if unconnected.
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Logout ID

Opens the IDM Confirmed window (floating window). It allows user to logout or change ID users.

5.6.1 Edit User

You can define up to 40 users. Each user is protected by  password.  Different  user's  right  are adjustable
for each user. 

To set users right:

Click menu: "User > User management"

A windows appears  you can add new users  click  "Add" or you can delete user by  selecting it  and
clicking "Delete".

By  clicking  "Edit"  you  can  adjust  the  user  privileges  and  define  password,  these  privileges  are
coupled on the design file selected on the bottom.
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First  enter User name then password.  If you  check  Customized  in  the  Set  Access  Privileges,  By
notching the white square you can select  which are the privileges of this  user (by  notching what  do
you want). Than couple the file by selecting it in the bottom line. Now the software has all  the known
privileges to the users.

To get connected to the UAPG2 with the new user the UAPG2 also has to know the user.

Click menu: "User > ID management"

Type the same User ID and Password and click ok.

The UAPG2 has to be connected to the PC to set this item.

5.7 Preset

Master preset  allows storing of several different  DSP design in a same  configuration.  For  example  if
you have room which can be separated into two smaller sized rooms etc.

Icon from left to right:

o Indicates which current Master Preset you are working with.
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o Names each Master Preset

o Add or Delete Master Preset

1. Define (Add and Name) the number of Master Preset that you need.

2. Select the Master Preset you want to work with and make your design.

3. Do the same for each Master Preset.

To change Master preset  simply  change the current  Master  preset  when  the  PC is  connected,  or
use URC or Logical connectors.

Sub  Preset  allows  you  to  store  different  adjustments  (Level,  mute)  but  not  (as  Master  preset)  to
change DSP design (no possibility to change routing, modules...)

Icon from left to right:

o Name of the current Sub Preset

o Add or Delete a Sub Preset

o Manages Sub Preset name

o Saves or Load Sub Presets

Example for use:

We are going to define two sub-presets:

o The first with all the C inputs on +20dB (Sub preset's name: A + 20dB).

o The second with C inputs set to -90dB and Mute on (Sub preset's name: A mute).

1. Define the two Sub-Presets. Click  on the "Subpreset  add" twice to add two Sub-presets  and
enter the name of them.

  

2. Click "OK", the name of the current Sub-Preset appears:
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3. Then we are going to choose which adjustments we want to assign to the Sub preset: 

Double click on the component  you want,  (for our example double click  input  C),  then right
click on the adjustments and assign the adjustment to the sub-preset. A purple dot  appears
if there is a sub-preset assigned to the adjustment. Repeat that for all the adjustments.



System configuration 237

© 2019, ATEÏS, member of PAX ProAV Group

4. Set the adjustments: click on the Sub preset you want to store the adjustments:

For example  we  use  "A  mute",  adjust  the  parameters  as  you  want,  here  we  turn  on  the
"Mute" and decrease the Level.
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5. When the adjustments are OK. Click  "Subpreset  save" in order to store your adjustments  in
the current Sub Preset (you make a kind of photocopy of the adjustments  you have selected
in this Sub-preset). Repeat those actions with the other Sub preset.

6.  If you want  to load saved Sub Preset  select  the Sub Preset  you want  and click  "Subpreset
load".

5.8 Virtual Control

The Virtual Control allows you to define group buttons,  LEDs,  or Fader.  You can import  those groups in
the Monitor Window.

Open Virtual Window: "Menu: > View > Virtual control" (or press F11)

1. Select by drag and drop (from the Design Control Area to the Virtual control window) which kind of
controls or indicators (Logical In, Logical Out or Knob) you want.
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2. Name the virtual adjustment  by  right-clicking on it:  >  Properties  > “Function field”.  You can also
adjust some settings, in the properties window.

  

3. Assign which adjustments  you want  to  control  with  this  virtual  adjustment  (double  click  on  the
component icon then right-click on the adjustment  and select  Virtual control > analogue in,  logic
in or logic  out  (depends on which kind of adjustment  you want  to  control)  >  name  of  the  virtual
adjustment.



UAP G2 Manual240

© 2019, ATEÏS, member of PAX ProAV Group

4. If you want to use the virtual adjustment in the Monitor window right click on the virtual adjustment
and select > copy to Monitor then paste it on the monitor window.
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5.9 Monitor

The Monitor window is a window in which you can bring all  the adjustments  and indicators  you need for
your project. This is helpful if you want to have a graphical control interface.

See View/Monitor settings to set the options of the monitor window.

1. Open the Monitor Window: > View > Monitor (or F12)

2. For each adjustment you want to import in the monitor window:

a. Double click on the component icon

b. Right-click on the adjustment you want to import

c. Select > Copy
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d. Then go to the Monitor window

e. Right-click where you want to paste the adjustment

f. Select > Paste

In the “Design Control Area” you have three choices (drag and drop to the monitor window):

Label: Adds a written message.

Group button: Adds a button which opens a sub-monitor window.

Image: Adds a background Image.

Close button: Adds a close button to close the virtual window or sub-monitor window.
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Password Setup / Lock

If you want to protect the access to the UAP, click on (Ctrl+M).

Chose and type two times a password (this is not an user or ID user management).

Now you can lock the system by clicking on  (Ctrl+L).

To unlock, click on the button and type the password.

Tips: If you want  to create a complex Monitor window (for operator only) create all  the  parameters
you'll need in Administrator mode. Then create another user with the following rights,  and made the
window directly with the right window size (it is more convenient)
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5.10 Monitor Settings

Use the monitor window in  auto-login.  You  can  create  a  specific  user  to  have  only  an  access  to  the
monitor window.

This user must be associate with a configuration file (*.uap).

At first, disconnect with the UAP, and open File -> Save As. Save the configuration.

1. Open User -> User Management:

Click [Add] to create a new user:
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Write the User Name and the Password.

Unroll  the  menu  and  select  "Operator",  this  predefined  user  has  an  access  only  to  the
monitor.  This  allows  user  to  connect  or  disconnect  UAPG2,  enable/disable  the  audio  and
change the control settings in the components.

Click [Open]  to open the browser and select  your configuration file.  This  configuration will  be
automatically loaded when the user will type its user name and password.

Click [Ok] to save and click [Close] to close the window.
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2. Open View -> Monitor Settings:

Notch the options of the monitor window. See View/Monitor settings for more details.

To have an automatic logon, notch at least "Auto Connect". 

After the monitor settings,  compile the design then save your configuration in the file and store
the configuration.

If the IDM is  required (access to the Master-Presets),  type  the  default  IDM  user  "ADMIN"  (no
password).

The system is ready. Disconnect and close the software.

3. Now to access to the machine, the monitor user has to follow these steps:

Open the UAPG2 software.

Type the User and Password:
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The ethernet connection and also the machine connection will be done automatically:

o Auto ethernet connection :

o Auto machine connection:

Close these windows.  Now the monitor window is  opened,  and the user is  connected (ethernet
and machine).

To return in administrator mode, the user has to disconnect with the machine ,  Click  on the

"User Login" , and then type the default user ADMIN. 

If you find trouble check the following points:

o Control the settings in View > Monitor Settings.
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o Be sure to save the configuration file after compilation (needed after every  change in  the

config).

4. Master-Preset access limitation:

If you want to limit the Master-Preset access depending of the user,  then don't  select  the "auto
connect"  option in the  Monitor  Setting  window.  Create  an  IDM  (User  ->  ID  Management)  and
select for this IDM the authorized Master-Presets.

Now  when  the  user  will  start  the  software,  he  will  have  to  type  the  UserID.  The  ethernet
connection  will  be  done  automatically,  and  the  configuration  will  be  loaded  but  the  machine
won't connected.

The user has to click on the "Machine connection" icon and type the IDM.

Only the Master-Presets associated to the IDM will be loaded.

5.11 How To

5.11.1 Create paging of PPM with LPC

Component Appearance

Description

LPC (Link Page Control) is the component for paging the audio signal of PPMs.
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Be  aware  that  you  cannot  add  more  than  one  LPC per  UAPG2.  If  you  have  several  PPMs  on  a
UAPg2, then you have to use the different input of the LPC component.

Control Window

For example if we have two PPMs on UAPG21 and one PPM on UAPG2:

Choose one of the LPC in the LPC list. No matter which LPC you choose,  it's  not  necessary  to use
all the inputs or outputs of the LPC. Even if you use one PPM (so one input of the LPC) you can use
for example the LPC 4x28.

Then Double click on the component (LPC) to tell where the inputs are connected.

Each PPM which use one input has to be configured in its tab.

First select the "input 1" tab to set the first PPM. 
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Unroll the menu "Audio Module" and select the input used by this PPM.

As soon as the  input  is  selected,  the  paging  matrix  is  displayed.Here  you  can  choose  on  which
zones you will have microphone signal when a key is pressed by notching the boxes:

Then do the same for the second PPM. Select the tab number 2 to set  the second PPM. Unroll  the
Audio Module menu and select  the input  used by  the second PPM. And then notch the boxes you
want to associate the outputs with the PPM Keys.
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Now do the same in  the  second  UAPG2,  double  click  on  the  component  (LPC)  to  tell  where  the
input  is  connected.  First  select  the "input  1"  tab to set  the PPM. Unroll  the menu  "Audio  Module"
and select the input used by this PPM.

5.11.2 Use front knobs

Right  click  on  the  software  adjustments  you  want  to  pilot  with  the  control  input  and  choose  control
option:

1. Type of control you can assign to this software control (adjustments).

2. Name of the UAPG2 in the system.

3. Connector channel number (control input  9 to 16  defined  as  analogue  input),  FP  =  Front  Panel
knob.)
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6 Components

6.1 Input

Component Template

Component Appearance

Description

Control  the  input  signals  parameters  and  monitor  it.  The  analogue  input  modules  represent  the
physical  analogue  inputs  accessible  on  the  rear  panel  of  the  UAPG2.  There  are  four  separate
modules  for  use  with  each  of  the  audio  board  slots  A,  B,  C  and  D.  Analogue  input  and  output
modules  are  added  automatically  to  the  DSP  window of  the  relevant  processor  by  defining  their
module configuration at the time you create them and should not be altered.

Control Window

The main control window of the input module is opened by a double click  on the icon in the UAPG2
design window and appears like this: 
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The sensitivity and phantom power can be set and changed when connected.

Analogue Input Adjustments

Parameter  Range  Comment

Bypass  On/Off
Bypasses the channel fader settings. The channel gain will be

equal to unity gain (0 dB); LED, lit green when activate.

Mute  On/Off 
Mutes or un-mutes the input channel; LED, lit red with channel

muted.

Sensitivity
0dB, 12dB, 24dB,

40dB, 54dB
Sets the input gain of the channel preamplifier.

Phantom Power  On/Off 
Applies 48 VDC phantom power to the channel input for use

with condenser mikes.
RTO  LED, Lit blue  Indicates an input channel 'Routed To Output(s)'.
Clip  LED, lit red  Indicates channel level above 'Clip Threshold (dB)'.

Volume (dB)  -20 to +20 dB  Meter showing the channel RMS level.

Signal  LED, lit yellow
 Indicates audio signal presence above -30 dB from chosen

'Sensitivity'.
Level (dB)  -60.0 to +20.0 dB  Signal output level of the module

Clip Threshold -20.0 to +20.0 dB  Sets the threshold of the Clip indicator.
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6.2 Output

Component Template

Component Appearance

Description

Control the output  signals  parameters  and  monitor  it.  The  analogue  output  modules  represent  the
physical  analogue  outputs  accessible  on  the  rear  panel  of  the  UAPG2.  There  are  four  separate
modules  for  use  with  each  of  the  audio  board  slots  A,  B,  C  and  D.  Analogue  input  and  output
modules  are  added  automatically  to  the  DSP  window of  the  relevant  processor  by  defining  their
module configuration at the time you create them and should not be altered.

Control Window
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Analogue Output Parameters

Parameter  Range  Comment

Clip lit red Indicates channel level above chosen 'Clip Threshold (dB)'.

Volume (dB)  -90.0 to +20.0 dB
Mutes or un-mutes the input channel; LED, lit red with channel

muted.

Mute  On/Off 
Mute On/Off Mutes or un-mutes the output channel; LED, lit

red with channel muted.

Signal
LED, lit blue 

@ -30 dB
Indicates audio signal presence above -30 dB.

Level (dB)  -60.0 to +20.0 dB  Signal output level of the module
Clip Threshold -20.0 to +20.0 dB  Sets the threshold of the Clip indicator.

6.3 Mixer

Mix or route several signal to an Output.

Since the UAPG2 software only compiles active nodes, there is no use having a whole bunch of mixers,
like 2x1, 3x1, to (n)x1, then 2x2, 3x2, to (n)x2, etc. It simply makes no difference if you take a 4x4 from
the 4x4 component or the 16x16.

The mixer folder in the 'Component' control window holds three items:
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Within these items you can find the following modules:

Standard: 

o 4x4: 4 inputs mixing to 4 outputs.

o 8x8: 8 inputs mixing to 8 outputs.

o 16x16: 16 inputs mixing to 16 outputs.

Matrix: 

o 4x4: 4 inputs routing to 4 outputs.

o 8x8: 8 inputs routing to 8 outputs.

o 16x16: 16 inputs routing to 16 outputs.

Automixer:

o 4x1: mixing/priority switching of 4 inputs to 1 output.

o 8x1: mixing/priority switching of 8 inputs to 1 output.

o 16x1: mixing/priority switching of 16 inputs to 1 output.

6.3.1 Matrix

Component Template

Component Appearance

Mix  several  signals  to  Output(s).  The  mixer  components  are  organized  in  a  sub-folder  named
'Standard' holding the modules '4x4', '8x8' and '16x16'.
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Description

This component mix several signals to Output(s).

Control Window

The only difference of these modules is their number of in- and outputs, let's take a detailed look just
to the smallest  one,  the  4x4.  The  control  window of  the  'Standard  Mixer'  module  is  opened  by  a
double click on the icon in the 'UAPG2' design window and appears like this:

Clicking  the  orange  colored  function  [Output(n)]  buttons  under  the  label  'Variable  Matrix'  in  the
middle of the window opens the sub control windows of the particular output channels. 

In here you can create an individual mix  of the input  signals  independently  for the specified output.
By default  all  levels  are set  to 0 db,  which basically  means,  that  all  audio signals  at  the  input  are
mixed with no attenuation and appear like this on every output.

Standard Mixer (Master) Parameters

Parameter  Range  Comment

Input Mute  On/Off Mutes or un-mutes the input channels.

Input Level (dB)  -60.0 to +20.0 dB Sets the input level of the channel.

Variable Matrix Button 
Opens the sub control window 'Standard Mixer for routing and

mixing input channels to the specified output

Output Level (dB) -90.0 to +20.0 dB Sets the master output level of the channel

Output Mute On/Off  Mutes or un-mutes the output channel. 

Standard Mixer Parameters

Parameter  Range  Comment

Level (dB)  -60.0 to +20.0 dB Sets the input levels mixed to the particular output.
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6.3.2 Standard

Component Template

Component Appearance

Route  several  signals  to  Output(s).  The  matrix  components  are  organized  in  a  sub-folder  named
'Matrix' holding the modules '4x4', '8x8' and '16x16':

Description

This component routes several signals to Outputs.

Control Window

Since the only  difference of these modules  is  their number of in- and outputs,  let's  take  a  detailed
look just  to the smallest  one,  the  4x4.  The  control  window of  the  'Matrix'  module  is  opened  by  a
double click on the icon in the 'UAPG2' design window and appears like this:
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The matrix module is similar to the standard mixer,  with the main difference,  that  there is  no ability
to  make  independent  mixes  for  each  output  channel.  So  the  module  primary  is  used  for  simple
routing purposes.

By default  routing is  set  1 to 1;  audio at  each input  channel only  appears  on  the  particular  output
channel with unity gain. In short: The module does nothing at all.

Matrix Parameters

Parameter  Range  Comment

Input Mute  On/Off Mutes or un-mutes the input channels.
Input Level (dB)  -90.0 to +20.0 dB Sets the input level of the channel.
Routing Buttons On/Off  Turns on/off the input on the particular output channel.

Output Level (dB) -90.0 to +20.0 dB Sets the master output level of the channel
Output Mute On/Off  Mutes or un-mutes the output channel. 

6.3.3 AutoMixer

Component Template

Component Appearance

Description

This component allows mix several signals  to one output.  The Activation of channel(s) can be done
manually or automatically by signal threshold and priority.

Control Window

Since the only difference of these modules is their number of inputs, let's take a detailed look just  to
the smallest one, the 4x1. The control window of the 'Automixer' module is opened by a double click
on the icon in the 'UAPG2' design window and appears like this:
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The  auto  mixer  adjusts  the  signal  output  level  on  the  output  node  depending  on  the  number  of
activated  input  channels.  This  function  can  be  useful  in  conference  applications  or  houses  of
workshop, where usually unattended mixing has to be executed. A special feature of this component
is  the  priority  function,  which  can  be  used  for  auto-paging  applications  or  to  implement  a  voice
triggered chairman's mike in a small conference system.

Automixer Parameters

Parameter  Range  Comment

Mute On/Off Mutes or un-mutes the input channel
Invert 0°/180°  Inverts the polarity of the input channel.

Solo On/Off 
Solos the input channel. 

(the channel goes directly to the output)
Gate On  LED, lit green  Shows activation status of the input channel.

Level (dB)  -90.0 to +20.0 dB Adjusts the level of the output channel.

Manual Mode On/Off 
Only used in manual mode (see "Manual/Automatic") 

It allows manual channel activation.
Automatic Mode

Priority Level
 1 to (n) Sets the priority level of the channel. 1 is the most priority.

Output mute On/Off   Mutes or un-mutes the module's output.
Output level (dB)  -90.0 to +20.0 dB Sets the module's output level.
Threshold (dB) -90.0 to +20.0 dB Sets the threshold for channel activation.
Hold time (s) 0 to 10 s  Sets a hold time for the gate deactivation.

Attenuation
Response time (ms)

10 ms to 10.0 s 
Sets a pre delay time for automatic attenuation. 

That's means the transition time of the attenuation when a
channel is added or removed.

Background
threshold (%)

 0.0 to 100.0% 
Sets how the input signal is interpreted to open a gate.

The background level will increase the input activation level.
NOM attenuation

step (dB)
 0.0 to 6.0 dB 

Sets the amount of attenuation to be applied each time the
number of activated channels increases.

NOM attenuation  0.0 to 100.0 dB  Limits the amount of attenuation to be applied.
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Parameter  Range  Comment

max (dB)
Attn. Gain (dB)  -100.0 to +20.0 dB Indicates the amount of current gain reduction

Last Mic. On On/Off
Enables the last mic on function. If activate, even if there is no

audio on the inputs, one channel will stay open. (see "Last
Mic.On designated" parameter)

Last Mic. On
designated

 Ch 1 to (n), Last
Mic.

Defines which channel will stay open
(Only if "Last Mic. On" is activated).

Caution the channel will stay open even if it's muted.

Open Mic. Limits 1 to Non Limit
Chooses the maximum number of simultaneously activated

channels.

Manual/Automatic 
Manual or
Automatic

Select the mode, manual or automatic.
Manual mode : Only manual channel activation 

(threshold and priority are ignored) 
Automatic mode : With priority and threshold channel

activation.

NOM attenuation
mode

Eq1 or Eq2

Chose here if you want a linear attenuation or a logarithmic
attenuation which is more near of the reality.

Eq1 : (NOM-1) x step 
(same attenuation for each addicting channel), 

Eq2: log2(NOM) x step

 Channel activation:

At  first,  on  the  "Manual/Automatic"  selector  chose  if  you  want  manual  or  automatic  channel
activation.

o Manual:  The activation is  only  done manually  with  the  "Manual"  buttons.  The  threshold  and

the priority are ignored.

o Automatic:  The activation is  depending of the threshold,  and of  the  priority.  It  will  pass  only

highest priority channel out.  If several channels  have the same priority,  they all  will  be mixed
to the output together when they will be priority.

Attenuation:

The attenuation is always active. It doesn't depend of the mode.

The background threshold:

The  background  threshold  allows  adjusting  the  input  level  activation  depending  on  the
background level.

If  the  background  threshold  is  more  than  at  0%,  the  background  level  will  increase  the  input
activation level. You can adjust  the relation between the background and the activation level by
move the background threshold knobs.

Threshold' = Threshold+(mixing input*Background threshold percent).

PS: The used values to calculate are not in dB.

o Example 1:

One input in 0.5db => mixing input=1.059253725177289*1= 1.059253725177289

Threshold=0dB =1

Background threshold percent=5%

Threshold'=1+(1.059253725177289*0.05)=1.052962686258864
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In this case input=0.5db is almost critical point

Input >=0.5dB then on,

Input<0.5dB then off.

o Example 2:

Two input in 9.5db => mixing input=2.985382618917960*2=5.970765237835919

Threshold=5dB =1.778279410038923

Background threshold percent=20%

Threshold'=1.778279410038923+(5.970765237835919*0.05)=2.972432457606106

In this case input=0.5db is almost critical point

Input >=9.5dB then on,

Input<9.5dB then off.

6.4 Compressor/Limiter/Expander

The 'Compressor/Limiter/Expander' folder in the 'Component' control window holds for items:

They represent the dynamic section and consist of the following modules:

Limiter: Single channel limiter, triggered by input level (Feed-Forward type).

Compressor" Single channel compressor, triggered by input level (Feed-Forward type).

Expander: Single channel expander, triggered by input level (Feed-Forward type).

Comp-Limiter: It provides a simplified compressor and a limiter together.

6.4.1 Compressor

Component Appearance

The first module within the 'Compressor/Limiter' folder is a simple single channel 'Feed-Forward' type
compressor device:

Description

A compressor is an automatic  volume control.  Loud sounds over a certain threshold are reduced in
level  while  quiet  sounds  remain  untreated.  In  this  way  it  reduces  the  dynamic  range  of  an  audio
signal.  This  may  be  done  for  aesthetic  reasons,  to  deal  with  technical  limitations  of  audio
equipment, or to improve audibility of audio in noisy environments.  Compression reduces the level of
the loud sounds,  but  not  the quiet  sounds,  thus,  the level can be raised to a point  where the quiet
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sounds are more audible without the loud sounds being too loud.

Control Window

The  control  window of  the  'Compressor'  module  is  opened  by  a  double  click  on  the  icon  in  the
'UAPG2' design window and appears like this:

The compressor's  control window features  a graphical display/editor window which  is  opened  by  a
click on the [Graph] button at the top left side of the control window and looks like this:

The display/editor window displays  an output  to input  graph,  where the vertical axis  corresponds to
the output signal level in dB, while the horizontal axis displays the input signal level in dB. The green
line reflects the currently set dynamic response graph of the compressor.

The  small  squares  act  as  handles  that  can  be  dragged  to  the  desired  position  and  show  the
following parameters:

o Red Ratio x:1

o Blue Threshold (dB)
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o Yellow Threshold range (dB)

Compressor Parameters

Parameter  Range  Comment

Graph...  Button Opens the graphical display/editor window.
Ratio x:1 0.10 to 1.00 Sets compression ratio.

Threshold (dB) - 60.0 to +20.0 dB
Sets the range of level, in which the ratio gradually alters from
1:1 to the value set by the ratio parameter (soft knee function).

Attack time (ms)
(Attack)

10 to 1000 ms Sets the time it takes to respond to the input signal.

Release time (ms)
(Release)

10 to 1000 ms Sets the time it takes to release gain reduction.

Gain reduction (dB)  0.0 to -25.0 dB Reflects the current amount of gain reduction.
Bypass  On/Off Bypasses the compressor's function.

Soft knee On/Off Enables/disables the “Soft Knee” mode.
Compress LED, lit green Indicates compression.

6.4.2 Limiter

Component Appearance

Description

The second module within the 'Compressor/Limiter' folder is  a simple single channel 'Feed-Forward'
type limiter.

Control Window

The control window of the 'Limiter' module is  opened by a double click  on the  icon  in  the  'UAPG2'
design window and appears like this:

The limiter's control window features a graphical display/editor window which is opened by a click  on
the [Graph] button at the top left side of the control window and looks like this:
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The display/editor window displays  an output  to input  graph,  where the vertical axis  corresponds to
the output signal level in dB, while the horizontal axis displays the input signal level in dB. The green
line reflects the currently set dynamic response graph of the compressor.

The  small  squares  act  as  handles  that  can  be  dragged  to  the  desired  position  and  show  the
following parameters:

Blue Threshold (dB)

Hard Clipping mode:

This is an example of a sinusoidal signal limited with and without Hard Clipping.

Without Hard Clipping   w ith Hard Clipping

If the input signal is a lot higher than the threshold the signal will  be almost  identical to the hard
clipping.  The limiter is  a crude way of limiting.  For smoother limiting  a  compressor  is  a  better
solution.

Limiter Parameters

Parameter  Range  Comment

Graph...  Button Opens the graphical display/editor window.
Threshold (dB) - 60.0 to +20.0 dB Sets the threshold level above which limiting begins.

Release time (ms) 10 to 1000 ms Sets the time it takes to release gain reduction.
Bypass  On/Off  Bypasses the limiter's function.
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Parameter  Range  Comment

Hard Clipping On/Off  Enables/disables the “Hard clipping” mode.
Limiting LED, lit red  Indicates limiting.

Gain reduction (dB) 0.0 to -45.0 dB Reflects the current amount of gain reduction.

6.4.3 Comp/Limiter

Component Appearance

The third module within the 'Compressor/Limiter' folder is  a combination of the compressor and the
limiter modules described earlier:

Description

This component is the combination of the compressor and the limiter.

Control Window

The control window of the 'CompLimiter' module is opened by a double click  on the icon in the 'UAP
G2' design window and appears like this:

As  this  component  is  works  exactly  like  the  separately  described  modules  please  refer  to  the
parameter list of Compressor and Limiter.

6.4.4 Expander

Component Appearance

The only  module within the 'Expander' folder is  a simple expander of the same 'Feed-Forward' type
like the compressor:
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Description

An expander works in an opposite fashion than the compressor, the threshold is  set  and any part  of
the signal dropping below this threshold will be affected by the expander and this level will  be raised.
The  expander  therefore  like  the  compressor  balances  out  the  signal  making  it  sound  more
professional. The expander allows having a signal with a bigger dynamic range.

Control Window

The control window of the 'Expander' module is opened by a double click  on the icon in the 'UAPG2'
design window and appears like this:

The compressor's  control window features  a graphical display/editor window which  is  opened  by  a
click on the [Graph] button at the top left side of the control window and looks like this:
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The display/editor window displays  an output  to input  graph,  where the vertical axis  corresponds to
the output signal level in dB, while the horizontal axis displays the input signal level in dB. The green
line reflects the currently set dynamic response graph of the compressor.

The  small  squares  act  as  handles  that  can  be  dragged  to  the  desired  position  and  show  the
following parameters:

o Red Ratio x:1

o Blue Threshold (dB)

o Yellow Threshold range (dB)

Expander Parameters

Parameter  Range  Comment

Graph...  Button Opens the graphical display/editor window.
Ratio x:1 0.10 to 1.00 Sets expansion ratio.

Threshold (dB) - 60.0 to +20.0 dB Sets the threshold level above which expansion begins.
Threshold range

(dB) 
0.0 to 40.0 dB

Sets the range of level, in which the ratio gradually alters from
1:1 to the value set by the ratio parameter (soft knee function).

Attack time (ms)
(Attack)

10 to 1000 ms Sets the time it takes to respond to the input signal.

Release time (ms)
(Release)

10 to 1000 ms Adjusts the time to stop the gain reduction.

Gain reduction (dB)  0.0 to -25.0 dB Reflects the current amount of gain reduction.
Bypass  On/Off Bypasses the compressor's function.

Soft knee On/Off Enables/disables the “Soft Knee” mode.
Expand LED, lit red Indicates that the function is active.

6.5 Equalizer

The 'Equalizer' folder in the 'Component' control window holds  two sub-folders  containing parametric  and
graphic EQs:

6.5.1 PEQ

Component Appearance

You have six different PEQ modules, 2, 4, 6, 8, 10, 16 bands:
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Description

PEQ is  abbreviation of  parametric  equalizer,  PEQs  are  multi-band  variable  equalizers  which  allow
users  to  control  the  three  primary  parameters:  amplitude,  center  frequency  and  bandwidth.  The
amplitude of each band can be controlled,  and the center frequency can be shifted,  and bandwidth
("Q") can be widened or narrowed. PEQs are capable of making much more precise adjustments  to
sound  than  other  equalizers,  and  are  commonly  used  in  sound  recording  and  live  sound
reinforcement.

Control Window

The control window of  the  'PEQ'  module  is  opened  by  a  double  click  on  the  icon  in  the  'UAPG2'
design window and appears like this (example for 4 bands):

The display/editor window displays  an output  to input  graph,  where the vertical axis  corresponds to
the  output  signal  level  in  dB,  while  the  horizontal  axis  displays  the  frequencies.  The  green  line
reflects the currently set dynamic response graph of the equalizer.

The  small  squares  act  as  handles  that  can  be  dragged  to  the  desired  position  and  show  the
following parameters (example: 4 bands):

Orange Bandwidth (-)

Yellow Frequency (Hz)
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Equalizer Parameters

Parameter  Range  Comment

Symmetry - Not available on next versions.
Bypass all - To bypass the EQ (all the frequency channel).

Bypass - Bypasses only the selected frequency channel.
Bandwidth - Set the width around the frequency (Q factor)
Frequency - Selects the frequency to adjust

Gain - Set the gain (attenuate or increase the selected frequency)
Graph - Open the graphic window

6.5.2 GEQ

Component Appearance

You have three different GEQ modules, 1 Octave, 2/3 octave, 1/3 octave:

Description

GEQ is abbreviation of graphic equalizer, in the graphic  equalizer,  the input  signal is  sent  to a bank
of filters. Each filter passes the portion of the signal present in its own frequency range or band.  The
amplitude passed by each filter is adjust using a slider in control window of UAPG2 software control
to boost or cut frequency components passed by that  filter.  The vertical position of each slider thus
indicates the gain applied at that frequency band.

The number of frequency channels (and therefore each one's bandwidth) affects  the consuming DSP
power of audio processor, and may be matched to the requirements  of the intended application.  An
equalizer  for  professional  live  sound  reinforcement  typically  has  some  25  to  31  bands,  for  more
precise  control  of  feedback  problems  and  equalization  of  room  modes.  There  are  three  types  of
GEQ, 1 Octave,  2/3  Octave  and  1/3  Octave.  1/3  Octave  GEQ  (spoken  informally  as  "third-octave
EQ") because the center frequency of its filters are spaced one third of an octave apart,  three filters
to an octave. Equalizers with half as many filters per octave are common where less  precise control
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is called a 2/3-octave equalizer, and so on the 1 Octave GEQ, that is one filters to an octave.

Control Window

The control window of the 'GEQ' module is opened by a double click on the icon in the 'UAPG2'

design window and appears like this (example: 1 octave):

The display/editor window displays  an output  to input  graph,  where the vertical axis  corresponds to
the  output  signal  level  in  dB,  while  the  horizontal  axis  displays  the  frequencies.  The  green  line
reflects  the  currently  set  dynamic  response  graph  of  the  equalizer.  The  small  squares  act  as
handles that can be dragged to the desired position and show the following parameters  (example:  1
octave):

Yellow Frequency (Hz)

Equalizer Parameters

Parameter  Range  Comment

Bypass all - To bypass the EQ (all the frequency channel).
Bypass - Bypasses only the selected frequency channel.

Frequency - Show the frequency
Gain - Set the gain of the frequency

Graph - Open the graphic window
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6.6 Delay Basic

Component Template

Component Appearance

Description

Delay  (basics)  provides  all  to  delay  the  signal.  You  have  choice  between  seven  times  (you  can
adjust  precise  time)  and  each  sub-folders  contains  three  components  with  various  numbers  of
outputs.  The  difference  between  basic  and  advanced  is  that  for  the  advanced  you  can  mute  or
bypass delayed channels.

Control Window

Delay Parameters
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Parameter  Range  Comment

Type Button
Chose between adjustments with Time or

with Distance and temperature
Delay time (us) - Adjust the delay time (Type: switch on)

Temp (C) -
Enter the ambient temperature in Celsius degrees

(Type: switch off)
Gain - Adjust the distance in meter (Type: switch off)

6.7 Delay Advanced

Component Template

Component Appearance

Description

Delay  (Advanced) provides all  to delay  the signal.  You have choice between seven  times  (you  can
adjust  precise  time)  and  each  sub-folders  contains  three  components  with  various  numbers  of
outputs.  The  difference  between  basic  and  advanced  is  that  for  the  advanced  you  can  mute  or
bypass delayed channels.

Control Window

By double-clicking on the component's icon (for example: 50ms 4 Ch. ) a settings window appears:
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Delay Parameters

Parameter  Range  Comment

Type Button
Choose between adjustments with Time or with Distance and

temperature
Mute all Button Mute all channels

Bypass all Button Bypass all channels (disable the delay function)
Mute Button Mute the channel

Bypass Button Bypass the channel (disable the delay for this channel)
Delay time (us) - Adjust the delay time (Type: switch on)

Temp (C) -
Enter the ambient temperature in Celsius degrees 

(Type: switch off)
Gain - Adjust the distance in meter (Type: switch off)

6.8 Gate

The gate allows you to cut off the signal below a chosen threshold.

You can choose between four different gates:

Mono

With Sidechain

Stereo

6.8.1 Gate Mono

Component Appearance

The first module within the "Gate" folder is a simple single channel:
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Description

The gate allows you to cut off the signal below a chosen threshold.

Control Window

Gate Parameters

Parameter  Range  Comment

Mute Button Mute the gate's module
Bypass Button Switch off the gate's operation
Gate on LED, lit green Flash when the gate is active (open)

Thd. (Threshold)
(dB)

 -60.0 to +20.0 dB Sets the threshold level above which the Gate will open.

Response time 0 to 5000 ms
Adjust the time between the level's detection and the beginning

of the Gate operation
Attack time (ms) 0 to 1000 ms Adjust the fade-in time of the signal when Gate is working.

Hold time 0 to 5000 ms
Adjust the time between the end level's detection and the end

of the Gate operation

Release time (ms)  10 to 10000 ms
Adjust the fade-out time of the signal when Gate is 

no longer working
Depth (dB)  -100 to 0 dB Attenuate the level when the Gate is active.
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6.8.2 Gate With Sidechain

Component Appearance

Description

With this gate, you can control a gate on an audio channel (I) with an external sidechain signal(S).

When  the  Sidechain  input  (S)  input  goes  above  the  threshold,  the  gate  becomes  active  and  the
signal on Input (I) goes to the output.

Control Window

Gate Parameters

Parameter  Range  Comment

Mute Button Mute the gate's module
Bypass Button Switch off the gate's operation
Gate on LED, lit green Flash when the gate is active (open)

Sidechain gain (dB) -35.0 to + 35.0 dB Set the volume of the signal connected in the input S
Input gain (dB) -35.0 to + 35.0 dB Set the volume of the signal connected in the input I

Thd. (Threshold)
(dB)

 -60.0 to +20.0 dB Sets the threshold level above which the Gate will open.

Response time 0 to 5000 ms
Adjust the time between the level's detection and the beginning

of the Gate operation
Attack time (ms) 0 to 1000 ms Adjust the fade-in time of the signal when Gate is working.

Hold time 0 to 5000 ms
Adjust the time between the end level's detection and the end

of the Gate operation

Release time (ms)  10 to 10000 ms
Adjust the fade-out time of the signal when Gate is 

no longer working
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Parameter  Range  Comment

Depth (dB)  -100 to 0 dB Attenuate the level when the Gate is active.

6.8.3 Gate Stereo

Component Appearance

Description

Simple double channel Gate.

Control Window

The  control  window of  the  "Gate  -  Stereo"  module  is  opened  by  a  double  click  on  the  icon  in
the'UAPG2' design window and appears like this:

When one of the inputs  goes above the threshold,  the  gate  becomes  active  and  the  both  left  and
right input signals are routed to the output.

Gate Parameters

Parameter  Range  Comment

Mute Button Mute the gate's module
Bypass Button Switch off the gate's operation
Gate on LED, lit green Flash when the gate is active (open)

Left gain (dB) -35.0 to + 35.0 dB Set the volume of the signal connected in the input L
Right gain (dB) -35.0 to + 35.0 dB Set the volume of the signal connected in the input R
Thd. (Threshold)

(dB)
 -60.0 to +20.0 dB Sets the threshold level above which the Gate will open.

Response time 0 to 5000 ms
Adjust the time between the level's detection and the beginning

of the Gate operation
Attack time (ms) 0 to 1000 ms Adjust the fade-in time of the signal when Gate is working.

Hold time 0 to 5000 ms
Adjust the time between the end level's detection and the end

of the Gate operation

Release time (ms)  10 to 10000 ms
Adjust the fade-out time of the signal when Gate is 

no longer working
Left Depth (dB)  -100 to 0 dB Attenuate the level when the Gate is active.

Right Depth (dB)  -100 to 0 dB Attenuate the level when the Gate is active.
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6.9 AGC

6.9.1 Example of AGC using

As example, we want to automatically adjust the gain of a kind of SM58 microphone.

On the "Input A" component, the input sensitivity is set to -40dB for standard dynamic microphone.

Threshold: Set at -25dB. The level is adjusted only when the input signal is above -25dB. This is to
keep a natural dynamic.

Target level: We want a final target level at -10dB.

Maximum gain:  Set  at  10dB,  because  giving  more  gain  will  generate  some  uncomfortable  level
differences.

Release time: Set at 800(ms), enough time to avoid hard transition when the speaker talks  again,
after a little break.

Attack time: Set at 400(ms), enough time to avoid hard transition when the speaker begin to talks,
and not too long because we want a stable level quickly (not since the middle of the sentence).

AVG  time:  Set  at  200(ms),  not  too  long,  to  detect  short  peaks  in  the  speech  and  to  be
responsive. Not too short to avoid level change too often.

You can see on the vu-meter that when the speaker talks at 18dBu, the final level is around -10.5dBu:

Left to right: Input Level, AGC level, RMS vu-meter (AGC in and AGC out)
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6.10 Ducker

Component Template

Component Appearance

Description

The ducker is  a kind of “sophisticated switch” allowing to attenuate or  switch  off  automatically  the
signal arriving in input A when a chosen level (in dB) is perceived in input S.

Control Window

Ducker Parameters

Parameter  Range  Comment

Bypass Button Switches off the Ducker’s operations

Active  LED, lit green
Flashes when the Ducker is active (Signal has been detected

on input S)
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Parameter  Range  Comment

Thd. (Threshold)
(dB)

60.0 to 20.0 dB

Threshold of detection on the input (S).
The input (A) is attenuate when input signal (S) goes above

this threshold.
Advice : To avoid unexpected attenuation, don't set a low

threshold level

Response time 0 to 5000 ms 

Adjust the time between the S level's detection and the
beginning of the Ducker’s operation on the A signal.

Advice : Don't set a long "response time", otherwise you won't
hear the beginning the (S) signal 
(as the first words of the speech).

Attack time (ms) 0 to 1000 ms
Adjust the fade-in time of the (A) signal when Ducker’s is

working.

Hold time 0 to 5000 ms

 Adjust the time between the end (S) level's detection and the
end of the Ducker’s operation

Advice : Set enough "Hold time" to avoid unexpected
background level during the speech's breaks.

Release time (ms) 10 to 10000 ms
Adjust the fade-out time of the A signal when Ducker’s is no

longer working
Audio Depth (dB) -100 to 0 dB Adjusts the A level when the Ducker is active.
Speech gain (dB) -60.0 to+ 20.0 dB Adjusts the S level when the Ducker is active.

Example:

As simple example, we will set a system for a speaker with background music.

When the speaker is talking, the background music must decrease its level.

The speaking is using a standard dynamic microphone type SM58. The microphone is  connected to
the  channel  2  of  the  "Input  A"  component,  with  a  input  sensitivity  at  -40dB  (set  in  the  input  A
component). Then the microphone is linked to the input (S) of the ducker.

The music player (as a CD player) is connected to the input 1 of the "Input  A"  component.  Then the
music is linked to the input (A) of the ducker.

Threshold: set at -18dB, because less  would active the attenuation when the speaker is  not
talking if the microphone catch some unexpected noise.

Response time: set very short, because the background music  must  be attenuated as  soon
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as the speaker is talking.

Attack and Release times: Which are the "fade in" and "fade out" on the background music.
Set almost one second for the hearing comfort, we want a kind music transition.

Hold time: Set at 700(ms), enough to avoid the music back during the speech breaks.

Audio  depth:  Set  at  -20dB,  to  hear  the  music  during  the  speech,  but  at  very  low  level
(depending of the context).

6.11 Inverter

Component Template

Component Appearance

Control Window

The control window of the "Inverter"  module is  opened by a double click  on the icon in the 'UAPG2'
design window and appears like this:

Inverter Parameters

Parameter  Range  Comment

Mute Button Mute the Inverter's module
Invert. Button Activate the inverter
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6.12 Filter

The filters allow to attenuate or to select a specific frequency or band of frequency.

The Crossover splits the signal in sub-signal with 2, 3 or 4 Way. Each way contains a specific  frequency
band. For example:

Low, Bass medium, High medium and High (4 ways).

Useful for active loudspeaker system.

6.12.1 Hi/Lo Pass

Component Appearance

Description

This component allows you to filter Hi or low frequencies.

Control Window
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The small squares act  as  handles  that  can be dragged to the  desired  position  and  show the  following
parameters):

Blue Frequency (Hz)

Hi/Lo Pass Parameters

Parameter  Range  Comment

Mode - Type of filtering
Slope [dB] 12, 24, 36, 48 Slope of attenuation

Type Low/High Low or High pass
Bypass Button Bypass the filter's module

Mute Button Mute the filter's module
Frequency [Hz] 20 to 20k Frequency of cut

Level [dB] -90 to +20 gain

6.12.2 Band Pass

Component Appearance

Description

This component allows you to filter to have only a band of frequency.

Control Window
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The small squares act  as  handles  that  can be dragged to the  desired  position  and  show the  following
parameters:

Blue Frequency (Hz)

Yellow Bandwidth (-)

Band Pass Parameters

Parameter  Range  Comment

Mode - Type of filtering
Slope [dB] 12, 24, 36, 48 Slope of attenuation

Type Low/High Low or High pass
Bypass Button Bypass the filter's module

Mute Button Mute the filter's module
Frequency [Hz] 20 to 20k Frequency of cut

Level [dB] -90 to +20 gain
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6.12.3 Band Stop

Component Appearance

Description

This component allows you to filter to cut a band of frequency.

Control Window

The small squares act  as  handles  that  can be dragged to the  desired  position  and  show the  following
parameters:
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Blue Frequency (Hz)

Yellow Bandwidth (-)

Band stop Parameters

Parameter  Range  Comment

Mode - Type of filtering
Slope [dB] 12, 24, 36, 48 Slope of attenuation

Type Low/High Low or High pass
Bypass Button Bypass the filter's module

Mute Button Mute the filter's module
Frequency [Hz] 20 to 20k Frequency of cut

Level [dB] -90 to +20 gain

6.12.4 Notch Filter

Component Appearance

Description

This component allows you to filter to cut a frequency.

Control Window
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The small squares act  as  handles  that  can be dragged to the  desired  position  and  show the  following
parameters:

Blue Frequency (Hz)

Yellow Bandwidth (-)

Notch filter Parameters

Parameter  Range  Comment

Mode - Type of filtering
Slope [dB] 12, 24, 36, 48 Slope of attenuation

Type Low/High Low or High pass
Bypass Button Bypass the filter's module

Mute Button Mute the filter's module
Frequency [Hz] 20 to 20k Frequency of cut

Level [dB] -90 to +20 gain

6.12.5 Shelving Filter

Component Appearance

Description

This component allows you to smoothly filter Hi or low frequencies.

Control Window
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The small squares act  as  handles  that  can be dragged to the  desired  position  and  show the  following
parameters:

Blue Frequency (Hz)

Shelving filter Parameters

Parameter  Range  Comment

Mode Hi or Low Type of filtering(high pass or low pass)
Bypass Button Bypass the filter's module

Frequency [Hz] 20 to 20k Frequency of cut
Level [dB] -90 to +20 gain
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6.12.6 Crossover

Component Appearance

Description

Use to filter signal for active audio pre amplifier for pro-audio sound. Three choice 2, 3 or 4 way In the
example we have open the three way cross-over.

Control Window
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The small squares act  as  handles  that  can be dragged to the  desired  position  and  show the  following
parameters:

Blue, yellow, red: Frequency of each way (Hz)

Hi/Lo pass Parameters (for each way)

Parameter  Range  Comment

Mode Hi or Low Type of filtering(high pass or low pass)
Invert Button  Invert the phase of the signal

Slope [dB] 12, 24, 36, 48  Slope of attenuation
Mute Button Mute the filter's module

Frequency [Hz] 20 to 20k Frequency of cut
Level [dB] -90 to +20 gain
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6.13 Feedback

Component Template

Component Appearance

Description

The  feedback  analyzes  the  signal,  detects  feedback  and  attenuates  the  responsible  frequency.
There is  several kind of feedback component.  The difference is  only  the bandwidth which are tuned
for Music high than speech (between it  the bandwidth is  decreasing).  Each category  has 4 different
feedback it is only the number of filter (4, 8 12 or 16) that  the feedback will  use.  The treatment  time
is increased with the number of filter.

Control Window

Tips:  use  feedback  killers  to  detect  feedback  then  note  the  frequency  and  replace  feedback
component with an Equalizer. And add a simply 4 notch feedback for security.
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Bypass: Bypass the feedback’s module.

Note: By clicking on Bypass you will erase the captured values such as  frequencies,  bandwidth
and gain.

Hold: when a Larsen is detected and a frequency locked the component  hold this  setting (like an
EQ).

Frequency: you can set the frequency.

Bandwidth: bandwidth of the notch filter to attenuate the feedback.

Gain: attenuation of the locked frequency.

Lock: shows if the feedback killers channel has detected and is erased a frequency responsible of
a feedback.
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Frequency: show the frequency locked.

Bandwidth: show the bandwidth of the notch filter locked.

Gain: show the attenuation of the frequency locked.

Bypass all: bypass all channels.

Hold all: hold all channels.

Manual all: active manual settings (with Frequency, Bandwidth and gain knobs).

Lock time: interval time during the filter will  be active when a feedback is  detected.  After that  the
captured values will be loose.

Detect level: level of feedback detection.

Depth: means maximum reduction gain for filter.

 By  storing  again  the  configuration,  you  will  erase  the  captured  values  such  as  frequencies,
bandwidth and gain.

6.14 DigiLink Input/Output

Component Template

Component Appearance

Description

These components are for the connection of more than one UAPG2.
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Example

Create a virtual audio channel to send Audio through the Link protocol.

16 audio channels  at  48  kHz  are  available  from  each  UAP  device  to  the  next  linked  UAP,  and  5
audio channel at 96 kHz.

Send audio to the next UAP & Receive audio from the previous UAP

 The  Digilink  component  send  the  audio  only  to  the  next  UAPG2  in  the  system  (the  first  is
connected to the PC), as in the following example.

In this is an example, the paging microphone is able to page on the three UAPG2.
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Components set in UAP1.

Components set in UAP2.

Components set in UAP3.
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6.15 Page Control

This component allows you to route (page) audio signal to one or several desired outputs.

Two kinds of page control with various number of inputs and outputs

S/W page control: for signal paging with contact IN and VOX.

LPC: Only use with PPM (Ateis Programmable Paging Microphone) allows defining key’s  routing.
(When you press one of the key of the PPM where the sound will be routed to.)

6.15.1 Page Control

Component Appearance

Description

With this component you can active and route the audio inputs to the outputs.

Caution, this is not a mixer, only one input can be routed to an output.

You can never have two inputs channels mixed to an output  (even if they have the same priority),  in
this case the busy led of the lower channel number will light and theses channels won't be routed.

Each outputs work separately. On each one output, only the channels with the gate ON and with the
highest priority will be routed.

Control Window

Outputs control (routing): 

To route a channel to an output,  click  on an output  button.  This  button can also be controlled.
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So you can change the routing on the outputs  by  several ways.  To choose what  kind of control
will  activate or inactivate the "TTL In button",  right  click  on an output  button and choose in  the
list.

Activation:

o Fixed:  The gate of the channel is  always  activated.  Only  the  highest  priority  channel  of  the

activated channels will be routed to the output.

o VOX: The gate is activated when the audio signal on the input is above the threshold.  (Choose

the threshold  with  knobs  on  the  bottom).  Only  the  highest  priority  channel  of  the  activated
channels will be routed to the output.

o Contact:The gate of the channel is  activated when the "TTL  In  button"  is  activated.  There  is

several  ways  to  activate  this  button.  Right  click  on  the  "TTL  In  button",  and  choose  what
control this button. Only the highest priority channel of the activated channels will be routed to
the output.

o VOX + Contact:

The  gate  of  the  channel  is  activated  when  the  audio  signal  on  the  input  is  above  the
threshold,  and if  the  "TTL  In"  button  is  activated.  Only  the  highest  priority  channel  of  the
activated channels will be routed to the output.

Priority:
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You can set a priority number for each channel. 1 is the biggest priority.  When several channels
are active (gate open), only one of the channel with the biggest priority will be routed.

If  you  have  several  channels  with  the  same  priority,  only  the  highest  channel  number  will  be
routed to the output.

Ducker Parameters

Parameter  Range  Comment

Input - Channel number of the input

Output button Click on the desired output’s button to rout input to 
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Parameter  Range  Comment

desired outputs
Activation - Type of activation of the routing (fixe, with TTL, or with a gate)

Contact State Button
If you want to active the routing with a logical input 

(rear panel of UAP)
Priority 1 to 8 Choose the priority of this input (1 is the biggest priority)
Gate on LED, lit green Flash when the gate is active (open)

Solo Button Route this input

Busy  LED, lit red

Lit if the gate of the channel is open, but another channel with
highest priority is already activate, 

and unable this channel to be routed to the output. 
Busy means: gate open, but channel not routed.

Thd. (Threshold)
(dB)

 -60.0 to +20.0 dB
Sets the threshold level above which Gate will open

automatically route the signal.

Response time 0 to 5000 ms
Adjust the time between the level's detection and the beginning

of the Gate operation

Hold time 0 to 5000 ms
Adjust the time between the end level's detection and the end

of the Gate operation

6.15.2 LPC

Component Appearance

There are several types of LPCs, various numbers of inputs as well as outputs.

Description

All the PPM connected to an UAPg2 will be configured in the same LPC component. 

Connect the component’s  inputs  to the virtual inputs  of the UAPg2 where the PPMs are physically
connected, then connect outputs of the component to virtual outputs (you can add audio component
to adjust signal before and after the component: ducker, Eq, Mixer….).

Control Window

Then in the component, select the right  physique input  of the PPM (to define key) in the PPM plug
on.

After that create your paging (notch which key route where…)
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For more information please see "Create paging of PPM with LPC" chapter.

6.16 Slector

Component Template

Component Appearance

Description

Simple selector to select different inputs to output. It can be used with URC, RAC, analogue input  or
contact input in binary mode.

Control Window



UAP G2 Manual302

© 2019, ATEÏS, member of PAX ProAV Group

6.17 Noise Generator

6.17.1 White Noise Generator

Component Appearance

Description

This  component  generates  a White noise.  The White noise is  a random signal (or  process)  with  a
flat power spectral density. In other words, the signal contains  equal power within a fixed bandwidth
at any center frequency.

An infinite-bandwidth, white noise signal is  purely  a theoretical construction.  By having power at  all
frequencies,  the  total  power  of  such  a  signal  is  infinite  and  therefore  impossible  to  generate.  In
practice, however, a signal can be "white" with a flat spectrum over a defined frequency band.

Control Window

As example, it can be used to set up the equalization for a concert or other performance in a venue,
a short burst of white or pink noise is sent through the PA system and monitored from various points
in the venue so that  the engineer can tell  if the acoustics  of the building naturally  boost  or cut  any
frequencies. The engineer can then adjust the overall EQ to ensure a balanced mix.

White Noise Generator Parameters

Parameter  Range  Comment

Mute Button  Mute the sound coming out from the component
Level -100 to +20 (dB) Level of the white noise
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Measured white noise spectrum

6.17.2 Pink Noise Generator

Component Appearance

Description

This component generates a Pink noise.

Pink  noise  or  1/ƒ  noise  is  a  signal  or  process  with  a  frequency  spectrum  such  that  the  power
spectral  density  is  inversely  proportional  to  the  frequency.  In  pink  noise,  each  octave  carries  an
equal amount of noise power.

Control Window
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Pink noise spectrum

Pink Noise Generator Parameters

Parameter  Range  Comment

Mute Button  Mute the sound coming out from the component

Level -100 to +20 (dB) Level of the pink noise

Measured Pink noise spectrum

6.17.3 Tone Generator

Component Appearance

Description

Generates either tone (single frequency) or sweep sequence (between two fixed frequencies and in a
defined interval of time).

Control Window
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Tone Generator Parameters

Parameter  Range  Comment

Mute Button Mute the sound coming out from the component
Level -100 to +20 (dB) Level of the signal

Sweep button  Active the sweep mode (sweep of frequency)
Tone button Active Tone mode (one single frequency played)

Sweep type selector
Choose the interval between Min and Max frequencies

(octave, 1/3 octave…)
Tone Freq. 20 to 10k (Hz) If Tone mode is activated select the frequency played
Start Freq.  20 to 20k (Hz)  Select the minimum frequency in sweep mode
Stop Freq. 20 to 20k (Hz)  Select the maximum frequency in sweep mode

Inc. Time  (ms)
Select the time between the frequencies change 

in sweep mode

6.18 Meter

6.18.1 Peak/RMS Meter

Component Template

Component Appearance
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Description

This component allows the user to see the audio level.

Control Window

Peak value : Maximum value of the signal

RMS value : Power average of the signal

Meter Parameters

Parameter  Range  Comment

Indefinite Button  Block the display of level value
Measure type Rms/Peak  Type of measure
Hold time (ms)  10 to1000(ms) Able to see keep displayed the value along a the hold time

Value (dBu)  Vu-meter Measure
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6.19 Auto Noise Gain

Component Template

Component Appearance

Description

Adjust the audio level of the paging input (P.M.) depending of the ambient noise.

The ambient  noise is  measured with a sensing  microphone  connected  to  the  sensing  microphone
input  (S.M.).  Our  advice  is  to  use  the  sensing  microphone  MSN  (Ateis),  but  you  can  also  use
another one.

S.M: sensing microphone input

P.M: paging input

Control Window

A.N.G Parameters

Parameter  Range  Comment

Calibration Button Click on to start the automatic calibration procedure
Calibration LED, lit red Lit all along the calibration procedure
Calibration LED, lit green Lit when the A.N.G is properly calibrate

Over LED, lit red
Indicates the calibration result:

The white noise level needed is over the range.
A pop-up window will shows you what to do.
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Parameter  Range  Comment

Under LED, lit red
Indicates the calibration result:

The white noise level needed is under the range.
A pop-up window will show you what to do :

Response speed Selector
 Select here the reaction speed of the A.N.G.

That's means the speed to adapt the P.M. audio level
depending of the ambient noise.

Min Gain  -15 to 0 dB The minimum AGC level compensation
Max Gain 0 to 15 dB The maximum AGC level compensation

Sampling time 0.5 to 60 sec
Determine the period time between two ambient

 noise measures
Noise generator Meter White noise level, automatically Adjusted by the calibration
Ambiant noise Meter -

AGC Level Meter  Display the current compensation gain

Hold time  1 to 5 sec
Holding time between when the P.M. signal passes below the

mode threshold and the end of the paging activity.

Paging activity LED, lit green
Light up when the paging is active.

(when P.M. is above the mode threshold)
Decrease Zone LED, lit blue Indicates that the AGC gain is decreasing

Dead Zone LED, lit green Indicates that the AGC is not changing
Increase Zone LED, lit yellow Indicates that the AGC gain is increasing

Fast Increase Zone LED, lit red Indicates that the AGC gain is increasing fast
Sensing Mic Level  Indicator/RMS Show the input level of the sensing microphone

C/Sensing Mic
Level

Indicator
Show the input level of the sensing microphone through the

calibration transfer function
Output Level  Indicator/RMS Show the output level

Differential Level Indicator Difference between the Output level and C/Sensing Mic level.

For the procedures and use, please see the next  topic:  Use the Auto Noise Gain Component  (A.N.
G).

6.19.1 Use the A.N.G

Procedure to set the ANG

Connect the sensing microphone to the S.M. input,  and the paging audio source to the P.M. input.
The NSM sensing microphone need an  input  sensitivity  of  0dB  (  software).  The  max  cable  length
between the NSM and the UAPg2 is 500 meter with CAT-5 STP cable.

Link the output of the ANG component to an UAPg2 output where is connected a loudspeaker.

Click on the Calibrate button, to start the calibration procedure. The system will start to estimate the
acoustic  transfer function between loudspeakers  and  microphone  when  user  clicks  the  Calibration
button, and it  will  automatically  stop calibrating until  the system find a better transfer function.  The
calibration red led light  up,  means the calibration procedure is  running.  During the procedure,  don't
move  the  physical  installation,  and  don't  make  punctual  noise.  The  calibration  must  be  done  in
normal ambient conditions.

Wait  until  the end of the calibration.  The  red  calibration  led  light  off,  and  the  green  calibration  led
light up.

Now look the Over/Under red led:
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If both Over/Under led are OFF, it means the calibration has properly  finished and the ANG is
ready.

If one of the Over/Under led light ON, it means the white noise level needed is out of range.

Depending of the issue, a pop-up window will  show you what  to do.  Follow the most  usefully  advice
and restart the calibration procedure until the both Over/Under led are OFF after the calibration.

    

  

The system is properly set.

Even when the paging is not active, the ANG is  still  adjusting the AGC level with the ambient  noise
to be ready when the paging will begin.

Note:

The calibration should be done in normal ambient  noise (shouldn't  have  suddenly  loud  noise
during calibration).

Do not  adjust  the gain of output,  amplifier or  sensing  microphone  during  or  after  calibration.
(You can adjust volume of the audio source connected to P.M input.

Theoretically,  when the calibration has finished,  the AGC level will  be stable  around  0  dB  in
the environment of no increasing noise. But every calibration might  exist  deviation,  if the AGC
level  is  not  stable  around0  dB,  user  could  adjust  the  gain  of  output  function,  amplifier  or
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sensing microphone to let AGC level stable around 0 dB.

When the system is calibrating, clicking on the calibration button will cancel the calibration at
that moment. (The system will use the calibration result  which was successfully  calibrated at
last time.)

After  calibration  successful,  the  paging  microphone  shouldn't  be  placed  nearly  to  sensing
microphone. (because the user's voice will be also received into sensing microphone.)

Inactive mode means that  it  is  no  paging.  When  the  paging  Microphone  (or  Music)  input  is
inactive, in general,  it  needn't  increase or decrease gain.  But  it  is  better to set  an initial gain
before outputs are active, then you become with a good approximation of gain.  Suppose your
AGC gain is  -6dB and there is  a lot  of ambient  noise.  When outputs  are active,  but  before it
reach a correct gain, you won't hear the beginning of the announcement.

Use the A.N.G

When the calibration green led lit, the system is  ready.  In our example,  the A.N.G has detected an
ambient  noise  average  of  -12dB.  We  choose  a  medium  "response  speed"  and  a  short  "sampling
time" to be enough reactive quickly.

Now the  A.N.G  will  automatically  adjust  the  level  on  the  (P.M)  signal  depending  on  the  ambient
noise detected on the sensing microphone.  The A.N.G will  working when the paging activity  led will
light, meaning that an audio signal is detected on the (P.M) input.

Dead Zone:

If  the  sensing  microphone  doesn't  detect  more  noise  than  during  the  calibration,  the  A.N.G
works in the "Dead Zone" which means that there is no need to adjust the gain.
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As the noise level is near than during the calibration, the differential level is almost  null.  You can
see the AGC level near from 0 dB, meaning no compensation.

Increase Zone:

If the sensing microphone detects  more noise than  during  the  calibration,  the  A.N.G  works  in
the "Increase Zone" which means that  the gain must  be increased to compensate the ambient
noise.

In  our  example,  the  noise  is  now  louder  than  during  the  calibration.  The  differential  level  is
around 4.4dB. You can see the AGC level at  3.5dB,  meaning the (P.M)  signal  is  increased  of
3.5dB. As soon as the AGC level reach the level needed to compensate the ambient  noise (or
the Max Gain), the A.N.G will goes back in the "Dead Zone".

Fast Increase Zone:

If the sensing microphone detects  more noise than  during  the  calibration,  the  A.N.G  works  in
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the "Fast Increase Zone" which means that  the gain must  be quickly  increased to compensate
the loud ambient noise.

6.20 Level Controller

Component Template

Component Appearance

Description

Various numbers of level controllers allows you to adjust the signal level after a signal treatments.

Control Window
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Level Control Parameters

Parameter  Range  Comment

Mute Button Mute the sound coming out from the component
Bypass Button Switches off the Ducker’s operations

Level  -100 to +20 (dB) Increase Level of the signal

6.21 Message Player

Component Template

Component Appearance

Description

This  component  is  an  internal  messages  player.  It  is  able  to  play  two  different  messages  in  the
same time on two separate outputs M1 and M2.

You will have to store your Wave messages into the UAPg2 device.

Control Window

The component contains two Tabs:

Events Settings

To create and manage the message play event:
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Playing a message is considered as an event: the "Message play" event.

Like every  event,  it  can be  controlled  by  a  lot  of  ways  (contact  In,  scheduler,  third  party,
etc).

Here you can select the output used for each Message play event:

This component window allows creation and assignation of the "play message" event.

To set  the control of this  event,  and also to  create  and  use  a  "stop  message  event",  you
have to open

View->Events Management.

UAP Music Management (which should be understood as "Messages management")

load wave file into UAPG2 or recover wave file from UAPG2 to Computer.  (Don't  mind about
"Music", it is the messages management)
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This tab contains two sides:

o Message Storage: files in the computer (in the wave library).

o Machine Storage: files in the UAPG2.

Message player Parameters

Buttons  Comment

Clicking on this button to display the messages either of the
wave library or of the UAP G2 machine, depending of the side.

To store the selected messages of the wave library 
into the UAP G2.

To retrieve the messages from UAP G2 to the wave library

To delete the selected messages.

To play/Pause/Stop the message listening

Select here the output used for the messages listening.
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6.22 PPM Touch

Component Template

Component Appearance

Description

This component is for transferring audio from microphone input of PPM IT5 to output of UAP G2. 

In order to assign which zones to paging for PPM IT5, it requires a LPC paging component too.  

Control Window

1. Connect to the pin of PPM Touch Component to corresponding pin and channel.  

2. Connect to the pin of paging zone to corresponding output pin.  
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7 3rd party control

7.1 Where to access 3rd party control

Go to the UAP G2 (Universal Audio Processor G2) to launch the software. 

Open the editing panel by clicking on the icon.

 

After,  please go the "System" on your left  hand side of the  page  and  drag  the  UAP  G2  icon  to  the
editing page. 

The "Configure Modules" window appears;  users  are free to select  the components  according to your
device configuration and click on "OK" to open the System Page.
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On the System Page,  the UAP G2 icon appeared in green,  and double click  on the icon to open  its
Component Window. 

In the Component Window, the components appear as the picture shown below. 
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Please note that the components are vary from different device configurations. 

Double click on the component to see open the Component Parameter Window. 
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Please note that the Component Parameter Window are vary from different components. 

Right click on the channels to apply the 3rd party control function.

 

The selected channels to do 3rd party control will automatically appears on the bottom of page. 
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What is "Check sum"? 

o "Check sum" is  an error-detection  method  in  a  the  transmitter  computes  a  numerical  value

according  to  the  number  of  set  or  unset  bits  in  a  message  and  sends  it  along  with  each
message frame. 

Not Check sum : 

o Tick the "Not Check sum" box to NOT use the check sum calculation after sending/receiving

command. User MUST input a value to set up the command. 

For command type "Increase",  the check sum  value  must  not  be  empty,  users  can  fill  in
any number to set up the command.

For command type "Decrease",  the check sum value must  not  be empty,  users  can  fill  in
any number to set up the command. 

 Note: The "??" is for users to enter a number under "CS" to set the command. 

o If you do not tick the box, the "check sum" function will be auto applied and users will  see the

calculation value on the "Packet".

For command type "Increase", the check sum value  is 51.

For command type "Decrease", the check sum value is 4C.

o In the "Packet", a serial number is the calculated from the "Command frame", which is

consisted of "Header section","Data Section", "EXT", "Check-sum" and "CR".

o STX  always be 0x02

o EXT  always be 0x03

o Command string Number of Max is 50 

o Command code : 1 char, I/D/W/R/T/M/S/L/E/P/V/N/Y/U/B.

o Function name : 4 char, named by user. 

o Value : depend on each command. 
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o CS  Sum of all all characters of command string 

o CR  always be 0x0Dalways be 0x02

For each command, the answer can be ACK CR (executed), NACK CR (not executed),  DLE
CR (not executed), or none, depending on the communication protocol settings.
(ACK 0x06  DLE 0x10  NACK 0x10

Not  Command  answer  :  After  sending  a  command,  the  receiver  will  automatically  send  out  a
message to let the sender know if the command has been successfully sent or failed.

                                      Tick the box for not to send out the messages, or un-tick the box to agree
with sending out the messages.                   

o Sent successfully: 060D

o Sent failure: 100D   

Or,  users  can click  on the View tab to open the "Third Party  Control"  page  and  apply  the  3rd  party
control function to the channels. 
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8 Various types of 3rd command

8.1 Increase/decrease command

Command string = I/D nnnn vvvv

STX Data Section

STX I/D nnnn vvvv EXT CS CR

STX Data Section

STX I/D nnnn vvvv EXT EXT CR

nnnn = function name (fixed 4 length)

vvvv = value (unfixed)

For example : Room1 volume, value = 3 dB

'STX' + IR0013 + 'EXT' + 'CS' + 'CR '

'STX' + IR0013 + 'EXT' + 'CR '

8.2 Write parameter command

Command string = W nnnn vvvv

STX Data Section

STX I/D nnnn vvvv EXT CS CR

STX Data Section

STX I/D nnnn vvvv EXT EXT CR

nnnn = function name (fixed 4 length)

vvvv = value (unfixed)

For example :  cd1, value = 10 dB

'STX' + WCD1?10 + 'EXT' + 'CS' + 'CR '

'STX' + WCD1?10 + 'EXT' + 'CR '

8.3 Read parameter command

Command string =Rnnnn

STX Data Section

STX Rnnnn EXT CS CR
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STX Data Section
STX Rnnnn EXT CR

nnnn = function name (fixed 4 length)

Answer is always Rnnnnvvvv  (Reply Read Para. Com.)

8.4 Connect test command

Command string = T

STX Data Section

STX T EXT CS CR

STX Data Section

STX T EXT CR

Answer is always ACK CR or None, depend on communication protocol settings.

8.5 Control command

8.5.1 Change preset

Command string = Mvvvv

STX Data Section

STX Mvvvv EXT CS CR

STX Data Section

STX Mvvvv EXT CR

vvvv = Master preset number

8.5.2 Load sub-preset

Command string = Svvvv

STX Data Section

STX Svvvv EXT CS CR

STX Data Section

STX Svvvv EXT CR

vvvv = Sub preset number

8.6 Reply read parameter command

Command string = Rnnnnvvvv
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STX Data Section
 Rnnnnvvvv

STX Data Section

 Rnnnnvvvv

DB element
nnnn = function name (fixed 4 length)

vvvv = sign + integer(fixed 2 length) + dot + decimal(fixed 1 length)

Other element

Answer is always Rnnnnvvvv  (Reply Read Para. Com.)

nnnn = function name (fixed 4 length)

vvvv = value (unfixed)

8.7 Set machine system value

Command string =Lnnnn 

STX Data Section

STX Lnnnniivvvv EXT CS CR

STX Data Section

STX Lnnnniivvvv EXT CR

nnnn = function name (fixed 4 length)

iiii = Machine IP number(fixed 2 length)

vvvv = value (unfixed)

8.8 Read machine system value

Command string =Ennnn

STX Data Section

STX Ennnnii EXT CS CR

STX Data Section

STX Ennnnii EXT CR

nnnn = function name (fixed 4 length)

iiii = Machine IP number(fixed 2 length)
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8.9 Reply machine system value

Command string =Pnnnnvvvv

STX Data Section

Pnnnnvvv

STX Data Section

Pnnnnvvv

nnnn = function name (fixed 4 length)

vvvv = value (unfixed)

8.10 Event action

Command string =Vnnnn

STX Data Section

Vnnnn

STX Data Section

Vnnnn

nnnn = function name (fixed 4 length)

8.11 Ethernet reset command

Command string = N

STX Data Section

STX N EXT CS CR

STX Data Section

STX N EXT CR

8.12 Auto-reply control command

Command string = N

STX Data Section

STX Svvvv EXT CS CR

STX Data Section

STX Svvvv EXT CR

Reset Value
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IP Address 192.168.100.230
Sub Mask 225.225.225.0
 Getway 192.168.100.254

Receive Port 19760

8.13 Machine ID setting

Command string =Ykdddd

STX Data Section

STX Ykdddd EXT CS CR

STX Data Section

STX Ykdddd EXT CR

k = Write kind

1 LAP G2
2 UAP G2
3 DIVA (Reserve Kind)
4 VNB (Reserve Kind)
5 PPM G2
6 ECS
7 DigiDrive

8.14 Firm wave version read

Command string = O

STX Data Section

STX O EXT CS CR

STX Data Section

STX O EXT CR

Answer is always Oaaaa-bbbb-cccc-dddd  (Reply FirmWave Version Com.)

aaaa = firmwave version 1

bbbb = firmwave version 2

cccc = firmwave version 3

dddd = firmwave version 4

8.15 Power on/off

Command string = Qnnnn

STX Data Section
STX  Qnnnn EXT CS CR
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STX Data Section

STX  Qnnnn EXT CR

nnnn = flag

0 Stand by

1 Reset

2 Read State

Answer is always (Reply Power On/Off)

8.16 Reply power on/off

Command string = Qnnnn

STX Data Section

STX Qnnnn EXT CS CR

STX Data Section

STX Qnnnn EXT CR

nnnn = Standby Mode of System

8.17 Message state read

Command string = Gc

STX Data Section

STX Gc EXT CS CR

STX Data Section

STX Gc EXT CR

c = Message Channel Number

Answer is always (Reply Message State)

8.18 Reply message state

Command string = Gcsnnnn

STX Data Section

STX Gcsnnnn EXT CS CR

STX Data Section

STX Gcsnnnn EXT CR

0 Stop
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1 Play
2 Pause

nnnn = Message Name(reply null when message stop)
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9 Contact infomation

 ATEÏS Europe B.V. 
 EMEA 

Celsiusstraat 1 - 2652 XN Lansingerland
 (Rotterdam Region), Netherlands

Tel: +31 (0) 10 2088690
info@ateis-europe.com

 ATEÏS Suisse SA 
 Switzerland & South-East Europe 

 Penton Audio USA 
 USA, Canada & Latin America 

Avenue des Baumettes 9, 
1020 Renens VD, Switzerland

Tel: +41 (0) 21 881 25 10
Fax: +41 (0) 21 881 25 09

info@ateis.ch

21 Sabin St. Pawtucket,
RI 02860, USA

Tel: 401-727-1600
Fax: 401-727-0003

info@penton-usa.com 

 ATEÏS France  ATEÏS Se Europe 
 Serbia 

8, rue de l'Europe - 
ZA de Font Ratel,

38640 Claix, France
Tel: 33 (0) 4 76 99 26 30

contact@ateis.com

Sime Lukina Lazica 12-B, 
11040 Belgrade, Serbia

Tel: +381 (0)11 40 89 617
info@ateisseeurope.com

 Penton UK Ltd. 
 UK & Ireland 

 ATEÏS China 

Unit 2, Teville Industrials, Dominion Way,
Worthing West Sussex,

BN14 8NW, United Kingdom
Tel: +44 (0)1903 215315
Fax: +44 (0)1903 215415
sales@pentonuk.co.uk

Room 610, No. 255 Wubao Road,
Minxing district, Shanghai, China

Tel: 021-54495191/92
Fax: 021-54495193

sales@ateis.com.cn

 ATEÏS Far East CORP. 
 Far-East Asia 

 Xavtel Communications RUS Ltd. 
 Russia 

No.60, Xinghua 2nd Rd, Tanzi, 
Taichung 427, Taiwan
Tel: +886-4-25333820
Fax: +886-4-25333830

sales@ateis-fareast.com

Russian Federation, 115280, Moscow
Leninskaya Sloboda str., 26 bld. 28, Business

Center "Slobodskoy", office #122
Tel: +7 495 803 3655
Fax: +7 495 803 3655

info@xavtel.ru.com

 ATEÏS Middle East  ATEÏS SE PTE Ltd. 
 South-East Asia 

Light Industrial Unit 11 Dubai 
Silicon Oasis, Dubai United Arab Emirates

Tel: +971 4 3262730
Fax: +971 4 3262731

info@ateis.ae

Blk 5002 Ang Mo Kio Avenue 5, #03-01B
TECHplace II. Singapore 569871

Tel: +65 6481 1968
Fax: +65 6481 1960

info@ateis-se.com.sg
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